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Foreword

The idea for producing a book on Xamarin.Forms is one we've had for almost as long as we've been
working on the product. Of course, we didn’t know it would be written by such a talented and highly
regarded author. We couldn’t have asked for a better-qualified person, nor someone who would re-
quire so little of us to get inside our minds! Charles offers insights in such beautiful and simple ways, as
you'll soon discover.

This book distills more than three years of effort to create a modern, cross-platform toolkit as an easy
to understand, organized progression of ideas. The examples contained within this book are simple
enough to be understood without the need for a fancy IDE or compiler, yet they retain the complexity
required to be applicable to problems faced by real applications. Better, the following chapters don't
focus on a single platform but take a holistic approach to understanding mobile development for all
platforms, not just iOS or Android or Windows.

We wanted to avoid the pitfalls commonly associated with cross-platform toolkits: either they have an
alien-feeling user experience, or they are limited to the lowest common denominator across all the tar-
get platforms. The pattern we fell in love with was to use native APIs, as is the traditional Xamarin way.
Xamarin.Forms offers the user the smallest usable subset of APIs that are required to write the majority
of an app in a unified codebase, and then gives access to the underlying toolkit for fit and finish. The
end result is that the user has the ability to express the majority of their app in unified code, without
losing the flexibility of per-platform implementation.

It works, too, by removing the need to provide every feature inside the abstraction. Instead, we allow
simple access down to the toolkit so that application developers are able to bring out those platform-
specific features that make their app shine. Ninety percent of what makes your app work is the same as
for every other app out there, but working across platforms shouldn't force you to give up the 10 per-
cent that makes your app unique.

Because of this, Xamarin.Forms is in many ways the “untoolkit,” a toolkit that isn't so much a toolkit as
it is a way to look at mobile development and use it as a pattern to create mobile apps. If the authors
of Xamarin.Forms can offer you anything to retain as you read this book, it is that toolkits, platforms,
and technologies change very rapidly, but patterns, especially good patterns, rarely die.

When | read the preview editions of this book, | was blown away. Charles understood what we were
trying to do better than anyone else ever had. This book is written knowing that Xamarin.Forms is
about the pattern of creating mobile apps. | believe that by the time you finish reading, you too will
understand what it is we set out to create.

Xamarin.Forms cocreator,
Jason Smith



Introduction

This is the third version of a book about writing applications with Xamarin.Forms, the exciting mobile
development platform for iOS, Android, and Windows unveiled by Xamarin in May 2014. (The first two
versions of this book were Preview Editions.) Xamarin.Forms lets you write shared user-interface code
in C# and XAML (the Extensible Application Markup Language) that maps to native controls on these
platforms.

The Windows support of Xamarin.Forms includes the Windows Runtime (WinRT) for targeting
Windows 8.1 and Windows Phone 8.1 devices, and the Universal Windows Platform (UWP), which is a
form of the Windows Runtime that targets Windows 10 and Windows 10 Mobile devices with a single
program.

The two previous versions of this book were called Preview Editions because they were not com-
plete. At 1200 pages, this is the first edition that can claim to be complete, even though several topics
are not included and Xamarin.Forms continues to be progressively enhanced with no sign of slowing
down.

All information about this book can be found on the book’s home page at:

https://developer.xamarin.com/r/xamarin-forms/book/

Who should read this book

This book is for C# programmers who want to write applications using a single code base that targets
the three most popular mobile platforms: iOS, Android, and Windows, encompassing the Universal
Windows Platform and Windows Phone.

Xamarin.Forms also has applicability for those programmers who eventually want to use C# and the
Xamarin.iOS and Xamarin.Android libraries to target the native application programming interfaces
(APIs) of these platforms. Xamarin.Forms can be a big help in getting programmers started with these
platforms or in constructing a prototype or proof-of-concept application.

This book assumes that you know C# and are familiar with the use of the .NET Framework. How-
ever, when | discuss some C# and .NET features that might be somewhat exotic or unfamiliar to recent
C# programmers, | adopt a somewhat slower pace.
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Conventions and features in this book

This book has just a few typographical conventions:

e All programming elements referenced in the text—including classes, methods, properties, varia-
ble names, etc.—are shown in a monospaced font, such as the stackLayout class.

e Items that appear in the user interface of Visual Studio or Xamarin Studio, or the applications
discussed in these chapters, appear in boldface, such as the Add New Project dialog.

e Application solutions and projects also appear in boldface, such as MonkeyTap.

The various editions of this book

This book is intended as a tutorial to learn Xamarin.Forms programming. It is not a replacement for the
online APl documentation, which can be found at the Xamarin.Forms Framework link on this page:

https://developer.xamarin.com/api/

The first Preview Edition of this book was published in October 2014 to coincide with the Xamarin
Evolve 2014 conference. It contained six chapters but no coverage of XAML.

This second Preview Edition was reconceived to contain shorter and more focused chapters. The
sixteen chapters of the second Preview Edition were published in April 2015 to coincide with the
Microsoft Build 2015 conference. Over the next six months, eight more chapters were published online,
bringing the total to 24.

This edition has 27 chapters and is being published to coincide with the Xamarin Evolve 2016 con-
ference taking place April 24-28, 2016. But the deadline for this book is about a month earlier than
Evolve, and several topics did not make it into this edition. These include maps, ControlTemplate,
DataTemplateSelector, the Margin property, and CarouselView. Of the classes that derive from
GestureRecognizer, only TapGestureRecognizer is covered, and not PanGestureRecognizer or
PinchGestureRecognizer. Although RelativeLayout dates from the very first release of Xama-
rin.Forms, somehow it never made it into this book.

Between the second Preview Edition and this edition, a big change occurred for the Windows plat-
forms: The sample programs no longer support the Silverlight API of Windows Phone 8.0. Instead, all
the sample programs support the Universal Windows Platform for targeting Windows 10 and Windows
10 Mobile, and the Windows Runtime for targeting Windows 8.1 and Windows Phone 8.1.

However, there was insufficient time to update this book’s sample programs and screenshots to re-
flect Android AppCompat and Material Design, which is expected to be supported in a forthcoming
Visual Studio and Xamarin Studio project template for Xamarin.Forms.
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For updates and additions to this edition, check the Xamarin webpage devoted to this book.

System requirements

This book assumes that you'll be using Xamarin.Forms to write applications that simultaneously target
all the supported mobile platforms—iOS, Android, the Universal Windows Platform, and perhaps
Windows Phone 8.1 as well. However, it's possible that some readers will be targeting only one or two
platforms in their Xamarin.Forms solutions. The platforms you target govern your hardware and soft-
ware requirements. For targeting iOS devices, you'll need a Mac installed with Apple Xcode and the
Xamarin Platform, which includes Xamarin Studio. For targeting any of the Windows platforms, you'll
need Visual Studio 2015 on a PC, and you'll need to have installed the Xamarin Platform.

However, you can also use Visual Studio on the PC to target iOS devices through a Wi-Fi-accessible
Mac installed with Xcode and the Xamarin Platform. You can target Android devices from Visual Studio
on the PC or from Xamarin Studio on the Mac.

Chapter 1, “How does Xamarin.Forms fit in?" has more details on the various configurations you can
use and resources for additional information and support. My setup for creating this book consisted of
a Microsoft Surface Pro 2 (with external monitor, keyboard, and mouse) installed with Visual Studio
2015 and the Xamarin Platform, connected by Wi-Fi with a MacBook Pro installed with Xcode and the
Xamarin Platform.

Most of the screenshots in this book show an iPhone, an Android phone, and a Windows 10 Mobile
device in that order. The three devices shown in these screenshots reflect my setup and hardware:

e The iPhone 6 simulator on the MacBook Pro running iOS 8.2
e An LG Nexus 5 running Android 6.0.1
e A Nokia Lumia 925 running Windows 10 Mobile

Additional screenshots use an iPad Air 2 simulator, a Microsoft Surface Pro 3 running Windows 10 in
tablet mode, a Windows 10 Mobile phone running a program targeting Windows Phone 8.1, and the
Windows 10 desktop running a program targeting Windows 8.1.

Some of the early triple screenshots in this book used devices with somewhat earlier versions of the
operating systems, for example Android 5.0 or 5.1. Although | tried to use real devices for all the
Android and Windows screenshots, in the interests of expediency some Windows Phone and Windows
10 Mobile screenshots were taken with a Windows 10 Mobile emulator.
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Downloads: Code samples

The sample programs shown in the pages of this book were compiled in late March 2016 with
Xamarin.Forms version 2.1.0. The source code of these samples is hosted on a repository on GitHub:

http://aka.ms/xamarinbook/codesamples

You can clone the directory structure to a local drive on your machine or download a big ZIP folder.
I'll try to keep the code updated with the latest release of Xamarin.Forms and to fix (and comment) any
errors that might have sneaked through.

You can report problems, bugs, or other kinds of feedback about the book or source code by click-
ing the Issues button on this GitHub page. You can search through existing issues or file a new one. To
file a new issue, you'll need to join GitHub (if you haven't already).

Use this GitHub page only for issues involving the book. For questions or discussions about
Xamarin.Forms itself, use the Xamarin.Forms forum:

http://forums.xamarin.com/categories/xamarin-forms

Updating the code samples

The libraries that make up Xamarin.Forms are distributed via the NuGet package manager. The
Xamarin.Forms package consists of a collection of dynamic-link libraries, the most significant of which
are:

e Xamarin.Forms.Core.dl|

e  Xamarin.Forms.Xaml.dll

e  Xamarin.Forms.Platform.dll

e  Xamarin.Forms.Platform.iOS.dll

e  Xamarin.Forms.Platform.Android.dlI

e  Xamarin.Forms.Platform.WinRT.dlI

e  Xamarin.Forms.Platform.WinRT.Phone.dll
e  Xamarin.Forms.Platform.WinRT.Tablet.dll
e  Xamarin.Forms.Platform.UAP.dII

The Xamarin.Forms package also requires five Android support libraries, currently identified with the
version number 23.0.1.3. These should be automatically included.
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When you create a new Xamarin.Forms solution using Visual Studio or Xamarin Studio, a version of
the Xamarin.Forms package becomes part of that solution. However, that might not be the latest
Xamarin.Forms version available from NuGet. You'll probably want to update that package to the most
recent version.

Also, the source code for this book that is stored on GitHub does not include the actual NuGet
packages. Xamarin Studio will automatically download them when you load the solution, but by de-
fault Visual Studio will not.

In Visual Studio, you can handle both these jobs by right-clicking the solution name in the Solution
Explorer and selecting Manage NuGet Packages for Solution. The Manage Packages for Solution
dialog lets you download and restore the NuGet packages and to update them.

In Xamarin Studio, the process is somewhat more automatic, but you can also use the Update
NuGet Packages and Restore NuGet Packages options on the Project menu.

Some of the projects contain references to libraries in the Libraries folder of the sample code. You'll
want to load those library solutions into Visual Studio or Xamarin Studio separately and restore (or up-
date) the NuGet packages. Then load projects referencing these libraries.
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Free ebooks from Microsoft Press

From technical overviews to in-depth information, the free ebooks from Microsoft Press cover a wide
range of topics. These ebooks are available in PDF, EPUB, and Mobi for Kindle formats, ready for you to
download at http://aka.ms/mspressfree.

We want to hear from you

At Microsoft Press, your satisfaction is our top priority and your feedback our most valuable asset.
Please tell us what you think of this book at http://aka.ms/tellpress. Your feedback goes directly to the

editors at Microsoft Press. (No personal information will be requested.) Thanks in advance for your in-
put!
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Chapter 1
How does Xamarin.Forms fit in?

There is much joy in programming. There is joy in analyzing a problem, breaking it down into pieces,
formulating a solution, mapping out a strategy, approaching it from different directions, and crafting
the code. There is very much joy in seeing the program run for the first time, and then more joy in
eagerly diving back into the code to make it better and faster.

There is also often joy in hunting down bugs, in ensuring that the program runs smoothly and pre-
dictably. Few occasions are quite as joyful as finally identifying a particularly recalcitrant bug and defin-
itively stamping it out.

There is even joy in realizing that the original approach you took is not quite the best. Many devel-
opers discover that they've learned a lot while writing a program, including that there’s a better way to
structure the code. Sometimes, a partial or even a total rewrite can result in a much better application,
or simply one that is structurally more coherent and easier to maintain. The process is like standing on
one’s own shoulders, and there is much joy in attaining that perspective and knowledge.

However, not all aspects of programming are quite so joyful. One of the nastier programming jobs
is taking a working program and rewriting it in an entirely different programming language or porting
it to another operating system with an entirely different application programming interface (API).

A job like that can be a real grind. Yet, such a rewrite may very well be necessary: an application
that's been so popular on the iPhone might be even more popular on Android devices, and there’s
only one way to find out.

But here’s the problem: As you're going through the original source code and moving it to the new
platform, do you maintain the same program structure so that the two versions exist in parallel? Or do
you try to make improvements and enhancements?

The temptation, of course, is to entirely rethink the application and make the new version better.
But the further the two versions drift apart, the harder they will be to maintain in the future.

For this reason, a sense of dread pervades the forking of one application into two. With each line of
code that you write, you realize that all the future maintenance work, all the future revisions and en-
hancements, have become two jobs rather than one.

This is not a new problem. For over half a century, developers have craved the ability to write a sin-
gle program that runs on multiple machines. This is one of the reasons that high-level languages were
invented in the first place, and this is why the concept of “cross-platform development” continues to
exert such a powerful allure for programmers.
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Cross-platform mobile development

The personal computer industry has experienced a massive shift in recent years. Desktop computers
still exist, of course, and they remain vital for tasks that require keyboards and large screens: program-
ming, writing, spread-sheeting, data tracking. But much of personal computing now occurs on smaller
devices, particularly for quick information, media consumption, and social networking. Tablets and
smartphones have a fundamentally different user-interaction paradigm based primarily on touch, with
a keyboard that pops up only when necessary.

The mobile landscape

Although the mobile market has the potential for rapid change, currently two major phone and tablet
platforms dominate:

e The Apple family of iPhones and iPads, all of which run the iOS operating system.

e The Android operating system, developed by Google based on the Linux kernel, which runs on
a variety of phones and tablets.

How the world is divided between these two giants depends on how they are measured: there are
more Android devices currently in use, but iPhone and iPad users are more devoted and spend more
time with their devices.

There is also a third mobile development platform, which is not as popular as iOS and Android but
involves a company with a strong history in the personal computer industry:

e Microsoft's Windows Phone and Windows 10 Mobile.

In recent years, these platforms have become a more compelling alternative as Microsoft has been
merging the APIs of its mobile, tablet, and desktop platforms. Both Windows 8.1 and Windows Phone
8.1 are based on a single API called the Windows Runtime (or WinRT), which is based on

Microsoft .NET. This single APl means that applications targeted for desktop machines, laptops, tablets,
and phones can share very much of their code.

Even more compelling is the Universal Windows Platform (UWP), a version of the Windows Runtime
that forms the basis for Windows 10 and Windows 10 Mobile. A single UWP application can target
every form factor from the desktop to the phone.

For software developers, the optimum strategy is to target more than just one of these platforms.
But that's not easy. There are four big obstacles:

Problem 1: Different user-interface paradigms

All three platforms incorporate similar ways of presenting the graphical user interface (GUI) and inter-
action with the device through multitouch, but there are many differences in detail. Each platform has
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different ways to navigate around applications and pages, different conventions for the presentation of
data, different ways to invoke and display menus, and even different approaches to touch.

Users become accustomed to interacting with applications on a particular platform and expect to
leverage that knowledge with future applications as well. Each platform acquires its own associated
culture, and these cultural conventions then influence developers.

Problem 2: Different development environments

Programmers today are accustomed to working in a sophisticated integrated development environ-
ment (IDE). Such IDEs exist for all three platforms, but of course they are different:

e  For iOS development, Xcode on the Mac.
e  For Android development, Android Studio on a variety of platforms.

e  For Windows development, Visual Studio on the PC.

Problem 3: Different programming interfaces

All three of these platforms are based on different operating systems with different APIs. In many
cases, the three platforms all implement similar types of user-interface objects but with different
names.

For example, all three platforms have something that lets the user toggle a Boolean value:
e On the iPhone or iPad, it's a “view" called UISwitch.

e On Android devices, it's a "widget” called switch.

e In the Windows Runtime AP, it's a “control” called ToggleSwitch.

Of course, the differences go far beyond the names into the programming interfaces themselves.

Problem 4: Different programming languages

Developers have some flexibility in choosing a programming language for each of these three plat-
forms, but, in general, each platform is very closely associated with a particular programming lan-

guage:
e  Objective-C for the iPhone and iPad
e Java for Android devices

e  C# for Windows

Objective-C, Java, and C# are cousins of sorts because they are all object-oriented descendants of C,
but they have become rather distant cousins.
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For these reasons, a company that wants to target multiple platforms might very well employ three
different programmer teams, each team skilled and specialized in a particular language and API.

This language problem is particularly nasty, but it's the problem that is the most tempting to solve:
If you could use the same programming language for these three platforms, you could at least share
some code between the platforms. This shared code likely wouldn't be involved with the user interface
because each platform has different APIs, but there might well be application code that doesn’t touch
the user interface at all.

A single language for these three platforms would certainly be convenient. But what language
would that be?

The C# and .NET solution

A roomful of programmers would come up with a variety of answers to the question just posed, but a
good argument can be made in favor of C#. Unveiled by Microsoft in the year 2000, C# is a fairly new
programming language, at least when compared with Objective-C and Java. At first, C# seemed to be
a rather straightforward, strongly typed, imperative object-oriented language, certainly influenced by
C++ (and Java as well), but with a much cleaner syntax than C++ and none of the historical baggage.
In addition, the first version of C# had language-level support for properties and events, which turn
out to be member types that are particularly suited for programming graphical user interfaces.

But C# has continued to grow and get better over the years. The support of generics, lambda func-
tions, LINQ, and asynchronous operations has successfully transformed C# so that it is now properly
classified as a multiparadigm programming language. C# code can be traditionally imperative, or the
code can be flavored with declarative or functional programming paradigms.

Since its inception, C# has been closely associated with the Microsoft .NET Framework. At the lowest
level, .NET provides an infrastructure for the C# basic data types (int, double, string, and so forth).
But the extensive .NET Framework class library provides support for many common chores encoun-
tered in many different types of programming. These include:

e Math

e Debugging

e  Reflection

e  Collections

e  Globalization
e Filel/O

e Networking
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e Security

e Threading

e Web services

e Data handling

e XML and JSON reading and writing

Here's another big reason for C# and .NET to be regarded as a compelling cross-platform solution:
It's not just hypothetical. It's a reality.

Soon after Microsoft's announcement of .NET way back in June 2000, the company Ximian
(founded by Miguel de Icaza and Nat Friedman) initiated an open-source project called Mono to cre-
ate an alternative implementation of the C# compiler and the .NET Framework that could run on Linux.

A decade later, in 2011, the founders of Ximian (which had been acquired by Novell) founded
Xamarin, which still contributes to the open-source version of Mono but which has also adapted Mono
to form the basis of cross-platform mobile solutions.

The year 2014 saw some developments in C# and .NET that bode well for its future. An open-source
version of the C# compiler, called the .NET Compiler Platform (formerly known by its code name
“Roslyn”) has been published. And the .NET Foundation was announced to serve as a steward for open-
source .NET technologies, in which Xamarin plays a major part.

In March 2016, Microsoft acquired Xamarin with the goal of bringing cross-platform mobile devel-
opment to the wider Microsoft developer community. Xamarin.Forms is now freely available to all
users of Visual Studio.

A single language for all platforms

For the first three years of its existence, Xamarin focused mainly on compiler technologies and three
basic sets of .NET libraries:

e Xamarin.Mac, which has evolved from the MonoMac project.
e  Xamarin.iOS, which evolved from MonoTouch.
e  Xamarin.Android, which evolved from Mono for Android or (more informally) MonoDroid.

Collectively, these libraries are known as the Xamarin platform. The libraries consist of .NET versions
of the native Mac, 10S, and Android APIs. Programmers using these libraries can write applications in
C# to target the native APIs of these three platforms, but also (as a bonus) with access to the .NET
Framework class library.
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Developers can use Visual Studio to build Xamarin applications, targeting iOS and Android as well
as all the various Windows platforms. However, iPhone and iPad development also requires a Mac con-
nected to the PC through a local network. This Mac must have Xcode installed as well as Xamarin Stu-
dio, an OS X-based integrated development environment that lets you develop iPhone, iPad, Mac OS
X, and Android applications on the Mac. Xamarin Studio does not allow you to target Windows plat-
forms.

Sharing code

The advantage of targeting multiple platforms with a single programming language comes from the
ability to share code among the applications.

Before code can be shared, an application must be structured for that purpose. Particularly since the
widespread use of graphical user interfaces, programmers have understood the importance of separat-
ing application code into functional layers. Perhaps the most useful division is between user-interface
code and the underlying data models and algorithms. The popular MVC (Model-View-Controller) ap-
plication architecture formalizes this code separation into a Model (the underlying data), the View (the
visual representation of the data), and the Controller (which handles input from the user).

MVC originated in the 1980s. More recently, the MVVM (Model-View-ViewModel) architecture has
effectively modernized MVC based on modern GUIs. MVVM separates code into the Model (the under-
lying data), the View (the user interface, including visuals and input), and the ViewModel (which man-
ages data passing between the Model and the View).

When a programmer develops an application that targets multiple mobile platforms, the MVVM
architecture helps guide the developer into separating code into the platform-specific View—the code
that requires interacting with the platform APIs—and the platform-independent Model and View-
Model.

Often this platform-independent code needs to access files or the network or use collections or
threading. Normally these jobs would be considered part of an operating system API, but they are also
jobs that can make use of the .NET Framework class library, and if .NET is available on each platform,
then this code is effectively platform independent.

The part of the application that is platform independent can then be isolated and—in the context of
Visual Studio or Xamarin Studio—put into a separate project. This can be either a Shared Asset Project
(SAP)—which simply consists of code and other asset files accessible from other projects—or a Portable
Class Library (PCL), which encloses all the common code in a dynamic-link library (DLL) that can then
be referenced from other projects.

Whichever method you use, this common code has access to the .NET Framework class library, so it
can perform file /O, handle globalization, access web services, decompose XML, and so forth.
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This means that you can create a single Visual Studio solution that contains four C# projects to tar-
get the three major mobile platforms (all with access to a common PCL or SAP), or you can use
Xamarin Studio to target iPhone and Android devices.

The following diagram illustrates the interrelationships between the Visual Studio or Xamarin
Studio projects, the Xamarin libraries, and the platform APIs. The third column refers to any .NET-based
Windows Platform regardless of the device:

Portable Class Library (PCL) or Shared Asset Project (SAP)

}

Android App

{

Android API

ﬁ
{
Xamarin.Android

The boxes in the second row are the actual platform-specific applications. These apps make calls
into the common project and also (with the iPhone and Android) the Xamarin libraries that implement
the native platform APlIs.

But the diagram is not quite complete: it doesn’t show the SAP or PCL making calls to the .NET
Framework class library. Exactly what version of .NET this is depends on the common code: A PCL has
access to its own version of .NET, while an SAP uses the version of .NET incorporated into each particu-
lar platform.

In this diagram, the Xamarin.iOS and Xamarin.Android libraries seem to be substantial, and while
they are certainly important, they’re mostly just language bindings and do not significantly add any
overhead to API calls.

When the iOS app is built, the Xamarin C# compiler generates C# Intermediate Language (IL) as
usual, but it then makes use of the Apple compiler on the Mac to generate native iOS machine code
just like the Objective-C compiler. The calls from the app to the iOS APIs are the same as though the
application were written in Objective-C.
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For the Android app, the Xamarin C# compiler generates IL, which runs on a version of Mono on
the device alongside the Java engine, but the API calls from the app are pretty much the same as
though the app were written in Java.

For mobile applications that have very platform-specific needs, but also a potentially shareable
chunk of platform-independent code, Xamarin.iOS and Xamarin.Android provide excellent solutions.
You have access to the entire platform API, with all the power (and responsibility) that implies.

But for applications that might not need quite so much platform specificity, there is an alternative
that will simplify your life even more.

Introducing Xamarin.Forms

On May 28, 2014, Xamarin introduced Xamarin.Forms, which allows you to write user-interface code
that can be compiled for the iOS, Android, and Windows devices.

The Xamarin.Forms option

Xamarin.Forms supports five distinct application platforms:
e {OS for programs that run on the iPhone, iPad, and iPod Touch.
e Android for programs that run on Android phones and tablets.

e The Universal Windows Platform (UWP) for applications that runs under Windows 10 or
Windows 10 Mobile.

e The Windows Runtime API of Windows 8.1.
e  The Windows Runtime APl of Windows Phone 8.1.

In this book, "Windows" or “Windows Phone” will generally be used as a generic term to describe all
three of the Microsoft platforms.

In the general case, a Xamarin.Forms application in Visual Studio consists of five separate projects
for each of these five platforms, with a sixth project containing common code. But the five platform
projects in a Xamarin.Forms application are typically quite small—often consisting of just stubs with a
little boilerplate startup code. The PCL or SAP contains the bulk of the application, including the user-
interface code. The following diagram shows just the iOS, Android, and Universal Windows Platform.
The other two Windows platforms are similar to UWP:



Chapter 1 How does Xamarin.Forms fit in? 9

{ \ \

Portable Class Library (PCL) or Shared Asset Project (SAP)

Xamarin.Forms.Core and Xamarin.Forms.Xaml

Xamarin.Android

Android API

Xamarin.Forms.
Platform.Android

The Xamarin.Forms.Core and Xamarin.Forms.Xaml libraries implement the Xamarin.Forms API.
Depending on the platform, Xamarin.Forms.Core then makes use of one of the Xamarin.Forms.Plat-
form libraries. These libraries are mostly a collection of classes called renderers that transform the
Xamarin.Forms user-interface objects into the platform-specific user interface.

The remainder of the diagram is the same as the one shown earlier.

For example, suppose you need the user-interface object discussed earlier that allows the user to
toggle a Boolean value. When programming for Xamarin.Forms, this is called a switch, and a class
named switch is implemented in the Xamarin.Forms.Core library. In the individual renderers for the
three platforms, this switch is mapped to a UTSwitch on the iPhone, a switch on Android, and a
ToggleSwitch on Windows Phone.

Xamarin.Forms.Core also contains a class named slider for displaying a horizontal bar that the
user manipulates to choose a numeric value. In the renderers in the platform-specific libraries, this is
mapped to a UTS1lider on the iPhone, a SeekBar on Android, and a S1ider on Windows Phone.
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This means that when you write a Xamarin.Forms program that has a Switch or a Slider, what's
actually displayed is the corresponding object implemented in each platform.

Here's a little Xamarin.Forms program containing a Label reading “Hello, Xamarin.Forms!”, a
Button saying “Click Me!”, a Switch, and a Slider. The program is running on (from left to right) the
iPhone, an Android phone, and a Windows 10 Mobile device:

30 Wl i 1:48

®
T8 P - ) e
visuals [ QO 0Vlsuals F oo

Hello, Xamarin.Forms!

Hello, Xamarin.Forms!

Hello, Xamarin.Forms!

Click Me!

CLICK ME!

The iPhone screenshot is of an iPhone 6 simulator running iOS 9.2. The Android phone is an LG
Nexus 5 running Android version 6. The Windows 10 Mobile device is a Nokia Lumia 935 running a
Windows 10 Technical Preview.

You'll encounter triple screenshots like this one throughout this book. They're always in the same
order—iPhone, Android, and Windows 10 Mobile—and they're always running the same program.

As you can see, the Button, Switch, and Slider all have different appearances on the three
phones because they are all rendered with the object specific to each platform.

What's even more interesting is the inclusion in this program of six Too1BarItem objects, three
identified as primary items with icons, and three as secondary items without icons. On the iPhone these
are rendered with UIBarButtonItem objects as the three icons and three buttons at the top of the
page. On the Android, the first three are rendered as items on an ActionBar, also at the top of the
page. On Windows 10 Mobile, they're realized as items on the CommandBar at the page’s bottom.

The Android ActionBar has a vertical ellipsis and the Universal Windows Platform CommandBar
has a horizontal ellipsis. Tapping this ellipsis causes the secondary items to be displayed in a manner
appropriate to these two platforms:
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Hello, Xamarin.Forms!

CLICK ME!

Hello, Xamarin.Forms!

Click Me!

explore
discover

evolve
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search  refresh

Xamarin.Forms was originally conceived as a platform-independent API for mobile devices. How-
ever, Xamarin.Forms is not limited to phones. Here's the same program running on an iPad Air 2

simulator:

228PM

Visuals

Hello, Xamarin.Forms!

Most of the programs in this book are fairly simple, and hence designed to look their best on a
phone screen in portrait mode. But they will also run in landscape mode and on tablets.

Here's the UWP project on a Microsoft Surface Pro 3 running Windows 10:
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Hello, Xamarin.Forms!

Notice the toolbar at the top of the screen. The ellipsis has already been pressed to reveal the three
secondary items.

The other two platforms supported by Xamarin.Forms are Windows 8.1 and Windows Phone 8.1.
Here's the Windows 8.1 program running in a window on the Windows 10 desktop, and the Windows
8.1 program running on the Windows 10 Mobile device:

| Visuals

Hello. X inF : Hello, Xamarin.Forms!
ello, Xamarin.Forms!

explore

discaver

evolve
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The Windows 8.1 screen has been left-clicked with the mouse to reveal the toolbar items at the bot-
tom. On this screen, the secondary items are at the left, but the program neglectfully forgot to assign
them icons. On the Windows Phone 8.1 screen, the ellipsis at the bottom has been pressed.

The various implementations of the toolbar reveals that, in one sense, Xamarin.Forms is an API that
virtualizes not only the user-interface elements on each platform, but also the user-interface para-
digms.

XAML support

Xamarin.Forms also supports XAML (pronounced “zammel” to rhyme with “camel”), the XML-based
Extensible Application Markup Language developed at Microsoft as a general-purpose markup lan-
guage for instantiating and initializing objects. XAML isn’t limited to defining initial layouts of user
interfaces, but historically that's how it's been used the most, and that's what it's used for in Xamarin-
.Forms.

Here's the XAML file for the program whose screenshots you've just seen:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatformVisuals.PlatformVisualsPage"
Title="Visuals">

<StackLayout Padding="10,0">
<Label Text="Hello, Xamarin.Forms!"
FontSize="Large"
VerticalOptions="CenterAndExpand"
HorizontalOptions="Center" />

<Button Text = "Click Me!"
VerticalOptions="CenterAndExpand"
HorizontalOptions="Center" />

<Switch VerticalOptions="CenterAndExpand"
HorizontalOptions="Center" />

<STider VerticalOptions="CenterAndExpand" />
</StackLayout>

<ContentPage.ToolbarItems>
<ToolbarItem Text="edit" Order="Primary">
<ToolbarItem.Icon>
<OnPTatform x:TypeArguments="FileImageSource"
i0S="edit.png"
Android="1ic_action_edit.png"
WinPhone="Images/edit.png" />
</ToolbarItem.Icon>
</ToolbarItem>

<ToolbarItem Text="search" Order="Primary">
<ToolbarItem.Icon>
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<OnPlatform x:TypeArguments="FileImageSource"
i0S="search.png"
Android="1c_action_search.png"
WinPhone="Images/feature.search.png" />
</ToolbarItem.Icon>
</ToolbarItem>

<ToolbarItem Text="refresh" Order="Primary">
<ToolbarItem.Icon>
<OnPlatform x:TypeArguments="FileImageSource"
i0S="reload.png"
Android="1ic_action_refresh.png"
WinPhone="Images/refresh.png" />
</ToolbarItem.Icon>
</ToolbarItem>

<ToolbarItem Text="explore" Order="Secondary" />
<ToolbarItem Text="discover" Order="Secondary" />
<ToolbarItem Text="evolve" Order="Secondary" />
</ContentPage.ToolbarItems>
</ContentPage>

Unless you have experience with XAML, some syntax details might be a little obscure. (Don't worry;
you'll learn all about them later on in this book.) But even so, you can see the Label, Button, Switch,
and slider tags. In a real program, the Button, Switch, and slider would probably have event
handlers attached that would be implemented in a C# code file. Here they do not. The verticalop-
tions and HorizontalOptions attributes assist in layout; they are discussed in the next chapter.

Platform specificity

In the section of that XAML file involving the ToolbarItem, you can also see a tag named OnPlat-
form. This is one of several techniques in Xamarin.Forms that allow introducing some platform speci-
ficity in otherwise platform-independent code or markup. It's used here because each of the separate
platforms has somewhat different image format and size requirements associated with these icons.

A similar facility exists in code with the Device class. It's possible to determine what platform the
code is running on and to choose values or objects based on the platform. For example, you can spec-
ify different font sizes for each platform or run different blocks of code based on the platform. You
might want to let the user manipulate a s1ider to select a value in one platform but pick a number
from a set of explicit values in another platform.

In some applications, deeper platform specificities might be desired. For example, suppose your ap-
plication requires the GPS coordinates of the user’s phone. This is not something that Xamarin.Forms
provides, so you'd need to write your own code specific to each platform to obtain this information.

The DependencyService class provides a way to do this in a structured manner. You define an in-
terface with the methods you need (for example, IGetCurrentLocation) and then implement that
interface with a class in each of the platform projects. You can then call the methods in that interface
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from the Xamarin.Forms project almost as easily as if it were part of the API.

Each of the standard Xamarin.Forms visual objects—such as Label, Button, Switch, and
Slider—are supported by a renderer class in the various Xamarin.Forms.Platform libraries. Each
renderer class implements the platform-specific object that maps to the Xamarin.Forms object.

You can create your own custom visual objects with your own custom renderers. The custom visual
object goes in the common code project, and the custom renderers go in the individual platform pro-
jects. To make it a bit easier, generally you'll want to derive from an existing class. Within the individual
Xamarin.Forms platform libraries, all the corresponding renderers are public classes, and you can derive
from them as well.

Xamarin.Forms allows you to be as platform independent or as platform specific as you need to be.
Xamarin.Forms doesn't replace Xamarin.iOS and Xamarin.Android; rather, it integrates with them.

A cross-platform panacea?

For the most part, Xamarin.Forms defines its abstractions with a focus on areas of the mobile user in-
terface that are common to the iOS, Android, and Windows Runtime APIs. These Xamarin.Forms visual
objects are mapped to platform-specific objects, but Xamarin.Forms has tended to avoid implementing
anything that is unique to a particular platform.

For this reason, despite the enormous help that Xamarin.Forms can offer in creating platform-
independent applications, it is not a complete replacement for native APl programming. If your appli-
cation relies heavily on native API features such as particular types of controls or widgets, then you
might want to stick with Xamarin.iOS, Xamarin.Android, and the native Windows Phone API.

You'll probably also want to stick with the native APIs for applications that require vector graphics
or complex touch interaction. The current version of Xamarin.Forms is not quite ready for these
scenarios.

On the other hand, Xamarin.Forms is great for prototyping or making a quick proof-of-concept ap-
plication. And after you've done that, you might just find that you can continue using Xamarin.Forms
features to build the entire application. Xamarin.Forms is ideal for line-of-business applications.

Even if you begin building an application with Xamarin.Forms and then implement major parts of it
with platform APIs, you're doing so within a framework that allows you to share code and that offers
structured ways to make platform-specific visuals.

Your development environment

How you set up your hardware and software depends on what mobile platforms you're targeting and
what computing environments are most comfortable for you.
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The requirements for Xamarin.Forms are no different from the requirements for using Xamarin.iOS
or Xamarin.Android or for programming for Windows Runtime platforms.

This means that nothing in this section (and the remainder of this chapter) is specific to
Xamarin.Forms. There exists much documentation on the Xamarin website on setting up machines and
software for Xamarin.iOS and Xamarin.Android programming, and on the Microsoft website about
Windows Phone.

Machines and IDEs

If you want to target the iPhone, you're going to need a Mac. Apple requires that a Mac be used for
building iPhone and other iOS applications. You'll need to install Xcode on this machine and, of course,
the Xamarin platform that includes the necessary libraries and Xamarin Studio. You can then use
Xamarin Studio and Xamarin.Forms on the Mac for your iPhone development.

Once you have a Mac with Xcode and the Xamarin platform installed, you can also install the
Xamarin platform on a PC and program for the iPhone by using Visual Studio. The PC and Mac must
be connected via a network (such as Wi-Fi). Visual Studio communicates with the Mac through a
Secure Shell (SSH) interface, and uses the Mac to build the application and run the program on a de-
vice or simulator.

You can also do Android programming in Xamarin Studio on the Mac or in Visual Studio on the PC.

If you want to target the Windows platforms, you'll need Visual Studio 2015. You can target all the
platforms in a single IDE by running Visual Studio 2015 on a PC connected to the Mac via a network.
(That's how the sample programs in this book were created.) Another option is to run Visual Studio in a
virtual machine on the Mac.

Devices and emulators

You can test your programs on real phones connected to the machines via a USB cable, or you can test
your programs with onscreen emulators.

There are advantages and disadvantages to each approach. A real phone is essential for testing
complex touch interaction or when getting a feel for startup or response time. However, emulators al-
low you to see how your application adapts to a variety of sizes and form factors.

The iPhone and iPad emulators run on the Mac. However, because Mac desktop machines don’t
have touchscreens, you'll need to use the mouse or trackpad to simulate touch. The touch gestures on
the Mac touchpad do not translate to the emulator. You can also connect a real iPhone to the Mac,
but you'll need to provision it as a developer device.

Historically, Android emulators supplied by Google have tended to be slow and cranky, although
they are often extremely versatile in emulating a vast array of actual Android devices. Fortunately,
Visual Studio now has its own Android emulator that works rather better. It's also very easy to connect
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a real Android phone to either a Mac or PC for testing. All you really need do is enable USB Debugging
on the device.

The Windows Phone emulators are capable of several different screen resolutions and also tend to
run fairly smoothly, albeit consuming lots of memory. If you run the Windows Phone emulator on a
touchscreen, you can use touch on the emulator screen. Connecting a real Windows Phone to the PC is
fairly easy but requires enabling the phone in the Settings section for developing. If you want to un-
lock more than one phone, you'll need a developer account.

Installation

Before writing applications for Xamarin.Forms, you'll need to install the Xamarin platform on your Mac,
PC, or both (if you're using that setup). See the articles on the Xamarin website at:

https://developer.xamarin.com/quides/cross-platform/getting_started/installation/

You're probably eager to create your first Xamarin.Forms application, but before you do, you'll want
to try creating normal Xamarin projects for the iPhone and Android and normal Windows, Windows
Phone, and Windows 10 Mobile projects.

This is important: if you're experiencing a problem using Xamarin.iOS, Xamarin.Android, or
Windows, that's not a problem with Xamarin.Forms, and you'll need to solve that problem before using
Xamarin.Forms.

Creating an iOS app

If you're interested in using Xamarin.Forms to target the iPhone, first become familiar with the appro-
priate Getting Started documents on the Xamarin website:

https://developer.xamarin.com/quides/ios/getting started/

This will give you guidance on using the Xamarin.iOS library to develop an iPhone application in C#. All
you really need to do is get to the point where you can build and deploy a simple iPhone application
on either a real iPhone or the iPhone simulator.

If you're using Visual Studio, and if everything is installed correctly, you should be able to select File
> New > Project from the menu, and in the New Project dialog, from the left, select Visual C# and
iOS and then Universal (which refers to targeting both iPhone and iPad), and from the template list in
the center, select Blank App (iOS).

If you're using Xamarin Studio, you should be able to select File > New > Solution from the menu,
and in the New Project dialog, from the left, select iOS and then App, and from the template list in
the center, select Single View App.


https://developer.xamarin.com/guides/cross-platform/getting_started/installation
https://developer.xamarin.com/guides/ios/getting_started/
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In either case, select a location and name for the solution. Build and deploy the skeleton application
created in the project. If you're having a problem with this, it's not a Xamarin.Forms issue. You might
want to check the Xamarin.iOS forums to see if anybody else has a similar problem:

http://forums.xamarin.com/categories/ios/

Creating an Android app

If you're interested in using Xamarin.Forms to target Android devices, first become familiar with the
Getting Started documents on the Xamarin website:

https://developer.xamarin.com/quides/android/getting started/

If you're using Visual Studio, and if everything is installed correctly, you should be able to select File
> New > Project from the menu, and in the New Project dialog, from the left, select Visual C# and
then Android, and from the template list in the center, select Blank App (Android).

If you're using Xamarin Studio, you should be able to select File > New > Solution from the menu,
and in the New Project dialog, from the left, select Android and App, and in the template list in the
center, select Android App.

Give it a location and a name; build and deploy. If you can't get this process to work, it's not a
Xamarin.Forms issue, and you might want to check the Xamarin.Android forums for a similar problem:

http://forums.xamarin.com/categories/android/

Creating a Windows app

If you're interested in using Xamarin.Forms to target Windows, Windows Phone, or Windows 10 Mo-
bile, you'll need to become familiar with at least the rudiments of using Visual Studio to develop
Windows applications:

http://dev.windows.com/

In Visual Studio 2015, if everything is installed correctly, you should be able select File > New >
Project from the menu, and in the New Project dialog, at the left, select Visual C# and Windows.
You'll see a hierarchy under the Windows heading something like this:


http://forums.xamarin.com/categories/ios
https://developer.xamarin.com/guides/android/getting_started/
http://forums.xamarin.com/categories/android/
http://dev.windows.com/
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The first Universal heading under Windows is for creating a Universal Windows Platform applica-
tion that can target either Windows 10 or Windows 10 Mobile. Select that, and from the center area
select Blank App (Universal Windows) to create a UWP app.

The other two project types supported by Xamarin.Forms are under the Windows 8 header. The
Universal item actually creates two projects—a Windows desktop application and a Windows Phone
application with some shared code. For creating just a Windows application, choose Windows and
then from the center section Blank App (Windows 8.1). For a Windows Phone application, choose
Windows Phone and Blank App This creates a project that targets Windows Phone 8.1.

These are the three project types supported by Xamarin.Forms.

You should be able to build and deploy the skeleton application to the desktop or to a real phone
or an emulator. If not, search the Microsoft website or online forums such as Stack Overflow.

All ready?

If you can build Xamarin.iOS, Xamarin.Android, and Windows applications (or some subset of those),
then you're ready to create your first Xamarin.Forms application. It's time to say “Hello,
Xamarin.Forms"” to a new era in cross-platform mobile development.



Chapter 2
Anatomy of an app

The modern user interface is constructed from visual objects of various sorts. Depending on the oper-
ating system, these visual objects might go by different names—controls, elements, views, widgets—
but they are all devoted to the jobs of presentation or interaction or both.

In Xamarin.Forms, the objects that appear on the screen are collectively called visual elements. They
come in three main categories:

e page
e layout
e view

These are not abstract concepts! The Xamarin.Forms application programming interface (API) de-
fines classes named VisualElement, Page, Layout, and View. These classes and their descendants
form the backbone of the Xamarin.Forms user interface. visualElement is an exceptionally important
class in Xamarin.Forms. A visualElement object is anything that occupies space on the screen.

A Xamarin.Forms application consists of one or more pages. A page usually occupies all (or at least
a large area) of the screen. Some applications consist of only a single page, while others allow navi-
gating between multiple pages. In many of the early chapters in this book, you'll see just one type of
page, called a ContentPage.

On each page, the visual elements are organized in a parent-child hierarchy. The child of a con-
tentPage is generally a layout of some sort to organize the visuals. Some layouts have a single child,
but many layouts have multiple children that the layout arranges within itself. These children can be
other layouts or views. Different types of layouts arrange children in a stack, in a two-dimensional grid,
or in a more freeform manner. In this chapter, however, our pages will contain just a single child.

The term view in Xamarin.Forms denotes familiar types of presentation and interactive objects: text,
bitmaps, buttons, text-entry fields, sliders, switches, progress bars, date and time pickers, and others of
your own devising. These are often called controls or widgets in other programming environments.
This book refers to them as views or elements. In this chapter, you'll encounter the Label view for dis-
playing text.

Say hello

Using either Microsoft Visual Studio or Xamarin Studio, let’s create a new Xamarin.Forms application by
using a standard template. This process creates a solution that contains up to six projects: five platform
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projects—for iOS, Android, the Universal Windows Platform (UWP), Windows 8.1, and Windows Phone
8.1—and a common project for the greater part of your application code.

In Visual Studio, select the menu option File > New > Project. At the left of the New Project dia-
log, select Visual C# and then Cross-Platform. In the center part of the dialog you'll see several avail-
able solution templates, including three for Xamarin.Forms:

e Blank App (Xamarin.Forms Portable)
e Blank App (Xamarin.Forms Shared)
e Class Library (Xamarin.Forms)
Now what? We definitely want to create a Blank App solution, but what kind?

Xamarin Studio presents a similar dilemma but in a different way. To create a new Xamarin.Forms
solution in Xamarin Studio, select File > New > Solution from the menu, and at the left of the New
Project dialog, under Multiplatform select App, pick Forms App, and press the Next button. Toward
the bottom of the next screen are a pair of radio buttons labeled Shared Code. These buttons allow
you to choose one of the following options:

e Use Portable Class Library
e Use Shared Library

The term "Portable” in this context refers to a Portable Class Library (PCL). All the common applica-
tion code becomes a dynamic-link library (DLL) that is referenced by all the individual platform pro-
jects.

The term “Shared” in this context means a Shared Asset Project (SAP) containing loose code files
(and perhaps other files) that are shared among the platform projects, essentially becoming part of
each platform project.

For now, pick the first one: Blank App (Xamarin.Forms Portable) in Visual Studio or Use Portable
Class Library in Xamarin Studio. Give the project a name—for example, Hello—and select a disk loca-
tion for it in that dialog (in Visual Studio) or in the dialog that appears after pressing the Next button
again in Xamarin Studio.

If you're running Visual Studio, six projects are created: one common project (the PCL project) and
five application projects. For a solution named Hello, these are:

e A Portable Class Library project named Hello that is referenced by all five application projects;
e An application project for Android, named Hello.Droid;
e An application project for iOS, named Hello.iOS;

e An application project for the Universal Windows Platform of Windows 10 and Windows Mobile
10, named Hello.UWP;
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e An application project for Windows 8.1, named Hello.Windows; and
e An application project for Windows Phone 8.1, named Hello.WinPhone.

If you're running Xamarin Studio on the Mac, the Windows and Windows Phone projects are not
created.

When you create a new Xamarin.Forms solution, the Xamarin.Forms libraries (and various support
libraries) are automatically downloaded from the NuGet package manager. Visual Studio and Xamarin
Studio store these libraries in a directory named packages in the solution directory. However, the par-
ticular version of the Xamarin.Forms library that is downloaded is specified within the solution tem-
plate, and a newer version might be available.

In Visual Studio, in the Solution Explorer at the far right of the screen, right-click the solution name
and select Manage NuGet Packages for Solution. The dialog that appears contains selectable items
at the upper left that let you see what NuGet packages are installed in the solution and let you install
others. You can also select the Update item to update the Xamarin.Forms library.

In Xamarin.Studio, you can select the tool icon to the right of the solution name in the Solution list
and select Update NuGet Packages.

Before continuing, check to be sure that the project configurations are okay. In Visual Studio, select
the Build > Configuration Manager menu item. In the Configuration Manager dialog, you'll see the
PCL project and the five application projects. Make sure the Build box is checked for all the projects
and the Deploy box is checked for all the application projects (unless the box is grayed out). Take note
of the Platform column: If the Hello project is listed, it should be flagged as Any CPU. The
Hello.Droid project should also be flagged as Any CPU. (For those two project types, Any CPU is the
only option.) For the Hello.iOS project, choose either iPhone or iPhoneSimulator depending on how
you'll be testing the program.

For the Hello.UWP project, the project configuration must be x86 for deploying to the Windows
desktop or an on-screen emulator, and ARM for deploying to a phone.

For the Hello.WinPhone project, you can select x86 if you'll be using an on-screen emulator, ARM
if you'll be deploying to a real phone, or Any CPU for deploying to either. Regardless of your choice,
Visual Studio generates the same code.

If a project doesn't seem to be compiling or deploying in Visual Studio, recheck the settings in the
Configuration Manager dialog. Sometimes a different configuration becomes active and might not
include the PCL project.

In Xamarin Studio on the Mac, you can switch between deploying to the iPhone and iPhone simula-
tor through the Project > Active Configuration menu item.

In Visual Studio, you'll probably want to display the iOS and Android toolbars. These toolbars let
you choose among emulators and devices and allow you to manage the emulators. From the main
menu, make sure the View > Toolbars > iOS and View > Toolbars > Android items are checked.
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Because the solution contains anywhere from two to six projects, you must designate which pro-
gram starts up when you elect to run or debug an application.

In the Solution Explorer of Visual Studio, right-click any of the five application projects and select
the Set As StartUp Project item from the menu. You can then select to deploy to either an emulator
or a real device. To build and run the program, select the menu item Debug > Start Debugging.

In the Solution list in Xamarin Studio, click the little tool icon that appears to the right of a selected
project and select Set As Startup Project from the menu. You can then pick Run > Start Debugging
from the main menu.

If all goes well, the skeleton application created by the template will run and you'll see a short
message:

Welcome to Xamarin Forms! Welcome to Xamarin Forms!

As you can see, these platforms have different color schemes. The iOS and Windows 10 Mobile
screens display dark text on a light background, while the Android device displays light text on a black
background. By default, the Windows 8.1 and Windows Phone 8.1 platforms are like Android in dis-
playing light text on a black background.

By default, all the platforms are enabled for orientation changes. Turn the phone sideways, and
you'll see the text adjust to the new center.

The app is not only run on the device or emulator but deployed. It appears with the other apps on
the phone or emulator and can be run from there. If you don't like the application icon or how the app
name displays, you can change that in the individual platform projects.
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Inside the files

Clearly, the program created by the Xamarin.Forms template is very simple, so this is an excellent op-
portunity to examine the generated code files and figure out their interrelationships and how they
work.

Let's begin with the code that's responsible for drawing the text that you see on the screen. This is
the app class in the Hello project. In a project created by Visual Studio, the app class is defined in the
App.cs file, but in Xamarin Studio, the file is Hello.cs. If the project template hasn’t changed too much
since this chapter was written, it probably looks something like this:
using System;
using System.Collections.Generic;

using System.Linq;
using System.Text;

using Xamarin.Forms;

namespace Hello

{
public class App : Application
{
public AppQO
{
// The root page of your application
MainPage = new ContentPage
{
Content = new StacklLayout
{
VerticalOptions = LayoutOptions.Center,
Children = {
new Label {
HorizontalTextAlignment = TextAlignment.Center,
Text = "Welcome to Xamarin Forms!"
}
}
}
1
}
protected override void OnStart()
{
// Handle when your app starts
}
protected override void OnSleep()
{
// Handle when your app sleeps
}

protected override void OnResume()
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// Handle when your app resumes

Notice that the namespace is the same as the project name. This App class is defined as public and
derives from the Xamarin.Forms Application class. The constructor really has just one responsibility:
to set the MainPage property of the Application class to an object of type page.

The code that the Xamarin.Forms template has generated here shows one very simple approach to
defining this constructor: The ContentPage class derives from page and is very common in single-
page Xamarin.Forms applications. (You'll see a lot of ContentPage throughout this book.) It occupies
most of the phone’s screen with the exception of the status bar at the top of the Android screen, the
buttons on the bottom of the Android screen, and the status bar at the top of the Windows Phone
screen. (As you'll discover, the iOS status bar is actually part of the ContentPage in single-page
applications.)

The ContentPage class defines a property named Content that you set to the content of the page.
Generally this content is a layout that in turn contains a bunch of views, and in this case it's set to a
StackLayout, which arranges its children in a stack.

This stackLayout has only one child, which is a Label. The Label class derives from view and is
used in Xamarin.Forms applications to display up to a paragraph of text. The verticalOptions and
HorizontalTextAlignment properties are discussed in more detail later in this chapter.

For your own single-page Xamarin.Forms applications, you'll generally be defining your own class
that derives from ContentPage. The constructor of the App class then sets an instance of the class that
you define to its MainPage property. You'll see how this works shortly.

In the Hello solution, you'll also see an AssemblyInfo.cs file for creating the PCL and a pack-
ages.config file that contains the NuGet packages required by the program. In the References section
under Hello in the solution list, you'll see at least the four libraries this PCL requires:

e .NET (displayed as .NET Portable Subset in Xamarin Studio)
¢ Xamarin.Forms.Core

¢  Xamarin.Forms.Xaml

¢ Xamarin.Forms.Platform

It is this PCL project that will receive the bulk of your attention as you're writing a Xamarin.Forms
application. In some circumstances the code in this project might require some tailoring for the various
platforms, and you'll see shortly how to do that. You can also include platform-specific code in the five
application projects.
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The five application projects have their own assets in the form of icons and metadata, and you must
pay particular attention to these assets if you intend to bring the application to market. But during the
time that you're learning how to develop applications using Xamarin.Forms, these assets can generally
be ignored. You'll probably want to keep these application projects collapsed in the solution list be-
cause you don't need to bother much with their contents.

But you really should know what's in these application projects, so let's take a closer look.

In the References section of each application project, you'll see references to the common PCL pro-
ject (Hello in this case), as well as various .NET assemblies, the Xamarin.Forms assembles listed above,
and additional Xamarin.Forms assemblies applicable to each platform:

e Xamarin.Forms.Platform.Android

e  Xamarin.Forms.Platform.iOS

e Xamarin.Forms.Platform.UAP (not explicitly displayed in the UWP project)
e Xamarin.Forms.Platform.WinRT

e  Xamarin.Forms.Platform.WinRT.Tablet

e Xamarin.Forms.Platform.WinRT.Phone

Each of these libraries defines a static Forms. Init method in the xamarin.Forms namespace that
initializes the Xamarin.Forms system for that particular platform. The startup code in each platform
must make a call to this method.

You've also just seen that the PCL project derives a public class named app that derives from
Application. The startup code in each platform must also instantiate this app class.

If you're familiar with iOS, Android, or Windows Phone development, you might be curious to see
how the platform startup code handles these jobs.

The iOS project

An iOS project typically contains a class that derives from UIApplicationDelegate. However, the
Xamarin.Forms.Platform.iOS library defines an alternative base class named FormsApplicationDele-
gate. In the Hello.iOS project, you'll see this AppDelegate.cs file, here stripped of all extraneous
using directives and comments:

using Foundation;
using UIKit;

namespace Hello.i0S
{
[Register("AppDelegate™)]
public partial class AppDelegate :
global::Xamarin.Forms.Platform.i0S.FormsApplicationDelegate



Chapter 2 Anatomy of an app 27

{
public override bool FinishedLaunching(UIApplication app, NSDictionary options)
{
global::Xamarin.Forms.Forms.Init();
LoadApplication(new App(Q);
return base.FinishedLaunching(app, options);
}
}

The FinishedLaunching override begins by calling the Forms . Init method defined in the
Xamarin.Forms.Platform.iOS assembly. It then calls a LoadApplication method (defined by the
FormsApplicationDelegate), passing to it a new instance of the App class defined in the Hello
namespace in the shared PCL. The page object set to the MainPage property of this App object can
then be used to create an object of type UIViewController, which is responsible for rendering the
page'’s contents.

The Android project

In the Android application, the typical MainActivity class must be derived from a Xamarin.Forms
class named FormsApplicationActivity, defined in the Xamarin.Forms.Platform.Android assem-
bly, and the Forms.Init call requires some additional information:

using Android.App;

using Android.Content.PM;
using Android.0S;

namespace Hello.Droid

{
[Activity(Label = "Hello", Icon = "@drawable/icon", MainLauncher = true,
ConfigurationChanges = ConfigChanges.ScreenSize | ConfigChanges.Orientation)]
public class MainActivity : global::Xamarin.Forms.Platform.Android.FormsApplicationActivity
{
protected override void OnCreate(Bundle bundle)
{
base.OnCreate(bundle);
global::Xamarin.Forms.Forms.Init(this, bundle);
LoadAppTication(new App());
}
}
}

The new instance of the app class in the He110 namespace is then passed to a LoadApplication
method defined by FormsapplicationActivity. The attribute set on the Mainactivity class indi-
cates that the activity is not re-created when the phone changes orientation (from portrait to land-
scape or back) or the screen changes size.
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The Universal Windows Platform project

In the UWP project (or either of the two Windows projects), look first in the App.xaml.cs file tucked un-
derneath the App.xaml file in the project file list. In the onLaunched method you will see the call to
Forms.Init using the event arguments:

Xamarin.Forms.Forms.Init(e);
Now look at the MainPage.xaml.cs file tucked underneath the MainPage.xaml file in the project file list.
This file defines the customary MainPage class, but it actually derives from a Xamarin.Forms class spec-

ified as the root element in the MainPage.xaml file. A newly instantiated aApp class is passed to the
LoadApplication method defined by this base class:

namespace Hello.UWP

{
public sealed partial class MainPage
{
public MainPage()
{
this.InitializeComponent();
LoadAppTication(new Hello.App());
}
}
}

Nothing special!
If you've created a Xamarin.Forms solution under Visual Studio and don’t want to target one or more
platforms, simply delete those projects.

If you later change your mind about those projects—or you originally created the solution in
Xamarin Studio and want to move it to Visual Studio to target one of the Windows platforms—you can
add new platform projects to the Xamarin.Forms solution. In the Add New Project dialog, you can
create a Unified API (not Classic API) Xamarin.iOS project by selecting the iOS project Universal type
and Blank App template. Create a Xamarin.Android project with the Android Blank App template,
or a Windows project by selecting Universal under the Windows heading (for a UWP project), or
Windows or Windows Phone under the Windows 8 heading, and then Blank App.

For these new projects, you can get the correct references and boilerplate code by consulting the
projects generated by the standard Xamarin.Forms template.

To summarize: there's really nothing all that special in a Xamarin.Forms app compared with normal
Xamarin or Windows Phone projects—except the Xamarin.Forms libraries.
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PCL or SAP?

When you first created the Hello solution in Visual Studio, you had a choice of two application tem-
plates:

e Blank App (Xamarin.Forms Portable)
e Blank App (Xamarin.Forms Shared)
In Xamarin Studio, the choice is embodied in a pair of radio buttons:
e Use Portable Class Library
e Use Shared Library

The first option creates a Portable Class Library (PCL), whereas the second creates a Shared Asset Pro-
ject (SAP) consisting only of shared code files. The original Hello solution used the PCL template. Now
let's create a second solution named HelloSap with the SAP template.

As you'll see, everything looks pretty much the same, except that the HelloSap project itself con-
tains only one item: the App.cs file.

With both the PCL and SAP approaches, code is shared among the five applications, but in decid-
edly different ways: With the PCL approach, all the common code is bundled into a dynamic-link li-
brary that each application project references and binds to at run time. With the SAP approach, the
common code files are effectively included with each of the five application projects at build time. By
default, the SAP has only a single file named App.cs, but effectively it's as if this HelloSap project did
not exist and instead there were five different copies of this file in the five application projects.

Some subtle (and not-so-subtle) problems can manifest themselves with the shared library
approach:

The iOS and Android projects have access to pretty much the same version of .NET, but it is not the
same version of .NET that the Windows projects use. This means that any .NET classes accessed by the
shared code might be somewhat different depending on the platform. As you'll discover later in this
book, this is the case for some file I/O classes in the System.T0 namespace.

You can compensate for these differences by using C# preprocessor directives, particularly #1if and
#elif. In the projects generated by the Xamarin.Forms template, the various application projects de-
fine symbols that you can use with these directives.

What are these symbols?

In Visual Studio, right-click the project name in the Solution Explorer and select Properties. At the
left of the properties screen, select Build, and look for the Conditional compilation symbols field.

In Xamarin Studio, select an application project in the Solution list, invoke the drop-down tools
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menu, and select Options. In the left of the Project Options dialog, select Build > Compiler, and look
for the Define Symbols field.

Here are the symbols that you can use:

iOS project: You'll see the symbol _10s__ (that's two underscores before and after)

e Android project: You won't see any symbols defined for indicating the platform, but the identi-
fier ANDROID is defined anyway, as well as multiple  ANDROID nn_identifiers, where nn
is each Android API level supported.

e UWP project: The symbol WINDOWS UWP
e  Windows project: The symbol WINDOWS APP
¢  Windows Phone project: The symbol WINDOWS PHONE APP

Your shared code file can include blocks like this:

#if _I0S__

// i0S specific code
#elif _ANDROID__

// Android specific code
#e1if WINDOWS_UWP

// Universal Windows Platform specific code
#e1if WINDOWS_APP

// Windows 8.1 specific code
#e1if WINDOWS__PHONE_APP

// Windows Phone 8.1 specific code
#endif

This allows your shared code files to run platform-specific code or access platform-specific classes, in-
cluding classes in the individual platform projects. You can also define your own conditional compila-
tion symbols if you'd like.

These preprocessor directives make no sense in a Portable Class Library project. The PCL is entirely
independent of the five platforms, and these identifiers in the platform projects are not present when
the PCL is compiled.

The concept of the PCL originally arose because every platform that uses .NET actually uses a some-
what different subset of .NET. If you want to create a library that can be used among multiple .NET
platforms, you need to use only the common parts of those .NET subsets.

The PCL is intended to help by containing code that is usable on multiple (but specific) .NET plat-
forms. Consequently, any particular PCL contains some embedded flags that indicate what platforms it
supports. A PCL used in a Xamarin.Forms application must support the following platforms:

e .NET Framework 4.5

e  Windows 8
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e  Windows Phone 8.1

e  Xamarin.Android

e  Xamarin.iOS

e Xamarin.iOS (Classic)
This is known as PCL Profile 111.

If you need platform-specific behavior in the PCL, you can't use the C# preprocessor directives be-
cause those work only at build time. You need something that works at run time, such as the Xamarin-
.Forms Device class. You'll see an example shortly.

The Xamarin.Forms PCL can access other PCLs supporting the same platforms, but it cannot directly
access classes defined in the individual application projects. However, if that's something you need to
do—and you'll see an example in Chapter 9, "Platform-specific API calls"—Xamarin.Forms provides a
class named DependencyService that allows you to access platform-specific code from the PCL in a
methodical manner.

Most of the programs in this book use the PCL approach. This is the recommended approach for
Xamarin.Forms and is preferred by many programmers who have been working with Xamarin.Forms
for a while. However, the SAP approach is also supported and definitely has its advocates as well. Pro-
grams within these pages that demonstrate the SAP approach always contain the letters Sap at the end
of their names, such as the HelloSap program.

But why choose? You can have both in the same solution. If you've created a Xamarin.Forms solu-
tion with a Shared Asset Project, you can add a new PCL project to the solution by selecting the Class
Library (Xamarin.Forms Portable) template. The application projects can access both the SAP and
PCL, and the SAP can access the PCL as well.

Labels for text

Let's create a new Xamarin.Forms PCL solution, named Greetings, using the same process described
above for creating the Hello solution. This new solution will be structured more like a typical
Xamarin.Forms program, which means that it will define a new class that derives from ContentPage.
Most of the time in this book, every class and structure defined by a program will get its own file. This
means that a new file must be added to the Greetings project:

In Visual Studio, you can right-click the Greetings project in the Solution Explorer and select Add
> New Item from the menu. At the left of the Add New Item dialog, select Visual C# and Cross-
Platform, and in the center area, select Forms ContentPage. (Watch out: There's also a Forms
ContentView option. Don't pick that one!)

In Xamarin Studio, from the tool icon on the Greetings project, select Add > New File from the
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menu. In the left of the New File dialog, select Forms, and in the central area, select Forms
ContentPage. (Watch out: There are also Forms ContentView and Forms ContentPage Xaml op-
tions. Don't pick those!)

In either case, give the new file a name of GreetingsPage.cs.

The GreetingsPage.cs file will be initialized with some skeleton code for a class named Greet-
ingsPage that derives from ContentPage. Because ContentPage is in the Xamarin.Forms
namespace, a using directive includes that namespace. The class is defined as public, but it need not
be because it won't be directly accessed from outside the Greetings project.

Let's delete all the code in the GreetingsPage constructor and most of the using directives, so
the file looks something like this:

using System;
using Xamarin.Forms;

namespace Greetings

{
public class GreetingsPage : ContentPage
{
public GreetingsPage()
{
}
}
}

In the constructor of the GreetingsPage class, instantiate a Label view, set its Text property, and
set that Label instance to the Content property that GreetingsPage inherits from ContentPage:

using System;
using Xamarin.Forms;

namespace Greetings

{
public class GreetingsPage : ContentPage
{
public GreetingsPage()
{
Label Tabel = new Label(Q);
label.Text = "Greetings, Xamarin.Forms!";
this.Content = Tlabel;
}
}
}

Now change the app class in App.cs to set the MainPage property to an instance of this Greet-
ingsPage class:

using System;
using Xamarin.Forms;
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namespace Greetings

{
public class App : Application
{
public AppQ
{
MainPage = new GreetingsPage();
}
protected override void OnStart()
{
// Handle when your app starts
}
protected override void OnSleep()
{
// Handle when your app sleeps
}
protected override void OnResume()
{
// Handle when your app resumes
}
}
}

It's easy to forget this step, and you'll be puzzled that your program seems to completely ignore your
page class and still says "Welcome to Xamarin Forms!"

Itis in the GreetingsPage class (and others like it) where you'll be spending most of your time in
early Xamarin.Forms programming. For some single-page, Ul-intensive programs, this class might con-
tain the only application code that you'll need to write. Of course, you can add additional classes to the
project if you need them.

In many of the single-page sample programs in this book, the class that derives from ContentPage
will have a name that is the same as the application but with Page appended. That naming convention
should help you identify the code listings in this book from just the class or constructor name without
seeing the entire file. In most cases, the code snippets in the pages of this book won't include the us-
ing directives or the namespace definition.

Many Xamarin.Forms programmers prefer to use the C# 3.0 style of object creation and property
initialization in their page constructors. You can do this for the Label object. Following the Label
constructor, a pair of curly braces enclose one or more property settings separated by commas. Here's
an alternative (but functionally equivalent) GreetingsPage definition:

public class CreetingsPage : ContentPage

{
public GreetingsPage()

{
Label Tabel = new Label
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{

Text = "Greetings, Xamarin.Forms!"
1
this.Content = label;

This style of property initialization allows the Labe1 instance to be set to the Content property di-
rectly, so that the Label doesn’t require a name, like so:

public class GreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!"
};
}
}

For more complex page layouts, this style of instantiation and initialization provides a better visual
analogue of the organization of layouts and views on the page. However, it's not always as simple as
this example might indicate if you need to call methods on these objects or set event handlers.

Whichever way you do it, if you can successfully compile and run the program on the iOS, Android,
and Windows 10 Mobile platforms on either an emulator or a device, here’s what you'll see:

all 7

reetings, Xamarin.Forms!

The most disappointing version of this Greetings program is definitely the iPhone: Beginning in iOS
7, a single-page application shares the screen with the status bar at the top. Anything the application
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displays at the top of its page will occupy the same space as the status bar unless the application com-
pensates for it.

This problem disappears in multipage-navigation applications discussed later in this book, but until
that time, here are four ways (or five ways if you're using an SAP) to solve this problem right away.

Solution 1. Include padding on the page

The page class defines a property named padding that marks an area around the interior perimeter of
the page into which content cannot intrude. The Padding property is of type Thickness, a structure
that defines four properties named Left, Top, Right, Bottom. (You might want to memorize that or-
der because that's the order you'll define the properties in the Thickness constructor as well as in
XAML.) The Thickness structure also defines constructors for setting the same amount of padding on
all four sides or for setting the same amount on the left and right and on the top and bottom.

A little research in your favorite search engine will reveal that the iOS status bar has a height of 20.
(Twenty what? you might ask. Twenty pixels? Actually, no. For now, just think of them as 20 "units.” For
much of your Xamarin.Forms programming, you shouldn’t need to bother with numeric sizes, but
Chapter 5, “Dealing with sizes,” will provide some guidance when you need to get down to the pixel
level.)

You can accommodate the status bar like so:

namespace Greetings

{
public class GreetingsPage : ContentPage
{
public GreetingsPage ()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!"
};
Padding = new Thickness(0, 20, 0, 0);
}
}
}

Now the greeting appears 20 units from the top of the page:
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Corier 1416 PM

=
reetings, Xamarin Forms!

Setting the Padding property on the ContentPage solves the problem of the text overwriting the
iOS status bar, but it also sets the same padding on the Android and Windows Phone, where it's not
required. Is there a way to set this padding only on the iPhone?

Solution 2. Include padding just for iOS (SAP only)
One of the advantages of the Shared Asset Project (SAP) approach is that the classes in the project are

extensions of the application projects, so you can use conditional compilation directives.

Let's try this out. We'll need a new solution named GreetingsSap based on the SAP template, and a
new page class in the GreetingsSap project named GreetingsSapPage. To set the Padding in iOS
only, that class looks like this:

namespace GreetingsSap

{
public class GreetingsSapPage : ContentPage
{
public GreetingsSapPage ()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!"
1
#if _I0S__

Padding = new Thickness(0, 20, 0, 0);

#endif
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}

The #if directive references the conditional compilation symbol 105, so the Padding property is
set only for the iOS project. The results look like this:

Carior 7 17 PM
reetings, Xamarin.Forms!

However, these conditional compilation symbols affect only the compilation of the program, so they
have no effect in a PCL. Is there a way for a PCL project to include different padding for different plat-
forms?

Solution 3. Include padding just for iOS (PCL or SAP)

Yes! The static Device class includes several properties and methods that allow your code to deal with
device differences at run time in a very simple and straightforward manner:

e The Device.Os property returns a member of the TargetPlatform enumeration: 10s,
Android, WinPhone, or Other. The WinPhone member refers to all the Windows and Windows
Phone platforms.

e The Device.Idiom property returns a member of the TargetIdiom enumeration: Phone,
Tablet, Desktop, Or Unsupported.

You can use these two properties in i f and else statements, or a switch and case block, to execute
code specific to a particular platform.

Two methods named onPlatform provide even more elegant solutions:
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e The static generic method OnPlatform<T> takes three arguments of type T—the first for iOS,
the second for Android, and the third for Windows Phone (encompassing all the Windows plat-
forms)—and returns the argument for the running platform.

e  The static method onPlatform has four arguments of type Action (the .NET function delegate
that has no arguments and returns void), also in the order iOS, Android, and Windows Phone,
with a fourth for a default, and executes the argument for the running platform.

Rather than setting the same pPadding property on all three platforms, you can restrict the Padding
to just the iPhone by using the Device.oOnPlatform generic method:
Padding = Device.OnPlatform<Thickness>(new Thickness(0, 20, 0, 0),

new Thickness(0),
new Thickness(0));

The first Thickness argument is for iOS, the second is for Android, and the third is for Windows
Phone. Explicitly specifying the type of the Device.OnPlatform arguments within the angle brackets
isn't required if the compiler can figure it out from the arguments, so this works as well:

Padding = Device.OnPlatform(new Thickness(0, 20, 0, 0),

new Thickness(0),
new Thickness(0));

Or, you can have just one Thickness constructor and use Device.OnPlatform for the second
argument:
Padding = new Thickness(0, Device.OnPlatform(20, 0, 0), 0, 0);
This is how the Padding will usually be set in the programs that follow when it's required. Of course,

you can substitute some other numbers for the zeroes if you want some additional padding on the
page. Sometimes a little padding on the sides makes for a more attractive display.

However, if you just need to set Padding for iOS, you can use the version of Device.OnPlatform
with Action arguments. These arguments are null by default, so you can just set the first for an ac-
tion to be performed on iOS:

public class CreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!"
1
Device.OnPlatform((Q) =>
{
Padding = new Thickness(0, 20, 0, 0);
s
}
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Now the statement to set the padding is executed only when the program is running on iOS. Of
course, with just that one argument to Device.oOnPlatform, it could be a little obscure to people
who need to read your code, so you might want to include the parameter name preceding the argu-
ment to make it explicit that this statement executes just for iOS:

Device.OnPlatform(i0OS: () =>
{

Padding = new Thickness(0, 20, 0, 0);
s
Naming the argument like that is a feature introduced in C# 4.0.

The Device.oOnPlatform method is very handy and has the advantage of working in both PCL and
SAP projects. However, it can't access APIs within the individual platforms. For that you'll need
DependencyService, which is discussed in Chapter 9.

Solution 4. Center the label within the page

The problem with the text overlapping the iOS status bar occurs only because the default display of the
text is at the upper-left corner. Is it possible to center the text on the page?

Xamarin.Forms supports a number of facilities to ease layout without requiring the program to per-
form calculations involving sizes and coordinates. The view class defines two properties, named
HorizontalOptions and VerticalOptions, that specify how a view is to be positioned relative to
its parent (in this case the ContentPage). These two properties are of type LayoutOptions, an excep-
tionally important structure in Xamarin.Forms.

Generally you'll use the LayoutOptions structure by specifying one of the eight public static read-
only fields that it defines that return LayoutOptions values:

. Start

° Center

. End

° Fill

J StartAndExpand
. CenterAndExpand
o EndAndExpand

. FillAndExpand

However, you can also create a LayoutOptions value yourself. The LayoutOptions structure also
defines two instance properties that let you create a value with these same combinations:

e AnAlignment property of type LayoutAlignment, an enumeration with four members:
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Start, Center, End, and Fil1l
e An Expands property of type bool.

A fuller explanation of all these options awaits you in Chapter 4, “Scrolling the stack,” but for now
you can set the HorizontalOptions and VerticalOptions properties of the Label to one of the
static fields defined by LayoutOptions values. For HorizontalOptions, the word start means left
and End means right; for verticalOptions, Start means top and End means bottom.

Mastering the use of the HorizontalOptions and VerticalOptions properties is a major part of
acquiring skill in the Xamarin.Forms layout system, but here's a simple example that positions the
Label in the center of the page:

public class GreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!",
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
b
}
}

Here's how it looks:

Greetings, Xamarin.Forms! Greetings, Xamarin.Forms!
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This is the version of the Greetings program that is included in the sample code for this chapter.
You can use various combinations of HorizontalOptions and VerticalOptions to position the
text in any of nine places relative to the page.

Solution 5. Center the text within the label

The Label is intended to display text up to a paragraph in length. It is often desirable to control how
the lines of text are horizontally aligned: left justified, right justified, or centered.

The Label view defines a HorizontalTextAlignment property for that purpose and also a ver-
ticalTextAlignment property for positioning text vertically. Both properties are set to a member of
the TextAlignment enumeration, which has members named start, Center, and End to be versatile
enough for text that runs from right to left or from top to bottom. For English and other European lan-
guages, Start means left or top and End means right or bottom.

For this final solution to the iOS status bar problem, set HorizontalTextAlignment and Verti-
calTextAlignment tO TextAlignment.Center:

public class CreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!",
HorizontalTextAlignment = TextAlignment.Center,
VerticalTextAlignment = TextAlignment.Center
};
}
}

Visually, the result with this single line of text is the same as setting HorizontalOptions and
VerticalOptions to Center, and you can also use various combinations of these properties to posi-
tion the text in one of nine different locations around the page.

However, these two techniques to center the text are actually quite different, as you'll see in the
next chapter.
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Despite how sophisticated graphical user interfaces have become, text remains the backbone of most
applications. Yet text is potentially one of the most complex visual objects because it carries baggage
of hundreds of years of typography. The primary consideration is that text must be readable. This re-
quires that text not be too small, yet text mustn't be so large that it hogs a lot of space on the screen.

For these reasons, the subject of text is continued in several subsequent chapters, most notably
Chapter 5, “Dealing with sizes.” Very often, Xamarin.Forms programmers define font characteristics in
styles, which are the subject of Chapter 12.

Wrapping paragraphs

Displaying a paragraph of text is as easy as displaying a single line of text. Just make the text long
enough to wrap into multiple lines:

public class BaskervillesPage : ContentPage
{
public BaskervillesPage()
{
Content = new Label
{
VerticalOptions = LayoutOptions.Center,
Text =
"Mr. Sherlock Holmes, who was usually very late in " +
"the mornings, save upon those not infrequent " +
"occasions when he was up all night, was seated at " +

"the breakfast table. I stood upon the hearth-rug " +
"and picked up the stick which our visitor had left " +
"behind him the night before. It was a fine, thick " +
"piece of wood, bulbous-headed, of the sort which " +
"is known as a \u201CPenang lawyer.\u201D Just " +
"under the head was a broad silver band, nearly an " +
"inch across, \u201CTo James Mortimer, M.R.C.S., " +
"from his friends of the C.C.H.,\u201D was engraved " +
"upon it, with the date \u201C1884.\u201D It was " +

"

"just such a stick as the old-fashioned family " +
"practitioner used to carry\u20l4dignified, solid, " +
"and reassuring."

};

Padding = new Thickness(5, Device.OnPlatform(20, 5, 5), 5, 5);
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Notice the use of embedded Unicode codes for opened and closed “smart quotes” (\u201C and
\u201D) and the em dash (\u2014). padding has been set for 5 units around the page to avoid the text
butting up against the edges of the screen, but the verticaloptions property has been used as well
to vertically center the entire paragraph on the page:

Mr. Sherlock Holmes, who was usually very late
in the mornings, save upon those not
infrequent occasions when he was up all night,

was seated at the breakfast table. | stood upon
the hearth-rug and picked up the stick which
our visitor had left behind him the night before.
It was a fine, thick piece of wood, bulbous-

headed, of the sort which is known as a
“Penang lawyer.” Just under the head was a
broad silver band, nearly an inch across, “To
James Mortimer, M.R.C.S., from his friends of
the C.C.H.," was engraved upon it, with the
date “1884." It was just such a stick as the old-
fashioned family practitioner used to carry—
dignified, salid, and reassuring.

Mr. Sherlock Holmes, who was usually very late in
the mornings, save upon those not infrequent
occasions when he was up all night, was seated at
the breakfast table. | stood upon the hearth-rug
and picked up the stick which our visitor had left
behind him the night before. It was a fine, thick
piece of wood, bulbous-headed, of the sort which

is known as a “Penang lawyer.” Just under the
head was a broad silver band, nearly an inch
across, "To James Mortimer, MR.CS., from his
friends of the C.CH.” was engraved upon it, with
the date "1884." It was just such a stick as the old-
fashioned family practitioner used to carry—
dignified, solid, and reassuring.

For this paragraph of text, setting HorizontalOptions to Start, Center, or End on iOS or
Windows Phone will shift the entire paragraph horizontally slightly to the left, center, or right. (Android
works a little differently for multiple lines of text.) The shifting is only slight because the width of the
paragraph is the width of the longest line of text. Since word wrapping is governed by the page width
(minus the padding), the paragraph likely occupies just slightly less width than the width available for it
on the page.

But setting the HorizontalTextAlignment property of the Label has a much more profound
effect: Setting this property affects the alignment of the individual lines. A setting of Textalign-
ment.Center will center all the lines of the paragraph, and TextAlignment.Right aligns them all at
the right. You can use HorizontalOptions in addition to HorizontalTextAlignment to shift the
entire paragraph slightly to the center or the right.

However, after you've set VerticalOptions to Start, Center, Or End, any setting of vertical-
TextAlignment has no effect.

Label defines a LineBreakMode property that you can set to a member of the LineBreakMode
enumeration if you don't want the text to wrap or to select truncation options.

There is no property to specify a first-line indent for the paragraph, but you can add one of your
own with space characters of various types, such as the em space (Unicode \u2003).
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You can display multiple paragraphs with a single Label view by ending each paragraph with one
or more line feed characters (\n). However, a better approach is to use the string returned from the
Environment.NewLine static property. This property returns “\n” on iOS and Android devices and
“\r\n" on all Windows and Windows Phone devices. But rather than embedding line feed characters to
create paragraphs, it makes more sense to use a separate Label view for each paragraph, as will be
demonstrated in Chapter 4, “Scrolling the stack.”

The Label class has lots of formatting flexibility. As you'll see shortly, properties defined by Label
allow you to specify a font size or bold or italic text, and you can also specify different text formatting
within a single paragraph.

Label also allows specifying color, and a little experimentation with color will demonstrate the pro-
found difference between the HorizontalOptions and VerticalOptions properties and the Hori-
zontalTextAlignment and VerticalTextAlignment properties.

Text and background colors

As you've seen, the Label view displays text in a color appropriate for the device. You can override
that behavior by setting two properties, named TextColor and BackgroundColor. Label itself de-
fines TextColor, but it inherits BackgroundColor from VisualElement, which means that Page
and Layout also have a BackgroundColor property.

You set TextColor and BackgroundColor to a value of type Color, which is a structure that de-
fines 17 static fields for obtaining common colors. You can experiment with these properties with the
Greetings program from the previous chapter. Here are two of these colors used in conjunction with
HorizontalTextAlignment and VerticalTextAlignment to center the text:

public class CreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!",
HorizontalTextAlignment = TextAlignment.Center,
VerticalTextAlignment = TextAlignment.Center,
BackgroundColor = Color.Yellow,
TextColor = Color.Blue
};
}
}

The result might surprise you. As these screenshots illustrate, the Label actually occupies the entire
area of the page (including underneath the iOS status bar), and the HorizontalTextAlignment and
VerticalTextAlignment properties position the text within that area:
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Greetings, Xamarin Forms!

' i |
Greetings, Xamarin Forms! Greetings, Xamarin.Forms!

In contrast, here’s some code that colors the text the same but instead centers the text using the
HorizontalOptions and VerticalOptions properties:

public class GreetingsPage : ContentPage

{
public GreetingsPage()
{
Content = new Label
{
Text = "Greetings, Xamarin.Forms!",
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
BackgroundColor = Color.Yellow,
TextColor = Color.Blue
b
}
}

Now the Label occupies only as much space as required for the text, and that's what's positioned in
the center of the page:
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[Greetings, Xamarin Forms

Greetings, Xamarin.Forms!

Greetings, Xamarin.Forms!

The default value of HorizontalOptions and VerticalOptions is not LayoutOptions.Start,
as the default appearance of the text might suggest. The default value is instead LayoutOp-
tions.Fill. This is the setting that causes the Label to fill the page. The default Horizontal-
TextAlignment and VerticalTextAlignment value of TextAlignment.Start is what caused the
text to be positioned at the upper-left in the first version of the Greetings program in the previous
chapter.

You can combine various settings of HorizontalOptions, VerticalOptions, HorizontalText-
Alignment, and VerticalTextAlignment for different effects.

You might wonder: What are the default values of the TextColor and BackgroundColor proper-
ties, because the default values result in different colors for the different platforms?

The default value of TextColor and BackgroundColor is actually a special color value named
Color.Default, which does not represent a real color but instead is used to reference the text and
background colors appropriate for the particular platform.

Let's explore color in more detail.

The Color structure

Internally, the color structure stores colors in two different ways:

e Asred, green, and blue (RGB) values of type double that range from 0 to 1. Read-only proper-
ties named R, G, and B expose these values.
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e  As hue, saturation, and luminosity values of type double, which also range from 0 to 1. These
values are exposed with read-only properties named Hue, Saturation, and Luminosity.

The Color structure also supports an alpha channel for indicating degrees of opacity. A read-only
property named A exposes this value, which ranges from 0 for transparent to 1 for opaque.

All the properties that define a color are read-only. In other words, once a Color value is created, it
is immutable.

You can create a Color value in one of several ways. The three constructors are the easiest:

. new Color (double grayShade)

(] new Color (double r, double g, double b)

. new Color (double r, double g, double b, double a)

Arguments can range from 0 to 1. Color also defines several static creation methods, including:
(] Color.FromRgb (double r, double g, double Db)

. Color.FromRgb (int r, int g, int Db)

. Color.FromRgba (double r, double g, double b, double a)

° Color.FromRgba (int r, int g, int b, int a)

. Color.FromHsla (double h, double s, double 1, double a)

The two static methods with integer arguments assume that the values range from 0 to 255, which
is the customary representation of RGB colors. Internally, the constructor simply divides the integer val-
ues by 255.0 to convert to double.

Watch out! You might think that you're creating a red color with this call:

Color.FromRgb (1, 0, 0)

However, the C# compiler will assume that these arguments are integers. The integer FromkRgb method
will be invoked, and the first argument will be divided by 255.0, with a result that is nearly zero. If you
want to invoke the method that has double arguments, be explicit:

Color.FromRgb (1.0, 0, 0)

Color also defines static creation methods for a packed uint format and a hexadecimal format in a
string, but these are used less frequently.

The Ccolor structure also defines 17 public static read-only fields of type Color. In the table below,
the integer RGB values that the Color structure uses internally to define these fields are shown to-
gether with the corresponding Hue, Saturation, and Luminosity values, somewhat rounded for
purposes of clarity:



Chapter 3 Deeper into text 48
Color Fields Color Red Green Blue Hue Saturation Luminosity
White 255 255 255 0 0 1.00
Silver 192 192 192 0 0 0.75
Gray [ ] 128 128 128 0 0 0.50
Black [ ] 0 0 0 0 0 0
Red [ ] 255 0 0 1.00 1 0.50
Maroon [ ] 128 0 0 1.00 1 0.25
Yellow 255 255 0 0.17 1 0.50
Olive [ ] 128 128 0 0.17 1 0.25
Lime 0 255 0 0.33 1 0.50
Green [ ] 0 128 0 0.33 1 0.25
Aqua 0 255 255 0.50 1 0.50
Teal [ ] 0 128 128 0.50 1 0.25
Blue [ ] 0 0 255 0.67 1 0.50
Navy [ ] 0 0 128 0.67 1 0.25
Pink 255 102 255 0.83 1 0.70
Fuchsia [ ] 255 0 255 0.83 1 0.50
Purple [ ] 128 0 128 0.83 1 0.25

With the exception of Pink, you might recognize these as the color names supported in HTML. An
18th public static read-only field is named Transparent, which has R, G, B, and a properties all set to

Zero.

When people are given an opportunity to interactively formulate a color, the HSL color model is of-
ten more intuitive than RGB. The Hue cycles through the colors of the visible spectrum (and the rain-

bow) beginning with red at 0, green at 0.33, blue at 0.67, and back to red at 1.

The saturation indicates the degree of the hue in the color, ranging from 0, which is no hue at all

and results in a gray shade, to 1 for full saturation.

The Luminosity is a measure of lightness, ranging from 0 for black to 1 for white.

Color-selection programs in Chapter 15, “The interactive interface,” let you explore the RGB and HSL

models more interactively.

The color structure includes several interesting instance methods that allow creating new colors

that are modifications of existing colors:
. AddLuminosity (double delta)
. MultiplyAlpha (double alpha)
o WithHue (double newHue)
. WithLuminosity (double newLuminosity)

. WithSaturation (double newSaturation)

Finally, color defines two special static read-only properties of type Color:

. Color.Default

. Color.Accent
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The Color.Default property is used extensively within Xamarin.Forms to define the default color of
views. The VisualElement class initializes its BackgroundColor property to Color.Default, and
the Label class initializes its TextColor property as Color.Default.

However, Color.Default is a Color value with its R, G, B, and A properties all set to -1, which
means that it's a special “mock” value that means nothing in itself but indicates that the actual value is
platform specific.

For Label and ContentPage (and most classes that derive from visualElement), the
BackgroundColor setting of Color.Default means transparent. The background color you see on
the screen is the background color of the page. The BackgroundColor property of the page has a de-
fault setting of Color.Default, but that value means something different on the various platforms.
The meaning of Color.Default for the TextColor property of Label is also device dependent.

Here are the default color schemes implied by the BackgroundColor of the page and the
TextColor of the Label:

Platform Color Scheme

iOS Dark text on a light background
Android Light text on a dark background
Uwp Dark text on a light background
Windows 8.1 Light text on a dark background
Windows Phone 8.1 Light text on a dark background

On Android, Windows, and Windows Phone devices, you can change this color scheme for your appli-
cation. See the next section.

You have a couple of possible strategies for working with color: You can choose to do your
Xamarin.Forms programming in a very platform-independent manner and avoid making any assump-
tions about the default color scheme of any phone. Or, you can use your knowledge about the color
schemes of the various platforms and use Device.OnPlatform to specify platform-specific colors.

But don't try to just ignore all the platform defaults and explicitly set all the colors in your applica-
tion to your own color scheme. This probably won't work as well as you hope because many views use
other colors that relate to the color theme of the operating system but that are not exposed through
Xamarin.Forms properties.

One straightforward option is to use the Color.Accent property for an alternative text color. On
the iPhone and Android platforms, this is a color that is visible against the default background but is
not the default text color. On the Windows platforms, it's a color selected by the user as part of the
color theme.

You can make text semitransparent by setting TextColor to a Color value with an A property less
than 1. However, if you want a semitransparent version of the default text color, use the opacity
property of the Label instead. This property is defined by the VvisualElement class and has a default
value of 1. Set it to values less than 1 for various degrees of transparency.
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Changing the application color scheme

When targeting your application for Android, Windows, and Windows Phone, it is possible to change
the color scheme for the application. In this case, the settings of Color.Default for the Back-
groundColor of the ContentPage and the TextColor property of the Label will have different
meanings.

There are several ways to set color schemes in Android, but the simplest requires only a single at-
tribute setting in the AndroidManifest.xml file in the Properties folder of the Android project. That file
normally looks like this:
<manifest xmlns:android="http://schemas.android.com/apk/res/android">

<uses-sdk android:minSdkVersion="15" />

<application>

</application>
</manifest>

Add the following attribute to the application tag:

<manifest xmlns:android="http://schemas.android.com/apk/res/android">
<uses-sdk android:minSdkVersion="15" />
<application android:theme="@style/android:Theme.Holo.Light">
</application>
</manifest>

Now your Android application will display dark text on a light background.

For the three Windows and Windows Phone projects, you'll need to change the App.xaml file lo-
cated in the particular project.

In the UWP project, the default App.xaml file looks like this:

<AppTlication
x:Class="Baskervilles.UWP.App"
xmIns="http://schemas.microsoft.com/winfx/2006/xaml/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2006/xam1"
xmlns:local="using:Baskervilles.UWP"
RequestedTheme="Light">

</Application>

That RequestedTheme attribute is what gives the UWP application a color scheme of dark text on a
light background. Change it to Dark for light text on a dark background. Remove the Requested-
Theme attribute entirely to allow the user's setting to determine the color scheme.

The App.xaml file for the Windows Phone 8.1 and Windows 8.1 projects is similar, but the Request-
edTheme attribute is not included by default. Here's the App.xaml file in the WinPhone project:

<Application
x:Class="Baskervilles.WinPhone.App"
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xmlns="http://schemas.microsoft.com/winfx/2006/xam1/presentation”
xmlns:x="http://schemas.microsoft.com/winfx/2006/xam1"
xmlns:local="using:Baskervilles.WinPhone">

</Application>

By default, the color scheme is determined by the user's setting. You can include a RequestedTheme
attribute and set it to Light or Dark to override the user's preference and take control of the color
scheme.

By setting RequestedTheme on your Windows Phone and Windows projects, your application
should have complete knowledge of the underlying color schemes on all the platforms.

Font sizes and attributes

By default, the Label uses a system font defined by each platform, but Label also defines several
properties that you can use to change this font. Label is one of only two classes with these font-re-
lated properties; Button is the other.

The properties that let you change this font are:
e FontFamily of type string
e FontSize of type double

e FontAttributes of type FontAttributes, an enumeration with three members: None, Bo1ld,
and Italic.

There is also a Font property and corresponding Font structure, but this is deprecated and should not
be used.

The hardest of these to use is FontFamily. In theory you can set it to a font family name such as
“Times Roman,” but it will work only if that particular font family is supported on the particular plat-
form. For this reason, you'll probably use FontFamily in connection with Device.OnPlatform, and
you'll need to know each platform’s supported font family names.

The FontSize property is a little awkward as well. You need a number that roughly indicates the
height of the font, but what numbers should you use? This is a thorny issue, and for that reason, it's
relegated to Chapter 5, "Dealing with sizes,” when the tools to pick a good font size will become avail-
able.

Until then, however, the Device class helps out with a static method called GetNamedSize. This
method requires a member of the NamedSize enumeration:

. Default

° Micro
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. Small

. Medium

L] Large

GetNamedSize also requires the type of the class that you're sizing with this font size, and that ar-
gument will be either typeof (Label) or typeof (Button).You can also use an instance of Label or
Button itself rather than the Type, but this option is often less convenient.

As you'll see later in this chapter, the Namedsize .Medium member does not necessarily return the
same size as NamedSize.Default.

FontAttributes is the least complicated of the three font-related properties to use. You can spec-

ify Bold or Italic or both, as this little snippet of code (adapted from the Greetings program from
the previous chapter) demonstrates:

class GreetingsPage : ContentPage

{

public GreetingsPage()

{

Content = new Label

{

Text = "Greetings, Xamarin.Forms!",

HorizontalOptions = LayoutOptions.Center,

VerticalOptions = LayoutOptions.Center,

FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold | FontAttributes.Italic

Here it is on the three platforms:
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Greetings, Xamarin.Forms! GFGEflngS,

Greetings, Xamarin.Forms!

Xamarin.Forms!

The Windows 10 Mobile screen is not quite wide enough to display the text in a single line.

Formatted text

As you've seen, Label has a Text property that you can set to a string. But Labe1 also has an alterna-
tive FormattedText property that constructs a paragraph with nonuniform formatting.

The FormattedText property is of type FormattedString, which has a Spans property of type
IList<Span>, a collection of span objects. Each Span object is a uniformly formatted chunk of text
that is governed by six properties:

. Text

[ FontFamily

[ FontSize

o FontAttributes
. ForegroundColor
. BackgroundColor

Here's one way to instantiate a FormattedString object and then add span instances to its Spans
collection property:

public class VariableFormattedTextPage : ContentPage

{
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public VariableFormattedTextPage()

{
FormattedString formattedString = new FormattedString(Q);
formattedString.Spans.Add(new Span
{
Text = "I "
b
formattedString.Spans.Add(new Span
{
Text = "love",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold
s
formattedString.Spans.Add(new Span
{
Text = " Xamarin.Forms!"
b
Content = new Label
{
FormattedText = formattedString,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label))
b
}

As each span is created, it is directly passed to the Add method of the spans collection. Notice that
the Label is given a FontSize of NamedSize.Large, and the Span with the Bold setting is also ex-
plicitly given that same size. When a Span is given a FontAttributes setting, it does not inherit the
FontSize setting of the Label.

Alternatively, it's possible to initialize the contents of the Spans collection by following it with a pair
of curly braces. Within these curly braces, the span objects are instantiated. Because no method calls
are required, the entire FormattedString initialization can occur within the Label initialization:

public class VariableFormattedTextPage : ContentPage

{
public VariableFormattedTextPage()
{
Content = new Label
{
FormattedText = new FormattedString
{
Spans =
{
new Span
{

Text = "I "
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1,
new Span
{
Text = "Tove",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold
1,
new Span
{
Text = " Xamarin.Forms!"
}

3,

HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label))

This is the version of the program that you'll see in the collection of sample code for this chapter. Re-
gardless of which approach you use, here’s what it looks like:

» . .
ENTHEE | love Xamarin.Forms!

I love Xamarin.Forms!

You can also use the FormattedText property to embed italic or bold words within an entire para-
graph, as the VariableFormattedParagraph program demonstrates:

public class VariableFormattedParagraphPage : ContentPage

{
public VariableFormattedParagraphPage()

{
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Content = new Label

{
FormattedText = new FormattedString
{
Spans =
{
new Span
{
Text = "\u2003There was nothing so "
1,
new Span
{
Text = "very",
FontAttributes = FontAttributes.Italic
1,
new Span
{
Text = " remarkable in that; nor did Alice " +
"think it so "
1,
new Span
{
Text = "very",
FontAttributes = FontAttributes.Italic
1,
new Span
{
Text = " much out of the way to hear the " +
"Rabbit say to itself \u20180h " +
"dear! Oh dear! I shall be too late!" +
"\u2019 (when she thought it over " +
"afterwards, it occurred to her that " +
"she ought to have wondered at this, " +
"but at the time it all seemed quite " +
"natural); but, when the Rabbit actually "
1},
new Span
{
Text = "took a watch out of its waistcoat-pocket",
FontAttributes = FontAttributes.Italic
1,
new Span
{
Text = ", and looked at it, and then hurried on, " +
"Alice started to her feet, for it flashed " +
"across her mind that she had never before " +
"seen a rabbit with either a waistcoat-" +
"pocket, or a watch to take out of it, " +
"and, burning with curiosity, she ran " +
"across the field after it, and was just " +
"in time to see it pop down a large " +
"rabbit-hold under the hedge."
}
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1,
HorizontalOptions = LayoutOptions.Center,

VerticalOptions = LayoutOptions.Center

1

The paragraph begins with an em space (Unicode \u2003) and contains so-called smart quotes
(\u201C and \u201D), and several words are italicized:

3% a2

There was nothing so very remarkable in that;

or did Alice think it so very much out of the way|
to heer the Rabbit say to itself “Oh dearl Oh
kiear! | shall be too latel” (when she thought it
over afterwards, it occurred to her that she
ought to have wondered at this, but at the time it|
fall seemed quite natural); but, when the Rabbit
actually took a watch out of its waistcoat-pocket,

d looked at it, and then hurried on, Alice

started to her feet, for it flashed across her mind
hat she had never befre seen a rabbit with
gither a waistcoat-pocket, or a watch to take out
b it, and, burning with curiosity, she ran across
he fiald after it, and was just in time to see it

bop down a large rabbit-hald under the hedge.

There was nothing sa very remarkable in that;

or did Alice think it so very much out of the way
o hear the Rabbit say to itself "Oh dear! Oh dear! |
shall be too late!” (when she thought it over
afterwards, it occurred to her that she ought to

ave wondered at this, but at the time it all seemed|
quite natural); but, when the Rabbit actually took a

atch out of its waistcoat-pocket, and locked at it,
and then hurried on, Alice started to her feet, for it
lashed across her mind that she had never before

seen a rabbit with either a waistcoat-pocket, or a

atch to take out of it, and, burning with curiosity,
he ran across the field after it, and was just in time
o see it pop down a large rabbit-hold under the

edge.

You can persuade a single Label to display multiple lines or paragraphs with the insertion of end-
of-line characters. This is demonstrated in the NamedFontSizes program. Multiple span objects are
added to a FormattedString objectin a foreach loop. Each Span object uses a different
NamedFont value and also displays the actual size returned from Device.GetNamedSize:

public class NamedFontSizesPage : ContentPage
{
public NamedFontSizesPage()
{
FormattedString formattedString = new FormattedString(Q);
NamedSize[] namedSizes =
{
NamedSize.Default, NamedSize.Micro, NamedSize.Small,
NamedSize.Medium, NamedSize.lLarge

1

foreach (NamedSize namedSize in namedSizes)
{
double fontSize = Device.GetNamedSize(namedSize, typeof(Label));
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formattedString.Spans.Add(new Span

{
Text = String.Format("Named Size = {0} ({1:F2})",
namedSize, fontSize),
FontSize = fontSize
b;
if (namedSize != namedSizes.Last())
{
formattedString.Spans.Add(new Span
{
Text = Environment.NewLine + Environment.NewLine
b;
}
}
Content = new Label
{
FormattedText = formattedString,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
b

Notice that a separate span contains the two platform-specific end-of-line strings to space the individ-
ual lines. This ensures that the line spacing is based on the default font size rather than the font size
just displayed:

* % @02
1718 AM

Named Size = Default (15.00)

Named Size = Micro (15.67)

Named Size = Default (17.00)
Namad Siza = Micro (12,00} Named Size = Small (18.67)

Named Size = Small (14.00) Named Size = Medium (22.67)
Named Size = Medium (17.00)

Named Size = Large (22.00) SRS IEs ; Named Size = Large
(32.00)
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These are not pixel sizes! As with the height of the iOS status bar, it's best to refer to these sizes only
vaguely as some kind of “units.” Some additional clarity is coming in Chapter 5.

The Default size is generally chosen by the operating system, but the other sizes were chosen by
the Xamarin.Forms developers. On iOS, Default is the same as Medium, but on Android Default is
the same as sma11, and on Windows 10 Mobile, Default is smaller than Micro.

The sizes on the iPad and Windows 10 are the same as the iPhone and Windows 10 Mobile, respec-
tively. However, the sizes on the Windows 8.1 and Windows Phone 8.1 platforms show more of
discrepancy:

NamedFontSizes. Windows s - ] X

Named Size = Small (18.67) Named Siz

Named Size = Medium (22.67)
Named Size = Large (32.00)

Named Size = Large
(32.00)

Of course, the use of multiple Span objects in a single Label is not a good way to render multiple
paragraphs of text. Moreover, text often has so many paragraphs that it must be scrolled. This is the
job for the next chapter and its exploration of StackLayout and Scrollview.



Chapter 4
Scrolling the stack

If you're like most programmers, as soon as you saw that list of static Color properties in the previous
chapter, you wanted to write a program to display them all, perhaps using the Text property of Label
to identify the color, and the TextColor property to show the actual color.

Although you could do this with a single Label using a FormattedString object, it's much easier
with multiple Label objects. Because multiple Label objects are involved, this job also requires some
way to display all the Label objects on the screen.

The contentPage class defines a Content property of type view that you can set to an object—
but only one object. Displaying multiple views requires setting Content to an instance of a class that
can have multiple children of type view. Such a class is Layout<T>, which defines a Children prop-
erty of type IList<T>.

The Layout<T> class is abstract, but four classes derive from Layout<vView>, a class that can have
multiple children of type view. In alphabetical order, these four classes are:

[ Absolutelayout
° Grid
o Relativelayout

[ StackLayout

Each of them arranges its children in a characteristic manner. This chapter focuses on StackLayout.

Stacks of views

The stackLayout class arranges its children in a stack. It defines only two properties on its own:

e Orientation of type StackOrientation, an enumeration with two members: vertical (the
default) and Horizontal.

e Spacing of type double, initialized to 6.0.

StackLayout seems ideal for the job of listing colors. You can use the Add method defined by
IList<T> to add children to the children collection of a StackLayout instance. Here's some code
that creates multiple Label objects from two arrays and then adds each Label to the Children col-
lection of a stackLayout:

Color[] colors =
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{
Color.White, Color.Silver, Color.Gray, Color.Black, Color.Red,
Color.Maroon, Color.Yellow, Color.0Olive, Color.Lime, Color.Green,
Color.Aqua, Color.Teal, Color.Blue, Color.Navy, Color.Pink,
Color.Fuchsia, Color.Purple

};

string[] colorNames =

{
"White", "Silver", "Gray", "Black", "Red",
"Maroon", "Yellow", "Olive", "Lime", "Green",
"Aqua", "Teal", "Blue", "Navy", "Pink",
"Fuchsia", "Purple"

1

StacklLayout stackLayout = new StacklLayout();

for (int i = 0; i < colors.Length; i++)

{
Label 1abel = new Label
{
Text = colorNames[i],
TextColor = colors[i],
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label))
b
stackLayout.Children.Add(label);
}

The stackLayout object can then be set to the Content property of the page.
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But the technique of using parallel arrays is rather perilous. What if they're out of sync or have a dif-

ferent number of elements? A better approach is to keep the color and name together, perhaps in a

tiny structure with Color and Name fields, or as an array of Tuple<Color, string> values, or as an

anonymous type, as demonstrated in the ColorLoop program:

class ColorLoopPage : ContentPage

{
public ColorLoopPage()
{
var colors = new[]
{
new { value = Color.White, name = "White" },
new { value = Color.Silver, name = "Silver" },
new { value = Color.Gray, name = "Gray" },
new { value = Color.Black, name = "Black" },
new { value = Color.Red, name = "Red" },
new { value = Color.Maroon, name = "Maroon" 1},
new { value = Color.Yellow, name = "Yellow" },
new { value = Color.0live, name = "Olive" },
new { value = Color.Lime, name = "Lime" },
new { value = Color.Green, name = "Green" },
new { value = Color.Aqua, name = "Aqua" },
new { value = Color.Teal, name = "Teal" },
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new { value = Color.Blue, name = "Blue" },

new { value = Color.Navy, name = "Navy" },

new { value = Color.Pink, name = "Pink" },

new { value = Color.Fuchsia, name = "Fuchsia" },
new { value = Color.Purple, name = "Purple" }

};
StackLayout stackLayout = new StacklLayout();

foreach (var color in colors)

{
stackLayout.Children.Add(
new Label
{
Text = color.name,
TextColor = color.value,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label))
s
}

Padding = new Thickness(5, Device.OnPlatform(20, 5, 5), 5, 5);
Content = stackLayout;

Or you can initialize the Children property of StackLayout with an explicit collection of views
(similar to the way the Spans collection of a Formattedstring object was initialized in the previous
chapter). The ColorList program sets the Content property of the page to a SstackLayout object,
which then has its Children property initialized with 17 Label views:

class ColorListPage : ContentPage
{
public ColorListPage()
{
Padding = new Thickness (5, Device.OnPlatform (20, 5, 5), 5, 5);
double fontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label));
Content = new StacklLayout

{
Children =
{
new Label
{

Text = "White",
TextColor = Color.White,
FontSize = fontSize

1,

new Label

{
Text = "Silver",
TextColor = Color.Silver,
FontSize = fontSize

3,
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new Label

{
Text = "Fuchsia",
TextColor = Color.Fuchsia,
FontSize = fontSize

1,

new Label

{
Text = "Purple",
TextColor = Color.Purple,
FontSize = fontSize

}

}

You don't need to see the code for all 17 children to get the idea! Regardless of how you fill the
Children collection, here's the result:

1213 PM

Yellow

Obviously, this isn't optimum. Some colors aren't visible at all, and some of them are too faint to
read well. Moreover, the list overflows the page on two platforms, and there's no way to scroll it up.

One solution is to reduce the text size. Instead of using NamedSize.Large, try one of the smaller

values.

Another partial solution can be found in stackLayout itself: StackLayout defines a Spacing
property of type double that indicates how much space to leave between the children. By default, it's
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6.0, but you can set it to something smaller (for example, zero) to help ensure that all the items will fit:

Content = new StacklLayout

{
Spacing = 0,
Children =
{
new Label
{

Text = "White",
TextColor = Color.White,
FontSize = fontSize

3,

Now all the Label views occupy only as much vertical space as required for the text. You can even set
Spacing to negative values to make the items overlap!

But the best solution is scrolling. Scrolling is not automatically supported by stackLayout and
must be added with another element called scrollview, as you'll see in the next section.

But there's another issue with the color programs shown so far: they need to either explicitly create
an array of colors and names, or explicitly create Label views for each color. To programmers, this is
somewhat tedious, and hence somewhat distasteful. Might it be automated?

Scrolling content

Keep in mind that a Xamarin.Forms program has access to the .NET base class libraries and can use
.NET reflection to obtain information about all the classes and structures defined in an assembly, such
as Xamarin.Forms.Core. This suggests that obtaining the static fields and properties of the Color
structure can be automated.

Most .NET reflection begins with a Type object. You can obtain a Type object for any class or struc-
ture by using the C# typeof operator. For example, the expression typeof (Color) returns a Type
object for the color structure.

In the version of .NET available in the PCL, an extension method for the Type class, named
GetTypelInfo, returns a TypeInfo object from which additional information can be obtained. Alt-
hough that’s not required in the program shown below; it needs other extension methods defined for
the Type class, named GetRuntimeFields and GetRuntimeProperties. These return the fields
and properties of the type in the form of collections of FieldInfo and PropertyInfo objects. From
these, the names as well as the values of the properties can be obtained.

This is demonstrated by the ReflectedColors program. The ReflectedColorsPage.cs file requires a
using directive for System.Reflection.

In two separate foreach statements, the ReflectedColorsPage class loops through all the fields
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and properties of the Color structure. For all the public static members that return color values, the
two loops call createColorLabel to create a Label with the Color value and name, and then add
that Label to the StackLayout.

By including all the public static fields and properties, the program lists Color.Transparent,
Color.Default, and Color.Accent along with the 17 static fields displayed in the earlier program. A
separate CreateColorLabel method creates a Label view for each item. Here's the complete listing
of the ReflectedColorsPage class:

public class ReflectedColorsPage : ContentPage
{

public ReflectedColorsPage()

{

StacklLayout stackLayout = new StacklLayout();

// Loop through the Color structure fields.
foreach (FieldInfo info in typeof(Color).GetRuntimeFields())

{
// Skip the obsolete (i.e. misspelled) colors.
if (info.GetCustomAttribute<ObsoleteAttribute>() != null)
continue;
if (info.IsPublic &&
info.IsStatic &&
info.FieldType == typeof(Color))
{
stackLayout.Children.Add(
CreateColorLabel((Color)info.GetvValue(null), info.Name));
}
}

// Loop through the Color structure properties.
foreach (PropertyInfo info in typeof(Color).GetRuntimeProperties())

{
MethodInfo methodInfo = info.GetMethod;
if (methodInfo.IsPublic &&
methodInfo.IsStatic &&
methodInfo.ReturnType == typeof(Color))
{
stackLayout.Children.Add(
CreateColorLabel((Color)info.GetValue(null), info.Name));
}
}

Padding = new Thickness(5, Device.OnPlatform(20, 5, 5), 5, 5);

// Put the StackLayout in a ScrollView.
Content = new ScrollView
{
Content = stacklLayout
b
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Label CreateColorLabel(Color color, string name)

{

Color backgroundColor = Color.Default;

if (color != Color.Default)

{
// Standard Tuminance calculation.
double Tuminance = 0.30 * color.R +
0.59 * color.G +
0.11 * color.B;
backgroundColor = Tuminance > 0.5 ? Color.Black
}

// Create the Label.
return new Label
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: Color.White;

{
Text = name,
TextColor = color,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
BackgroundColor = backgroundColor
b

Toward the end of the constructor, the stackLayout is set to the Content property of a
ScrollvView, which is then set to the Content property of the page.

The CreateColorLabel method in the class attempts to make each color visible by setting a con-
trasting background. The method calculates a luminance value based on a standard weighted average
of the red, green, and blue components and then selects a background of either white or black.

This technique won't work for Transparent, so that item can't be displayed at all, and the method
treats Color.Default as a special case and displays that color (whatever it may be) against a
Color.Default background.

Here are the results, which are still quite short of being aesthetically satisfying:
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But you can scroll the display because the stackLayout is the child of a scrollview.

StackLayout and scrollview are related in the class hierarchy. stackLayout derives from Lay-
out<View>, and you'll recall that the Layout<T> class defines the children property that stack-
Layout inherits. The generic Layout<T> class derives from the nongeneric Layout class, and
ScrollvView also derives from this nongeneric Layout. Theoretically, Scrollview is a type of layout
object—even though it has only one child.

As you can see from the screenshot, the background color of the L.abel extends to the full width of
the stackLayout, which means that each Label is as wide as the StackLayout.

Let's experiment a bit to get a better understanding of Xamarin.Forms layout. For these experi-
ments, you might want to temporarily give the stackLayout and the Scrol1view distinct back-
ground colors:

public ReflectedColorsPage()

{
StackLayout stackLayout = new StacklLayout
{
BackgroundColor = Color.Blue
};
Content = new ScrollView
{
BackgroundColor = Color.Red,
Content = stacklLayout
1
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Layout objects usually have transparent backgrounds by default. Although they occupy an area on
the screen, they are not directly visible. Giving layout objects temporary colors is a great way to see ex-
actly where they are on the screen. It's a good debugging technique for complex layouts.

You will discover that the blue stackLayout peeks out in the space between the individual Label
views. This is a result of the default spacing property of StackLayout. The StackLayout is also visi-
ble through the Label for Color.Default, which has a transparent background.

Try setting the HorizontalOptions property of all the Label views to LayoutOptions.Start:

return new Label

{
Text = name,
TextColor = color,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
BackgroundColor = backgroundColor,
HorizontalOptions = LayoutOptions.Start
};

Now the blue background of the stackLayout is even more prominent because all the Label
views occupy only as much horizontal space as the text requires, and they are all pushed over to the
left side. Because each Label view is a different width, this display looks even uglier than the first
version!

Now remove the HorizontalOptions setting from the Label, and instead set a HorizontalOp-
tions on the StackLayout:

StackLayout stackLayout = new StacklLayout

{
BackgroundColor = Color.Blue,
HorizontalOptions = LayoutOptions.Start
1

Now the StackLayout becomes only as wide as the widest Label (at least on iOS and Android)
with the red background of the scrol1lview now clearly in view.

As you begin constructing a tree of visual objects, these objects acquire a parent-child relationship.
A parent object is sometimes referred to as the container of its child or children because the child's lo-
cation and size is contained within its parent.

By default, HorizontalOptions and VerticalOptions are set to LayoutOptions.Fill, which
means that each child view attempts to fill the parent container. (At least with the containers encoun-
tered so far. As you'll see, other layout classes have somewhat different behavior.) Even a Labe1 fills its
parent container by default, although without a background color, the Label appears to occupy only
as much space as it requires.

Setting a view's HorizontalOptions Or VerticalOptions property to LayoutOptions.Start,
Center, or End effectively forces the view to shrink down—either horizontally, vertically, or both—to
only the size the view requires.
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A stackLayout has this same effect on its child’s vertical size: every child in a StackLayout occu-
pies only as much height as it requires. Setting the verticalOptions property on a child of a stack-
Layout to Start, Center, or End has no effect! However, the child views still expand to fill the width
of the stackLayout, except when the children are given a HorizontalOptions property other than
LayoutOptions.Fill.

If a stackLayout is set to the Content property of a ContentPage, you can set HorizontalOp-
tions or VerticalOptions on the StackLayout. These properties have two effects: first, they shrink
the stackLayout width or height (or both) to the size of its children; and second, they govern where
the stackLayout is positioned relative to the page.

If a stackLayout isina ScrollView, the Scrollview causes the StackLayout to be only as tall
as the sum of the heights of its children. This is how the scrol1view can determine how to vertically
scroll the stackLayout. You can continue to set the HorizontalOptions property on the stack-
Layout to control the width and horizontal placement.

However, you should avoid setting verticalOptions on the Scrollview to LayoutOptions-
.Start, Center, or End. The Scrollview must be able to scroll its child content, and the only way
ScrollvView can do that is by forcing its child (usually a StackLayout) to assume a height that re-
flects only what the child needs and then to use the height of this child and its own height to calculate
how much to scroll that content. If you set VerticalOptions on the scrollview to LayoutOp-
tions.Start, Center, Or End, you are effectively telling the scrol1lview to be only as tall as it needs
to be. But what is that height? Because Scrollview can scroll its contents, it doesn’t need to be any
particular height, so in theory it will shrink down to nothing. Xamarin.Forms protects against this even-
tuality, but it's best for you to avoid code that suggests something you don’t want to happen.

Although putting a StackLayout in a Scrollview is normal, putting a Scrollview in a Stack-
Layout doesn't seem quite right. In theory, the stackLayout will force the Scrollview to have a
height of only what it requires, and that required height is basically zero. Again, Xamarin.Forms pro-
tects against this eventuality, but you should avoid such code.

There is a proper way to put a ScrollvView in a StackLayout that is in complete accordance with
Xamarin.Forms layout principles, and that will be demonstrated shortly.

The preceding discussion applies to vertically oriented StackLayout and Scrollview elements.
StackLayout has a property named Orientation that you can set to a member of the stackori-
entation enumeration—vertical (the default) or Horizontal. Similarly, Scrol1view also has an
Orientation property that you set to a member of the Scrollorientation enumeration. Try this:

public ReflectedColorsPage()

{
StackLayout stackLayout = new StacklLayout
{
Orientation = StackOrientation.Horizontal
};

Content = new ScrollView
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Orientation = ScrollOrientation.Horizontal,
Content = stacklLayout
b
}

Now the Label views are stacked horizontally, and the Scrol1vieuw fills the page vertically but allows
horizontal scrolling of the stackLayout, which vertically fills the scrollview:

&
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<
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It looks pretty weird with the default vertical layout options, but those could be fixed to make it look a
little better.

The Expands option

You probably noticed that the HorizontalOptions and VerticalOptions properties are plurals, as

if there's more than one option. These properties are generally set to a static field of the Layoutop-
tions structure—another plural.

The discussions so far have focused on the following static read-only LayoutOptions fields that
returned predefined values of LayoutOptions:

. LayoutOptions.Start
] LayoutOptions.Center

e LayoutOptions.End
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o LayoutOptions.Fill

The default—established by the view class—is LayoutOptions.Fill, which means that the view fills
its container.

As you've seen, a VerticalOptions setting on a Label doesn't make a difference when the Label
is a child of a vertical stackLayout. The stackLayout itself constrains the height of its children to
only the height they require, so the child has no freedom to move vertically within that slot.

Be prepared for this rule to be slightly amended!

The LayoutOptions structure has four additional static read-only fields not discussed yet:
. LayoutOptions.StartAndExpand

. LayoutOptions.CenterAndExpand

. LayoutOptions.EndAndExpand

. LayoutOptions.FillAndExpand

LayoutOptions also defines two instance properties, named Alignment and Expands. The four
instances of LayoutOptions returned by the static fields ending with AndExpand all have the Ex-
pands property set to true.

This Expands property is recognized only by stackLayout. It can be very useful for managing the
layout of the page, but it can be confusing on first encounter. Here are the requirements for Expands
to play a role in a vertical stackLayout:

e The contents of the stackLayout must have a total height that is less than the height of the
StackLayout itself. In other words, some extra unused vertical space must exist in the stack-
Layout.

e That first requirement implies that the vertical StackLayout cannot have its own vertical-
Options property set to Start, Center, or End because that would cause the stackLayout
to have a height equal to the aggregate height of its children, and it would have no extra space.

e At least one child of the stackLayout must have a VerticalOptions setting with the
Expands property set to true.

If these conditions are satisfied, the StackLayout allocates the extra vertical space equally among
all the children that have a verticalOptions setting with Expands equal to true. Each of these chil-
dren gets a larger slot in the StackLayout than normal. How the child occupies that slot depends on
the Alignment setting of the LayoutOptions value: Start, Center, End, or Fill.

Here's a program, named VerticalOptionsDemo, that uses reflection to create Label objects with
all the possible verticalOptions settings in a vertical StackLayout. The background and fore-
ground colors are alternated so that you can see exactly how much space each Label occupies. The
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program uses Language Integrated Query (LINQ) to sort the fields of the LayoutOptions structure in
a visually more illuminating manner:

public class VerticalOptionsDemoPage : ContentPage

{

public VerticalOptionsDemoPage()

{

Color[] colors = { Color.Yellow, Color.Blue };
int flipFlopper = 0;

// Create Labels sorted by LayoutAlignment property.
IEnumerable<Label> labels =
from field in typeof(LayoutOptions).GetRuntimeFields()
where field.IsPublic && field.IsStatic
orderby ((LayoutOptions)field.GetValue(null)).Alignment
select new Label

{
Text = "VerticalOptions = " + field.Name,
VerticalOptions = (LayoutOptions)field.GetValue(null),
HorizontalTextAlignment = TextAlignment.Center,
FontSize = Device.GetNamedSize(NamedSize.Medium, typeof(Label)),
TextColor = colors[flipFlopper],
BackgroundColor = colors[flipFlopper = 1 - flipFlopper]

b

// Transfer to StackLayout.
StacklLayout stackLayout = new StacklLayout();

foreach (Label Tabel in labels)
{

stackLayout.Children.Add(label);
}

Padding = new Thickness(0, Device.OnPlatform(20, 0, 0), 0, 0);
Content = stackLayout;

You might want to study the results a little:
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The Label views with yellow text on blue backgrounds are those with verticalOptions proper-
ties set to LayoutOptions values without the Expands flag set. If the Expands flag is not set on the
LayoutOptions value of an item in a vertical StackLayout, the VerticalOptions setting is
ignored. As you can see, the Label occupies only as much vertical space as it needs in the vertical
StackLayout.

The total height of the children in this stackLayout is less than the height of the stackLayout, so
the stackLayout has extra space. It contains four children with their verticaloptions properties
set to LayoutOptions values with the Expands flag set, so this extra space is allocated equally among
those four children.

In these four cases—the Label views with blue text on yellow backgrounds—the Alignment prop-
erty of the LayoutOptions value indicates how the child is aligned within the area that includes the
extra space. The first one—with the verticalOptions property set to LayoutOptions.StartAnd-
Expand—is above this extra space. The second (CenterAndExpand) is in the middle of the extra space.
The third (EndandExpand) is below the extra space. However, in all these three cases, the Label is get-
ting only as much vertical space as it needs, as indicated by the background color. The rest of the space
belongs to the stackLayout, which shows the background color of the page.

The last Label has its VerticalOptions property set to LayoutOptions.FillAndExpand. In this
case, the Label occupies the entire slot including the extra space, as the large area of yellow back-
ground indicates. The text is at the top of this area; that's because the default setting of vertical-
TextAlignment iS TextAlignment.Start. Set it to something else to position the text vertically
within the area.
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The Expands property of LayoutOptions plays a role only when the view is a child of a stack-
Layout. In other contexts, it's ignored.

Frame and BoxView

Two simple rectangular views are often useful for presentation purposes:

The BoxView is a filled rectangle. It derives from view and defines a Color property with a default
setting of Color.Default that's transparent by default.

The Frame displays a rectangular border surrounding some content. Frame derives from Layout by
way of ContentView, from which it inherits a Content property. The content of a Frame can be a sin-
gle view or a layout containing a bunch of views. From VisualElement, Frame inherits a Back-
groundColor property that's white on the iPhone but transparent on Android and Windows Phone.
From Layout, Frame inherits a Padding property that it initializes to 20 units on all sides to give the
content a little breathing room. Frame itself defines a HasShadow property that is t rue by default (but
the shadow shows up only on iOS devices) and an outlineColor property that is transparent by de-
fault but doesn’t affect the iOS shadow, which is always black and always visible when HasShadow is
set to true.

Both the Frame outline and the BoxView are transparent by default, so you might be a little uncer-
tain how to color them without resorting to different colors for different platforms. One good choice is
Color.Accent, which is guaranteed to show up regardless. Or, you can take control over coloring the
background as well as the Frame outline and Boxview.

If the BoxView or Frame is not constrained in size in any way—that is, if it's not in a StackLayout
and has its HorizontalOptions and VerticalOptions set to default values of LayoutOptions-
.Fill—these views expand to fill their containers.

For example, here's a program that has a centered Label set to the Content property of a Frame:

public class FramedTextPage : ContentPage
{
public FramedTextPage()
{
Padding = new Thickness(20);
Content = new Frame
{
OutlineColor = Color.Accent,
Content = new Label

{
Text = "I've been framed!",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
}
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}

The Label is centered in the Frame, but the Frame fills the whole page, and you might not even be
able to see the Frame clearly if the page had not been given a padding of 20 on all sides:

- 1011

Fue bean framed! I've been framed!
ve been framed:

|'ve been framed!

To display centered framed text, you want to set the HorizontalOptions and VerticalOptions
properties on the Frame (rather than the Label) to LayoutOptions.Center:

public class FramedTextPage : ContentPage

{
public FramedTextPage()
{
Padding = new Thickness(20);
Content = new Frame
{
OutlineColor = Color.Accent,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
Content = new Label
{
Text = "I've been framed!",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label))
}
1
}
}

Now the Frame hugs the text (but with the frame’s 20-unit default padding) in the center of the
page:



Chapter 4 Scrolling the stack 76
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een framed!

I've been framed!

I've been framed!

The version of FramedText included with the sample code for this chapter exercises the freedom to
give everything a custom color:

public class FramedTextPage : ContentPage
{

public FramedTextPage()

{

BackgroundColor = Color.Aqua;

Content = new Frame

{
OutlineColor = Color.Black,
BackgroundColor = Color.Yellow,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,

Content = new Label
{
Text = "I've been framed!",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Italic,
TextColor = Color.Blue

The result looks roughly the same on all three platforms:
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I've been framed!

've been framed!

I've been framed!

Try setting a BoxView to the Content property of a ContentPage, like so:

public class SizedBoxViewPage : ContentPage

{
public SizedBoxViewPage()
{
Content = new BoxView
{
Color = Color.Accent
b
}
}

Be sure to set the Color property so you can see it. The BoxView fills the whole area of its con-
tainer, just as Label does with its default HorizontalOptions or VerticalOptions settings:
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It's even underlying the iOS status bar!

Now try setting the HorizontalOptions and VerticalOptions properties of the Boxview to
something other than Fil11, as in this code sample:

public class SizedBoxViewPage : ContentPage

{
public SizedBoxViewPage()
{
Content = new BoxView
{
Color = Color.Accent,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
1
}
}

In this case, the Boxview will assume its default dimensions of 40 units square:
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- 1018

The BoxView is now 40 units square because the BoxVieuw initializes its WidthRequest and
HeightRequest properties to 40. These two properties require a little explanation:

VisualElement defines width and Height properties, but these properties are read-only.
VisualElement also defines widthRequest and HeightRequest properties that are both settable
and gettable. Normally, all these properties are initialized to —1 (which effectively means they are un-
defined), but some view derivatives, such as BoxView, set the WidthRequest and HeightRequest
properties to specific values.

After a page has organized the layout of its children and rendered all the visuals, the Wwidth and
Height properties indicate actual dimensions of each view—the area that the view occupies on the
screen. Because width and Height are read-only, they are for informational purposes only. (Chapter 5,
“Dealing with sizes,” describes how to work with these values.)

If you want a view to be a specific size, you can set the WwidthRequest and HeightRequest prop-
erties. But these properties indicate (as their names suggest) a requested size or a preferred size. If the
view is allowed to fill its container, these properties will be ignored.

BoxView sets its default size to values of 40 by overriding the onsizerRequest method. You can
think of these settings as a size that Boxview would like to be if nobody else has any opinions in the
matter. You've already seen that WidthRequest and HeightRequest are ignored when the BoxView
is allowed to fill the page. The widthRequest kicks in if the HorizontalOptions is set to LayoutOp-
tions.Left, Center, Or Right, or if the BoxView is a child of a horizontal StackLayout. The
HeightRequest behaves similarly.
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Here's the version of the SizedBoxView program included with the code for this chapter:

public class SizedBoxViewPage : ContentPage

{
public SizedBoxViewPage()
{
BackgroundColor = Color.Pink;
Content = new BoxView
{
Color = Color.Navy,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
WidthRequest = 200,
HeightRequest = 100
b
}
}

Let's use both Frame and BoxView in an enhanced color list. The ColorBlocks program has a page
constructor that is virtually identical to the one in ReflectedColors, except that it calls a method
named CreateColorView rather than CreateColorLabel. Here's that method:

class ColorBlocksPage : ContentPage

{

View CreateColorView(Color color, string name)

{
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return new Frame

{
OutlineColor = Color.Accent,
Padding = new Thickness(5),
Content = new StacklLayout
{
Orientation = StackOrientation.Horizontal,
Spacing = 15,
Children =
{
new BoxView
{
Color = color
1,
new Label
{
Text = name,
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold,
VerticalOptions = LayoutOptions.Center,
HorizontalOptions = LayoutOptions.StartAndExpand
1,
new StacklLayout
{
Children =
{
new Label
{

Text = String.Format("{0:X2}-{1:X2}-{2:X2}",
(int) (255 * color.R),
(int) (255 * color.Q),
(int) (255 * color.B)),

VerticalOptions = LayoutOptions.CenterAndExpand,

IsVisible = color != Color.Default

1,
new Label
{

Text = String.Format("{0:F2}, {1:F2}, {2:F2}",
color.Hue,
color.Saturation,
color.Luminosity),

VerticalOptions = LayoutOptions.CenterAndExpand,

IsVisible = color != Color.Default

}
3,
HorizontalOptions = LayoutOptions.End
}
}
}
b

81
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The CreateColorvView method returns a Frame containing a horizontal StackLayout with a Box-
View indicating the color, a Label for the name of the color, and another StackLayout with two
more Label views for the RGB composition and the Hue, Saturation, and Luminosity values. The
RGB and HSL displays are meaningless for the Color.Default value, so that inner StackLayout has
its Isvisible property set to false in that case. The StackLayout still exists, but it's ignored when
the page is rendered.

The program doesn’'t know which element will determine the height of each color item—the Box-
View, the Label with the color name, or the two Label views with the RGB and HSL values—so it cen-
ters all the Label views. As you can see, the Boxview expands in height to accommodate the height of
the text:
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Now this is a scrollable color list that's beginning to be something we can take a little pride in.

A ScrollView in a StackLayout?

It's common to put a StackLayout in a ScrollView, but can you put a Scrollview in a StackLay-
out? And why would you even want to?

It's a general rule in layout systems like the one in Xamarin.Forms that you can't put a scroll in a
stack. A scrol1view needs to have a specific height to compute the difference between the height of
its content and its own height. That difference is the amount that the scro11view can scroll its con-
tents. If the scrollview isin a StackLayout, it doesn't get that specific height. The stackLayout
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wants the scrollview to be as short as possible, and that's either the height of the Scrol1view con-
tents or zero, and neither solution works.

So why would you want a Scrollview in a StackLayout anyway?

Sometimes it's precisely what you need. Consider a primitive e-book reader that implements scroll-
ing. You might want a Label at the top of the page always displaying the book's title, followed by a
ScrollView containing a StackLayout with the content of the book itself. It would be convenient for
that Label and the scrollview to be children of a stackLayout that fills the page.

With Xamarin.Forms, such a thing is possible. If you give the Scrollview a VerticalOptions set-
ting of LayoutOptions.FillAndExpand, it can indeed be a child of a stackLayout. The stackLay-
out will give the Scrol1view all the extra space not required by the other children, and the
Scrollview will then have a specific height. Interestingly, Xamarin.Forms protects against other set-
tings of that verticalOptions property, so it works with whatever you set it to.

The BlackCat project displays the text of Edgar Allan Poe’s short story “The Black Cat,” which is
stored in a text file named TheBlackCat.txt in a one-line-per-paragraph format.

How does the BlackCat program access the file with this short story? Perhaps the easiest approach
is to embed the text file right in the program executable or—in the case of a Xamarin.Forms applica-
tion—right in the Portable Class Library DLL. These files are known as embedded resources, and that's
what TheBlackCat.txt file is in this program.

To make an embedded resource in either Visual Studio or Xamarin Studio, you'll probably first want
to create a folder in the project by selecting the Add > New Folder option from the project menu. A
folder for text files might be called Texts, for example. The folder is optional, but it helps organize pro-
gram assets. Then, in that folder, you can select Add > Existing Item in Visual Studio or Add > Add
Files in Xamarin Studio. Navigate to the file, select it, and click Add in Visual Studio or Open in
Xamarin Studio.

Now here’s the important part: Once the file is part of the project, bring up the Properties dialog
from the menu associated with the file. Specify that the Build Action for the file is Embedded-
Resource. This is an easy step to forget, but it is essential.

This was done for the BlackCat project, and consequently the TheBlackCat.txt file becomes embed-
ded in the BlackCat.dll file.

In code, the file can be retrieved by calling the GetManifestResourceStream method defined by
the Assembly class in the System.Reflection namespace. To get the assembly of the PCL, all you
need to do is get the Type of any class defined in the assembly. You can use typeof with the page
type you've derived from ContentPage or GetType on the instance of that class. Then call GetType-
Info on this Type object. Assembly is a property of the resultant TypeInfo object:

Assembly assembly = GetType() .GetTypeInfo().Assembly;

In the GetManifestResourceStream method of Assembly, you'll need to specify the name of the
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resource. For embedded resources, that name is not the filename of the resource but the resource ID.
It's easy to confuse these because that ID might look vaguely like a fully qualified filename.

The resource ID begins with the default namespace of the assembly. This is not the .NET namespace!
To get the default namespace of the assembly in Visual Studio, select Properties from the project
menu, and in the properties dialog, select Library at the left and look for the Default namespace
field. In Xamarin Studio, select Options from the project menu, and in the Project Options dialog, se-
lect Main Settings at the left, and look for a field labeled Default Namespace.

For the BlackCat project, that default namespace is the same as the assembly: “BlackCat". However,
you can actually set that default namespace to whatever you want.

The resource ID begins with that default namespace, followed by a period, followed by the folder
name you might have used, followed by another period and the filename. For this example, the re-
source ID is “BlackCat.Texts.TheBlackCat.txt"—and that's what you'll pass to the GetManifestRe-
sourceStream method in the code. The method returns a .NET Stream object, and from that a
StreamReader can be created to read the lines of text.

It's a good idea to use using statements with the Stream object returned from GetManifestRe-
sourceStream and the StreamReader object because that will properly dispose of the objects when
they're no longer needed or if they raise exceptions.

For layout purposes, the BlackCatPage constructor creates two StackLayout objects: mainStack
and textStack. The first line from the file (containing the story’s title and author) becomes a bolded
and centered Label in mainStack; all the subsequent lines go in textStack. The mainStack in-
stance also contains a Scrollview with textStack.

class BlackCatPage : ContentPage
{
public BlackCatPage()
{
StacklLayout mainStack = new StacklLayout();
StackLayout textStack = new StacklLayout
{
Padding = new Thickness(5),
Spacing = 10

};

// Get access to the text resource.
Assembly assembly = GetType().GetTypeInfo().Assembly;
string resource = "BlackCat.Texts.TheBlackCat.txt";

using (Stream stream = assembly.GetManifestResourceStream (resource))

{

using (StreamReader reader = new StreamReader (stream))

{
bool gotTitle = false;
string Tline;

// Read in a 1line (which is actually a paragraph).
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while (null != (line = reader.ReadlLine()))

{

Label Tabel = new Label

{
Text = line,
// Black text for ebooks!
TextColor = Color.Black

};

if ('gotTitle)

{
// Add first label (the title) to mainStack.
Tlabel.HorizontalOptions = LayoutOptions.Center;
label.FontSize = Device.GetNamedSize(NamedSize.Medium, label);
Tlabel.FontAttributes = FontAttributes.Bold;
mainStack.Children.Add(1abel);
gotTitle = true;

}

else

{
// Add subsequent Tabels to textStack.
textStack.Children.Add(1abel);

}

}

// Put the textStack in a ScrollView with FiTlAndExpand.
Scrol1View scrollView = new ScrollView

{
Content = textStack,
VerticalOptions = LayoutOptions.FilTAndExpand,
Padding = new Thickness(5, 0),

b

// Add the ScrollView as a second child of mainStack.
mainStack.Children.Add(scrol1View);

// Set page content to mainStack.
Content = mainStack;

// White background for ebooks!
BackgroundColor = Color.White;

// Add some i0S padding for the page.
Padding = new Thickness (0, Device.OnPlatform (20, 0, 0), 0, 0);

Because this is basically an e-book reader, and humans have been reading black text on white paper
for hundreds of years, the BackgroundColor of the page is set to white and the TextColor of each
Label is set to black:
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THE BLACK CAT by Edgar Allan Poe

FOR the most wild, yet most homely namative
which | am about to pen, | neither expect nor
solicit belief. Mad indeed would | be to expect
it, in & case where my very senses reject their
own evidence. Yet, mad am | not--and very
surely do | not dream. But to-morrow | die,
and to-day | would unburthen my soul. My
immediate purpose is to place befare the
world, plainly, succinctly, and without
comment, a series of mere household avents.
In their consequences, these events have
terrified--have tortured--have destroyed me.
Yet | will not attempt to expound them. To me,
they have presented little but Horror--to many
they will seem less terrible than _barrogues_.
Hereafter, perhaps, some intellect may be
found which will reduce my phantasm to the
common-place--some intallect more calm,
more logical, and far less excitable than my
own, which will perceive, in the circumstances
| detail with awe, F\O\hing more than an
ordinary succession of very natural causes

abrute,
has had frequent occasion o test the palry friendship
and gossamer fidelity of mere _Man_

| married early, and was happy to find in my wife a
disposition not uncongenial with my own. Observing
my partiality for domestic pets. she last no opportunity
of procuring those of the most agreeable kind. We had
birds, gold-fish, a fine dog, rabbits, & small monkey, and
_acat

This latter was a remarkably large and beautiful
animal, entirely black, and sagacious 1o an astonishing
degree. In speaking of his intelligence, my wife, who at
heart was not a little tinctured with superstition, made
frequent allusion to the ancient popular notion, which
regarded all black cats as witches in disguise. Not that
she was ever _serlous_upon this paint-and | mentian
the matter at all for no better reason than that it
happens, just now, ta be remembered

Pluto-this was the cat's name-was my favorite pet
and playmate. | alone fed him, and he attended me
wherever | went about the house. It was even with
difficulty that | could prevent him from following me
through the streets,
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from her grasp and buried the axe in her brain.
She fell dead upon the spot, without a groan.

This hideous murder accomplished, | set myself
forthwith, and with entire deliberation, to the
task of concealing the body. | knew that | could
not remove it from the house, either by day or
by night, without the risk of being observed by
the neighbors. Many projects entered my mind.
At one period | thought of cutting the corpse
into minute fragments, and destroying them by
fire, At another, | resolved to dig a grave for it in
the floor of the cellar. Again, | deliberated about
casting it in the well in the yard--about packing
itin a box, as if merchandize, with the usual
arrangements, and so getting a porter to take it
from the hause. Finally | hit upon what |
considered a far better expedient than either of

86

and effects.

From my infancy | was noted for the docility
and humanity of my dispasition. My
tenderness cf heart was even so conspicuous
as to make me the jest of my companions. |
was espacially fond of animals, and was
indulged by my parents with a great variety of
pets With these | spent mo o

these. | determined to wall it up in the cellar--as
Our friendship lasted, in this manner, for several years, the monks of the middle ages are recorded 1o
during which my general temperament and character— have wall heir victim:
through the instrumentality of the Fiend ave walled up their victims.
Intemperance-had (1 blush to confess it) experienced Fora purpose such as this the cellar was well
aradical alteration for the worse. | grew. day by day, adapted. its walls were loosely constructed, and
more moady, mare irritable, more regardiess of the P ¥ 3

had lately been plastered throughout with a

BlackCat is a PCL application. It is also possible to write this program using a Shared Asset Project
rather than a PCL. To prove it, a BlackCatSap project is included with the code for this chapter. How-
ever, because the resource actually becomes part of the application project, you'll need the default
namespace for the application, and that's different for each platform. The code to set the resource vari-

able looks like this:

#if _TI0S__

string resource =

#e1if _ANDROID__

string resource =

#e1if WINDOWS_UWP

string resource =

#e1if WINDOWS_APP

string resource =

#e1if WINDOWS_PHONE_APP

string resource =

#endif

"BlackCatSap.i0S.Texts.TheBlackCat.txt";
"BlackCatSap.Droid.Texts.TheBTackCat.txt";
"BlackCatSap.UWP.Texts.TheBlackCat.txt";
"BlackCatSap.Windows.Texts.TheBlackCat.txt";

"BlackCatSap.WinPhone.Texts.TheBlackCat.txt";

If you're having problems referencing an embedded resource, you might be using an incorrect

name. Try calling GetManifestResourceNames on the Assembly object to get a list of the resource

IDs of all embedded resources.



Chapter 5
Dealing with sizes

Already you've seen some references to sizes in connection with various visual elements:

e The iOS status bar has a height of 20, which you can adjust for with a Padding setting on the
page.

e The BoxView sets its default width and height to 40.
e  The default Padding within a Frame is 20.
e The default spacing property on the stackLayout is 6.

And then there’s Device.GetNamedSize, which for various members of the Namedsize enumeration
returns a platform-dependent number appropriate for Fontsize values for a Label or Button.

What are these numbers? What are their units? And how do we intelligently set properties requiring
sizes to other values?

Good questions. As you've seen, the various platforms have different screen sizes and different text
sizes, and all display a different quantity of text on the screen. Is that quantity of text something that a
Xamarin.Forms application can anticipate or control? And even if it's possible, is it a proper program-
ming practice? Should an application adjust font sizes to achieve a desired text density on the screen?

In general, when programming a Xamarin.Forms application, it's best not to get too close to the ac-
tual numeric dimensions of visual objects. It's preferable to trust Xamarin.Forms and the individual
platforms to make the best default choices.

However, there are times when a programmer needs to know something about the size of particular
visual objects and the size of the screen on which they appear.

Pixels, points, dps, DIPs, and DIUs

Video displays consist of a rectangular array of pixels. Any object displayed on the screen also has a
pixel size. In the early days of personal computers, programmers sized and positioned visual objects in
units of pixels. But as a greater variety of screen sizes and pixel densities became available, working
with pixels became undesirable for programmers attempting to write applications that look roughly
the same on many devices. Another solution was required.

These solutions began with operating systems for desktop computers and were then adapted for
mobile devices. For this reason, it's illuminating to begin this exploration with the desktop.
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Desktop video displays have a wide range of pixel dimensions, from the nearly obsolete 640 x 480
on up into the thousands. The aspect ratio of 4:3 was once standard for computer displays—and for
movies and television as well—but the high-definition aspect ratio of 16:9 (or the similar 16:10) is now
more common.

Desktop video displays also have a physical dimension usually measured along the diagonal of the
screen in inches or centimeters. The pixel dimension combined with the physical dimension allows you
to calculate the video display’s resolution or pixel density in dots per inch (DPI), sometimes also re-
ferred to as pixels per inch (PPI). The display resolution can also be measured as a dot pitch, which is
the distance between adjacent pixel centers, usually measured in millimeters.

For example, you can use the Pythagorean theorem to calculate that an ancient 800 x 600 display
has a diagonal length of 1,000, the square root of 800 squared plus 600 squared. If this monitor has a
13-inch diagonal, that's a pixel density of 77 DPI, or a dot pitch of 0.33 millimeters. However, a 13-inch
screen on a modern laptop might have pixel dimensions of 2560 x 1600, which is a pixel density of
about 230 DPI, or a dot pitch of about 0.11 millimeters. A 100-pixel square object on this screen is one-
third the size of the same object on the older screen.

Programmers should have a fighting chance when attempting to size visual elements correctly. For
this reason, both Apple and Microsoft devised systems for desktop computing that allow programmers
to work with the video display in some form of device-independent units instead of pixels. Most of the
dimensions that a programmer encounters and specifies are in these device-independent units. It is the
responsibility of the operating system to convert back and forth between these units and pixels.

In the Apple world, desktop video displays were traditionally assumed to have a resolution of 72
units to the inch. This number comes from typography, where many measurements are in units of
points. In classical typography, there are approximately 72 points to the inch, but in digital typography
the point has been standardized to be exactly one seventy-second of an inch. By working with points
rather than pixels, a programmer has an intuitive sense of the relationship between numeric sizes and
the area that visual objects occupy on the screen.

In the Windows world, a similar technique was developed, called device-independent pixels (DIPs) or
device-independent units (DIUs). To a Windows programmer, desktop video displays are assumed to
have a resolution of 96 DIUs, which is exactly one-third higher than 72 DPI, although it can be adjusted
by the user.

Mobile devices, however, have somewhat different rules: The pixel densities achieved on modern
phones are typically much higher than on desktop displays. This higher pixel density allows text and
other visual objects to shrink much more in size before becoming illegible.

Phones are also typically held much closer to the user’s face than is a desktop or laptop screen. This
difference also implies that visual objects on the phone can be smaller than comparable objects on
desktop or laptop screens. Because the physical dimensions of the phone are much smaller than desk-
top displays, shrinking down visual objects is very desirable because it allows much more to fit on the
screen.
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Apple continues to refer to the device-independent units on the iPhone as points. Until recently, all
of Apple’s high-density displays—which Apple refers to by the brand name Retina—have a conversion
of two pixels to the point. This was true for the MacBook Pro, iPad, and iPhone. The recent exception is
the iPhone 6 Plus, which has three pixels to the point.

For example, the 640 x 960 pixel dimension of the 3.5-inch screen of the iPhone 4 has an actual
pixel density of about 320 DPI. There are two pixels to the point, so to an application program running
on the iPhone 4, the screen appears to have a dimension of 320 x 480 points. The iPhone 3 actually
did have a pixel dimension of 320 x 480, and points equaled pixels, so to a program running on these
two devices, the displays of the iPhone 3 and iPhone 4 appear to be the same size. Despite the same
perceived sizes, graphical objects and text are displayed in greater resolution on the iPhone 4 than the
iPhone 3.

For the iPhone 3 and iPhone 4, the relationship between the screen size and point dimensions im-
plies a conversion factor of 160 points to the inch rather than the desktop standard of 72.

The iPhone 5 has a 4-inch screen, but the pixel dimension is 640 x 1136. The pixel density is about
the same as the iPhone 4. To a program, this screen has a size of 320 x 768 points.

The iPhone 6 has a 4.7-inch screen and a pixel dimension of 750 x 1334. The pixel density is also
about 320 DPI. There are two pixels to the point, so to a program, the screen appears to have a point
size of 375 x 667.

However, the iPhone 6 Plus has a 5.5-inch screen and a pixel dimension of 1080 x 1920, which is a
pixel density of 400 DPI. This higher pixel density implies more pixels to the point, and for the iPhone 6
Plus, Apple has set the point equal to three pixels. That would normally imply a perceived screen size of
360 x 640 points, but to a program, the iPhone 6 Plus screen has a point size of 414 x 736, so the per-
ceived resolution is about 150 points to the inch.

This information is summarized in the following table:

Model iPhone 2,3 | iPhone 4 iPhone 5 iPhone 6 iPhone 6 Plus*
Pixel size 320 x 480 640 x 960 | 640 x 1136 | 750 x 1334 | 1080 x 1920
Screen diagonal | 3.5 in. 3.5in. 4in. 47 in. 5.5in.

Pixel density 165 DPI 330 DPI 326 DPI 326 DPI 401 DPI
Pixels per point | 1 2 2 2 3

Point size 320 x 480 320 x 480 | 320 x 568 375 x 667 414 x 736
Points per inch 165 165 163 163 154

* Includes 115 percent downsampling.

Android does something quite similar: Android devices have a wide variety of sizes and pixel dimen-
sions, but an Android programmer generally works in units of density-independent pixels (dps). The
relationship between pixels and dps is set assuming 160 dps to the inch, which means that Apple and
Android device-independent units are very similar.

Microsoft took a different approach with Windows Phone 7. The original Windows Phone 7 devices
had a screen dimension of 480 x 800 pixels, which is often referred to as WVGA (Wide Video Graphics
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Array). Applications worked with this display in units of pixels. If you assume an average screen size of 4
inches for a 480 x 800 Windows Phone 7 device, this means that Windows Phone 7 implicitly assumed
a pixel density of about 240 DPI. That's 1.5 times the assumed pixel density of iPhone and Android de-
vices. Eventually, several larger screen sizes were allowed: 768 x 1280 (WXGA or Wide Extended
Graphics Array), 720 x 1280 (referred to using high-definition television lingo as 720p), and 1080 x
1920 (called 1080p). For these additional display sizes, programmers worked in device-independent
units. An internal scaling factor translated between pixels and device-independent units so that the
width of the screen in portrait mode always appeared to be 480 pixels.

With the Windows Runtime APl in Windows Phone 8.1, different scaling factors were introduced
based on both the screen’s pixel size and the physical size of the screen. The following table was put
together based on the Windows Phone 8.1 emulators using a program named WhatSize, which you'll
see shortly:

Screen type WVGA 4" WXGA 4.5" 720p 4.7" 1080p 5.5" 1080p 6"
Pixel size 480 x 800 768 x 1280 720 x 1280 1080 x 1920 1080 x 1920
Size in DIUs 400 x 640 384 x 614.5 400 x 684 450 x 772 491 x 847
Scaling factor 12 2 18 24 22

DPI 194 161 169 167 167

The scaling factors were calculated from the width because the height in DIUs displayed by the What-
Size program excludes the Windows Phone status bar. The final DPI figures were calculated based on
the full pixel size, the diagonal size of the screen in inches, and the scaling factor.

Aside from the WVGA outlier, the calculated DPI is close enough to the 160 DPI criterion associated
with iOS and Android devices.

Windows 10 Mobile uses somewhat higher scaling factors, and in multiples of 0.25 rather than 0.2.
The following table was put together based on the Windows 10 Mobile emulators:

Screen type WVGA 4" QHD 5.2" WXGA 4.5" 720p 5" 1080p 6"
Pixel size 480 x 800 540 x 960 768 x 1280 720 x 1280 1080 x 1920
Size in DIUs 320 x 512 360 x 616 341 x 546 360 x 616 432 x 744
Scaling factor 15 15 2.25 2 25

DPI 155 141 147 147 141

You might conclude from this that a good average DPI for Windows 10 Mobile is 144 (rounded to the
nearest multiple of 16) rather than 160. Or you might say that it's close enough to 160 to assume that
it's consistent with iOS and Windows Phone.

Xamarin.Forms has a philosophy of using the conventions of the underlying platforms as much as
possible. In accordance with this philosophy, a Xamarin.Forms programmer works with sizes defined by
each particular platform. All sizes that the programmer encounters through the Xamarin.Forms API are
in these platform-specific, device-independent units.

Xamarin.Forms programmers can generally treat the phone display in a device-independent man-
ner, with the following resolution:
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e 160 units to the inch
e 64 units to the centimeter

The visualElement class defines two properties, named width and Height, that provide the
rendered dimensions of views, layouts, and pages in these device-independent units. However, the ini-
tial settings of width and Height are “mock” values of —1. The values of these properties become valid
only when the layout system has positioned and sized everything on the page. Also, keep in mind that
the default Fi11 setting for HorizontalOptions or VerticalOptions often causes a view to
occupy more space than it would otherwise. The width and Height values reflect this extra space.

The width and Height values also include any Padding that may be set on the element and are con-
sistent with the area colored by the view's BackgroundColor property.

VisualElement defines an event named SizeChanged that is fired whenever the width or
Height property of the visual element changes. This event is part of several notifications that occur
when a page is laid out, a process that involves the various elements of the page being sized and posi-
tioned. This layout process occurs following the first definition of a page (generally in the page con-
structor), and a new layout pass takes place in response to any change that might affect layout—for
example, when views are added to a ContentPage or a StackLayout, removed from these objects, or
when properties are set on visual elements that might result in their sizes changing.

A new layout is also triggered when the screen size changes. This happens mostly when the phone
is swiveled between portrait and landscape modes.

A full familiarity with the Xamarin.Forms layout system often accompanies the job of writing your
own Layout<View> derivatives. This task awaits us in Chapter 26, “Custom layouts.” Until then, simply
knowing when wWidth and Height properties change is helpful for working with sizes of visual objects.
You can attach a SizeChanged handler to any visual object on the page, including the page itself. The
WhatSize program demonstrates how to obtain the page’s size and display it:

public class WhatSizePage : ContentPage

{
Label Tabel;

public WhatSizePage()
{

Tabel = new Label

{
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center

};

Content = label;

SizeChanged += OnPageSizeChanged;
}

void OnPageSizeChanged(object sender, EventArgs args)
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Tlabel.Text = String.Format("{0} \uO0D7 {1}", Width, Height);
}

This is the first example of event handling in this book, and you can see that events are handled in the
normal C# and .NET manner. The code at the end of the constructor attaches the onPageSize-
Changed event handler to the sizeChanged event of the page. The first argument to the event han-
dler (customarily named sender) is the object firing the event, in this case the instance of whatsize-
Page, but the event handler doesn't use that. Nor does the event handler use the second argument—
the so-called event arguments—which sometimes provides more information about the event.

Instead, the event handler accesses the Label element (conveniently saved as a field) to display the
Width and Height properties of the page. The Unicode character in the String.Format call is a
times (x) symbol.

The sizeChanged event is not the only opportunity to obtain an element’s size. VisualElement
also defines a protected virtual method named OnSizeaAllocated that indicates when the visual ele-
ment is assigned a size. You can override this method in your ContentPage derivative rather than
handling the sizeChanged event, but OnsizeAllocated is sometimes called when the size isn't actu-
ally changing.

Here's the program running on the three standard platforms:

neEs e % @ 1034
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360 x 567 341.333343505859 x

375 x 667

546.222249984741

For the record, these are the sources of the screens in these three images:

e The iPhone 6 simulator, with pixel dimensions of 750 x 1334.
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e An LG Nexus 5 with a screen size of 1080 x 1920 pixels.
e A Nokia Lumia 925 with a screen size of 768 x 1280 pixels.

Notice that the vertical size perceived by the program on the Android does not include the area oc-
cupied by the status bar or bottom buttons; the vertical size on the Windows 10 Mobile device does
not include the area occupied by the status bar.

By default, all three platforms respond to device orientation changes. If you turn the phones (or em-
ulators) 90 degrees counterclockwise, the phones display the following sizes:
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The screenshots for this book are designed only for portrait mode, so you'll need to turn this book
sideways to see what the program looks like in landscape. The 598-pixel width on the Android excludes
the area for the buttons; the 335-pixel height excludes the status bar, which always appears above the
page. On the Windows 10 Mobile device, the 728-pixel width excludes the area for the status bar,
which appears in the same place but with rotated icons to reflect the new orientation.

Here's the program running on the iPad Air 2 simulator with a pixel dimension of 2048 x 1536.



Chapter 5 Dealing with sizes 94

11:02 AM

1024 x 768

Obviously, the scaling factor is 2. The screen is 9.7 inches in diagonal for a resolution of 132 DPI.

The Surface Pro 3 has a pixel dimension of 2160 x 1440. The scaling factor is selectable by the user
to make everything on the screen larger or smaller, but the recommended scaling factor is 1.5:

1440 x 920

The height displayed by WhatSize excludes the taskbar at the bottom of the screen. The screen is 12"
in diagonal for a resolution of 144 DPI.
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A few notes on the WhatSize program itself:

WhatSize creates a single Label in its constructor and sets the Text property in the event handler.
That's not the only way to write such a program. The program could use the sizeChanged handler to
create a whole new Label with the new text and set that new Label as the content of the page, in
which case the previous Label would become unreferenced and hence eligible for garbage collection.
But creating new visual elements is unnecessary and wasteful in this program. It's best for the program
to create only one Label view and just set the Text property to indicate the page’s new size.

Monitoring size changes is the only way a Xamarin.Forms application can detect orientation
changes without obtaining platform-specific information. Is the width greater than the height? That's
landscape. Otherwise, it's portrait.

By default, the Visual Studio and Xamarin Studio templates for Xamarin.Forms solutions enable de-
vice orientation changes for all three platforms. If you want to disable orientation changes—for exam-
ple, if you have an application that just doesn’t work well in portrait or landscape mode—you can do
so.

For iOS, first display the contents of Info.plist in Visual Studio or Xamarin Studio. In the iPhone De-
ployment Info section, use the Supported Device Orientations area to specify which orientations are
allowed.

For Android, in the Activity attribute on the MainActivity class in the MainActivity.cs file, add:

ScreenOrientation = ScreenOrientation.Landscape

or
ScreenOrientation = ScreenOrientation.Portrait
The Activity attribute generated by the solution template contains a ConfigurationChanges ar-

gument that also refers to screen orientation, but the purpose of ConfigurationChanges is to inhibit
a restart of the activity when the phone’s orientation or screen size changes.

For the two Windows Phone projects, the class and enumeration to use is in the Windows-
.Graphics.Display namespace. In the MainPage constructor in the MainPage.xaml.cs file, set the
static DisplayInformation.AutoRotationPreferences property to one or more members of the
DisplayOrientations enumeration combined with the C# bitwise OR operation. To restrict the pro-
gram to landscape or portrait, use:

DisplayInformation.AutoRotationPreferences = DisplayOrientations.Landscape

or:

DisplayInformation.AutoRotationPreferences = DisplayOrientations.Portrait;
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Metrical sizes

Now that you know how sizes in a Xamarin.Forms application approximately correspond to metrical
dimensions of inches and centimeters, you can size elements so that they are approximately the same
size on various devices. Here's a program called MetricalBoxView that displays a Boxview with a
width of approximately one centimeter and a height of approximately one inch:

public class MetricalBoxViewPage : ContentPage

{
public MetricalBoxViewPage()
{
Content = new BoxView
{
Color = Color.Accent,
WidthRequest = 64,
HeightRequest = 160,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
b
}
}

If you actually take a ruler to the object on your phone's screen, you'll find that it's not exactly the
desired size but certainly close to it, as these screenshots also confirm:

12:21PM

This program is intended to run on phones. If you want to run it on tablets as well, you might use
the Device.Idiom property to set a somewhat smaller factor for the iPad and Windows tablets.
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Estimated font sizes

The FontSize property on Label and Button specifies the approximate height of font characters
from the bottom of descenders to the top of ascenders, often (depending on the font) including dia-
critical marks as well. In most cases you'll want to set this property to a value returned by the De-
vice.GetNamedSize method. This allows you to specify a member of the Namedsize enumeration:
Default, Micro, Small, Medium, Or Large.

Alternatively, you can set the FontSize property to actual numeric font sizes, but there’s a little
problem involved (to be discussed in detail shortly). For the most part, you specify font sizes in the
same device-independent units used throughout Xamarin.Forms, which means that you can calculate
device-independent font sizes based on the platform resolution.

For example, suppose you want to use a 12-point font in your program. The first thing you should
know is that while a 12-point font might be a comfortable size for printed material or a desktop screen,
on a phone it's quite large. But let's continue.

There are 72 points to the inch, so a 12-point font is one-sixth of an inch. Multiply by the DPI reso-
lution of 160 and that's about 27 device-independent units.

Let's write a little program called FontSizes, which begins with a display similar to the NamedFont-
Sizes program in Chapter 3 but then displays some text with numeric point sizes, converted to device-
independent units using the device resolution:

public class FontSizesPage : ContentPage
{
public FontSizesPage()
{
BackgroundColor = Color.White;
StacklLayout stackLayout = new StacklLayout
{
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center

1

// Do the NamedSize values.

NamedSize[] namedSizes =

{
NamedSize.Default, NamedSize.Micro, NamedSize.Small,
NamedSize.Medium, NamedSize.lLarge

};

foreach (NamedSize namedSize in namedSizes)
{

double fontSize = Device.GetNamedSize(namedSize, typeof(Label));

stackLayout.Children.Add(new Label
{
Text = String.Format("Named Size = {0} ({1:F2})",
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namedSize, fontSize),
FontSize = fontSize,
TextColor = Color.Black
b

// Resolution in device-independent units per 1inch.
double resolution = 160;

// Draw horizontal separator line.
stackLayout.Children.Add(
new BoxView
{
Color = Color.Accent,
HeightRequest = resolution / 80
b

// Do some numeric point sizes.
int[] ptSizes = { 4, 6, 8, 10, 12 };

foreach (double ptSize in ptSizes)

{
double fontSize = resolution * ptSize / 72;
stackLayout.Children.Add(new Label
{
Text = String.Format("Point Size = {0} ({1:F2})",
ptSize, fontSize),
FontSize = fontSize,
TextColor = Color.Black
b;
}

Content = stacklLayout;

To facilitate comparisons among the three screens, the backgrounds have been uniformly set to
white and the labels to black. Notice the BoxView inserted into the StackLayout between the two
foreach blocks: the HeightRequest setting gives it a device-independent height of approximately
one-eightieth of an inch, and it resembles a horizontal rule.

Interestingly, the resultant visual sizes based on the calculation are more consistent among the plat-
forms than the named sizes. The numbers in parentheses are the numeric FontSize values in device-
independent units:
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Named Size = Default (17.00)
Named Siza = Micra (12.08)

Named Size = Small (14.00)
Named Size = Medium (17.00)

Named Size = Large (22.00)

P s o 17333
Point Size = 8 (17.76)
Point Size = 10 (22.22)

Point Size = 12 (26.67)

* %% @ n:2s

Named Size = Default (14.00)
Narmed Size - Micto (100}
Named Size = Small (14.00)

Named Size = Medium (18.00)
Named Size = Large (22.00)

i ine =4 (8.89)

Point Size = 6 (13.33)
Point Size = 8 (17.78)
Point Size = 10 (22.22)

Point Size =12 (26.67)

Named Size = Default (15.00)
Named Size = Micro (15.67)
Named Size = Small (18.67)

Named Size = Medium (22.67)

Named Size = Large
(32.00)

e
Point Size = 6 (13.33)

Point Size = 8 (17.78)
Point Size = 10 (22.22)
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Point Size = 12 (26.67)

Fitting text to available size

You might need to fit a block of text to a particular rectangular area. It's possible to calculate a value
for the Fontsize property of Label based on the number of text characters, the size of the rectangu-
lar area, and just two numbers.

The first number is line spacing. This is the vertical height of a Label view per line of text. For the
default fonts associated with the three platforms, it is roughly related to the Fontsize property as
follows:

e {OS:lineSpacing = 1.2 * label.FontSize
e Android: 1ineSpacing = 1.2 * 1abel.FontSize
e  Windows Phone: 1ineSpacing = 1.3 * label.FontSize

The second helpful number is average character width. For a normal mix of uppercase and lower-
case letters for the default fonts, this average character width is about half of the font size, regardless
of the platform:

e averageCharacterWidth = 0.5* label.FontSize

For example, suppose you want to fit a text string containing 80 characters in a width of 320 units,
and you'd like the font size to be as large as possible. Divide the width (320) by half the number of
characters (40), and you get a font size of 8, which you can set to the FontSize property of Label. For
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text that's somewhat indeterminate and can't be tested beforehand, you might want to make this cal-
culation a little more conservative to avoid surprises.

The following program uses both line spacing and average character width to fit a paragraph of text
on the page, minus the area at the top of the iPhone occupied by the status bar. To make the exclusion
of the iOS status bar a bit easier in this program, the program uses a ContentvView.

ContentView derives from Layout but only adds a Content property to what it inherits from
Layout. ContentView is also the base class to Frame. Although Contentview has no functionality
other than occupying a rectangular area of space, it is useful for two purposes: Most often, Content-
View can be a parent to other views to define a new custom view. But Contentview can also simulate
a margin.

As you might have noticed, Xamarin.Forms has no concept of a margin, which traditionally is similar
to padding except that padding is inside a view and a part of the view, while a margin is outside the
view and actually part of the parent’s view. A ContentView lets us simulate this. If you find a need to
set a margin on a view, put the view in a ContentView and set the Padding property on the con-
tentView. ContentView inherits a Padding property from Layout.

The EstimatedFontSize program uses ContentView in a slightly different manner: It sets the cus-
tomary padding on the page to avoid the iOS status bar, but then it sets a Contentview as the con-
tent of that page. Hence, this Contentview is the same size as the page, but excluding the iOS status
bar. It is on this ContentView that the SizeChanged event is attached, and it is the size of this con-
tentView that is used to calculate the text font size.

The sizeChanged handler uses the first argument to obtain the object firing the event (in this case
the Contentview), which is the object in which the Label must fit. The calculation is described in
comments:

public class EstimatedFontSizePage : ContentPage

{
Label Tabel;

public EstimatedFontSizePage()
{
Tabel = new Label(Q);
Padding = new Thickness(0, Device.OnPlatform(20, 0, 0), 0, 0);
ContentView contentView = new ContentView
{
Content = Tlabel
b
contentView.SizeChanged += OnContentViewSizeChanged;
Content = contentView;

}

void OnContentViewSizeChanged(object sender, EventArgs args)
{
string text =
"A default system font with a font size of S " +
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"has a Tline height of about ({0:F1} * S) and an " +
"average character width of about ({1:F1} * S). " +
"On this page, which has a width of {2:F0} and a " +
"height of {3:F0}, a font size of 7?1 should " +

"comfortably render the ??2 characters in this " +

"paragraph with ?3 Tines and about ?4 characters +
"per line. Does it work?";

// Get View whose size is changing.
View view = (View)sender;

// Define two values as multiples of font size.
double TineHeight = Device.OnPlatform(1.2, 1.2, 1.3);
double charWidth = 0.5;

// Format the text and get its character length.
text = String.Format(text, lineHeight, charWidth, view.Width, view.Height);
int charCount = text.Length;

// Because:

// TineCount = view.Height / (lineHeight * fontSize)

// charsPerLine = view.Width / (charWidth * fontSize)

// charCount = TineCount * charsPerLine

// Hence, solving for fontSize:

int fontSize = (int)Math.Sqrt(view.Width * view.Height /
(charCount * 1ineHeight * charWidth));

// Now these values can be calculated.
int TineCount = (int)(view.Height / (lineHeight * fontSize));
int charsPerLine = (int)(view.Width / (charWidth * fontSize));

// Replace the placeholders with the values.

text = text.Replace("?1", fontSize.ToString());
text = text.Replace("??2", charCount.ToString());
text = text.Replace("?3", T1ineCount.ToString(Q));
text = text.Replace("?4", charsPerLine.ToString());

// Set the Label properties.
Tabel.Text = text;
Tlabel.FontSize = fontSize;

The text placeholders named “?1", "??2", "?3", and "?4" were chosen to be unique but also to be the
same number of characters as the numbers that replace them.

If the goal is to make the text as large as possible without the text spilling off the page, the results
validate the approach:
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Not bad. Not bad at all. The text actually displays in one less line that indicated on all three platforms,
but the technique seems sound. It's not always the case that the same Fontsize is calculated for land-
scape mode, but it happens sometimes:
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A fit-to-size clock

The Device class includes a static StartTimer method that lets you set a timer that fires a periodic
event. The availability of a timer event means that a clock application is possible, even if it displays the
time only in text.

The first argument to Device.StartTimer is an interval expressed as a TimeSpan value. The timer
fires an event periodically based on that interval. (You can go down as low as 15 or 16 milliseconds,
which is about the period of the frame rate of 60 frames per second common on video displays.) The
event handler has no arguments but must return true to keep the timer going.

The FitToSizeClock program creates a Label for displaying the time and then sets two events: the
SizeChanged event on the page for changing the font size, and the Device.StartTimer event for
one-second intervals to change the Text property.

Many C# programmers these days like to define small event handlers as anonymous lambda func-
tions. This allows the event-handling code to be very close to the instantiation and initialization of the
object firing the event instead of somewhere else in the file. It also allows referencing objects within
the event handler without storing those objects as fields.

In this program, both event handlers simply change a property of the Label, and they are both ex-
pressed as lambda functions so that they can access the Label without it being stored as a field:

public class FitToSizeClockPage : ContentPage

{
public FitToSizeClockPage()
{
Label clockLabel = new Label
{
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center
};

Content = clockLabel;

// Handle the SizeChanged event for the page.
SizeChanged += (object sender, EventArgs args) =>

{
// Scale the font size to the page width
// (based on 11 characters in the displayed string).
if (this.Width > 0)
clockLabel.FontSize = this.Width / 6;
}

// Start the timer going.
Device.StartTimer(TimeSpan.FromSeconds(1), (O =>
{
// Set the Text property of the Label.
clockLabel.Text = DateTime.Now.ToString("h:mm:ss tt");
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return true;

B;

The startTimer handler specifies a custom formatting string for bateTime that results in 10 or 11
characters, but two of those are capital letters, and those are wider than average characters. The
SizeChanged handler implicitly assumes that 12 characters are displayed by setting the font size to
one-sixth of the page width:

12:25:16 PM 12:25:27 PM 12:25:41 PM

Of course, the text is much larger in landscape mode:
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This one-second timer doesn't tick exactly at the beginning of every second, so the displayed time
might not precisely agree with other time displays on the same device. You can make it more accurate
by setting a more frequent timer tick. Performance won't be impacted much because the display still
changes only once per second and won't require a new layout cycle until then.

Accessibility issues

The EstimatedFontSize program and the FitToSizeClock program both have a subtle flaw, but the
problem might not be so subtle if you're one of the many people who can’t comfortably read text on a
mobile device and uses the device's accessibility features to make the text larger.

On iOSs, run the Settings app, and choose General, and Accessibility, and Larger Text. You can
then use a slider to make text on the screen larger or smaller. The page indicates that text will only be
adjusted in iOS applications that support the Dynamic Type feature.

On Android, run the Settings app, and choose Display and then Font size. You are presented with
four radio buttons for selecting Small, Normal (the default), Large, or Huge.

On a Windows 10 Mobile device, run the Settings app, and choose Ease of Access and then More
options. You can then move a slider labeled Text scaling from 100% to 200%.

Here's what you will discover:

The iOS setting has no effect on Xamarin.Forms applications.
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The Android setting affects the values returned from Device.GetNamedSize. If you select some-
thing other than Normal and run the FontSizes program again, you'll see that for the
NamedSize.Default argument, Device.GetNamedSize returns 14 when the setting is Normal (as
the earlier screenshot shows), but returns 12 for a setting of Small, 16 for Large, and 18 1/3 for Huge.

Also, all the text displayed on the Android screen is a different size—either smaller or larger de-
pending on what setting you selected—even for constant FontSize values.

On Windows 10 Mobile, the values returned from Device.GetNamedSize do not depend on the
accessibility setting, but all the text is displayed larger.

This means that the EstimatedFontSize or FitToSizeClock programs do not run correctly on An-
droid or Windows 10 Mobile with the accessibility setting for larger text. Part of the text is truncated.

Let's explore this a little more. The AccessibilityTest program displays two Label elements on its
page. The first has a constant FontSize of 20, and the second merely displays the size of the first
Label when its size changes:

public class AccessibilityTestPage : ContentPage

{
public AccessibilityTestPage()
{
Label testLabel = new Label
{
Text = "FontSize of 20" + Environment.NewLine + "20 characters across",
FontSize = 20,
HorizontalTextAlignment = TextAlignment.Center,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.CenterAndExpand
};
Label displayLabel = new Label
{
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.CenterAndExpand
};
testLabel.SizeChanged += (sender, args) =>
{
displayLabel.Text = String.Format("{0:FO0} \u0O0OD7 {1:F0}", testlLabel.Width,
testlLabel.Height);
};
Content = new Stacklayout
{
Children =
{
testlLabel,
displayLabel
}
b
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Normally, the second Labe1l displays a size that is roughly consistent with the assumptions described
earlier:

FontSize of 20
20 characters across

FontSize of 20
20 characters across

But now go into the accessibility settings and crank them all the way up. Both Android and Windows
10 Mobile display larger text:

FontSize of 20 FontSize of 20
20 characte ross
i sl 20 characters across

FontSize of 20
20 characters across
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The character size assumptions described earlier are no longer valid, and that's why the programs fail

to fit the text.

But there is an alternative approach to sizing text to a rectangular area.

Empirically fitting text

Another approach to fitting text within a rectangle of a particular size involves empirically determining
the size of the rendered text based on a particular font size and then adjusting that font size up or
down. This approach has the advantage of working on all devices regardless of the accessibility
settings.

But the process can be tricky: The first problem is that there is not a clean linear relationship be-
tween the font size and the height of the rendered text. As text gets larger relative to the width of its
container, more line breaks result, with more wasted space. A calculation to find the optimum font size
often involves a loop that narrows in on the value.

A second problem involves the actual mechanism of obtaining the size of a Label rendered with a
particular font size. You can set a SizeChanged handler on the Label, but within that handler you
don't want to make any changes (such as setting a new Fontsize property) that will cause recursive
calls to that handler.

A better approach is calling the GetsSizeRequest method defined by VisualElement and inher-
ited by Label and all other views. GetSizeRequest requires two arguments—a width constraint and
a height constraint. These values indicate the size of the rectangle in which you want to fit the element,
and one or the other can be infinity. When using GetSizeRequest with a Label, generally you set
the width constraint argument to the width of the container and the height constraint to

Double.PositiveInfinity

The GetsizeRequest method returns a value of type sizeRequest, a structure with two proper-
ties, named Request and Minimum, both of type Size. The Request property indicates the size of the
rendered text. (More information on this and related methods can be found in Chapter 26.)

The EmpiricalFontSize project demonstrates this technique. For convenience, it defines a small
structure named FontCalc whose constructor makes the call to GetSizeRequest for a particular
Label (already initialized with text), a trial font size, and a text width:

struct FontCalc
{
public FontCalc(Label Tabel, double fontSize, double containerWidth)
: thisQ
{
// Save the font size.
FontSize = fontSize;

// Recalculate the Label height.
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label.FontSize = fontSize;
SizeRequest sizeRequest =
Tlabel.GetSizeRequest(containerWidth, Double.PositiveInfinity);

// Save that height.
TextHeight = sizeRequest.Request.Height;

public double FontSize { private set; get; }

public double TextHeight { private set; get; }
}

The resultant height of the rendered Label is saved in the TextHeight property.

When you make a call to GetSizeRequest on a page or a layout, the page or layout needs to ob-
tain the sizes of all its children down through the visual tree. This has a performance penalty, of course,
so you should avoid making calls like that unless necessary. But a Label has no children, so calling
GetSizeRequest On a Label is not nearly as bad. However, you should still try to optimize the calls.
Avoid looping through a sequential series of font size values to determine the maximum value that
doesn't result in text exceeding the container height. A process that algorithmically narrows in on an
optimum value is better.

GetSizeRequest requires that the element be part of a visual tree and that the layout process has
at least partially begun. Don't call GetSizeRequest in the constructor of your page class. You won't
get information from it. The first reasonable opportunity is in an override of the page’s OnAppearing
method. Of course, you might not have sufficient information at this time to pass arguments to the
GetSizeRequest method

However, calling GetSizeRequest doesn't have any side effects. It doesn’t cause a new size to be
set on the element, which means that it doesn’t cause a SizeChanged event to be fired, which means
that it's safe to call in a SizeChanged handler.

The EmpiricalFontSizePage class instantiates FontCalc values in the SizeChanged handler of
the ContentView that hosts the Label. The constructor of each Fontcalc value makes GetSize-
Request calls on the Label and saves the resultant TextHeight. The SizeChanged handler begins
with trial font sizes of 10 and 100 under the assumption that the optimum value is somewhere be-
tween these two and that these represent lower and upper bounds. Hence the variable names 1ower-
FontCalc and upperFontCalc:

public class EmpiricalFontSizePage : ContentPage

{
Label Tabel;

public EmpiricalFontSizePage()
{
label = new Label(Q);

Padding = new Thickness(0, Device.OnPlatform(20, 0, 0), 0, 0);
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ContentView contentView = new ContentView

{
Content = Tlabel

1

contentView.SizeChanged += OnContentViewSizeChanged;

Content = contentView;

void OnContentViewSizeChanged(object sender, EventArgs args)

{

// Get View whose size is changing.
View view = (View)sender;

if (view.Width <= 0 || view.Height <= 0)

return;

Tabel.Text =

"This is a paragraph of text displayed with " +

"a FontSize value of ?? that is empirically " +
"calculated in a Toop within the SizeChanged " +
"handler of the Label's container. This technique " +

"

"can be tricky: You don't want to get into " +
"an infinite Toop by triggering a Tayout pass +
"with every calculation. Does it work?";

"

// Calculate the height of the rendered text.

FontCalc TowerFontCalc
FontCalc upperFontCalc

new FontCalc(label, 10, view.Width);
new FontCalc(label, 100, view.Width);

while (upperFontCalc.FontSize - lowerFontCalc.FontSize > 1)

// Get the average font size of the upper and Tower bounds.
double fontSize = (TowerFontCalc.FontSize + upperFontCalc.FontSize) / 2;

// Check the new text height against the container height.

FontCalc newFontCalc = new FontCalc(label, fontSize, view.Width);

if (newFontCalc.TextHeight > view.Height)

{
{
upperFontCalc =
}
else
{
TowerFontCalc =
}
}

// Set the final font size and the text with the embedded value.

newFontCalc;

newFontCalc;

label.FontSize = TowerFontCalc.FontSize;

Tabel.Text = label.Text.Replace("??", Tabel.FontSize.ToString("F0"));

110
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In each iteration of the while loop, the FontSize properties of those two FontCalc values are aver-
aged and a new FontCalc is obtained. This becomes the new lowerFontCalc or upperFontCalc
value depending on the height of the rendered text. The loop ends when the calculated font size is
within one unit of the optimum value.

About seven iterations of the loop are sufficient to get a value that is clearly better than the esti-
mated value calculated in the earlier program:

his is a paragraph of
ext displayed with a
FontSize value of 36
hat is empirically
calculated in a loop

ithin the SizeChanged
handler of the Label's

icontainer. This

echnique can be
ricky: You don't want
o get into an infinite
loop by triggering a
layout pass with every
| calculation. Does it
ork?

] % % O @ 10:04
This is a paragraph of
text displayed with a
FontSize value of 34
that is empirically
calculated in a loop
within the SizeChanged
handler of the Label's
container. This
technigue can be tricky:
You don't want to get
into an infinite loop by
triggering a layout pass
with every calculation.
Does it work?

ail -, 343

his is a paragraph of
ext displayed with a
FontSize value of 30 that
is empirically calculated
in a loop within the
SizeChanged handler of
he Label's container.

his technique can be
ricky: You don't want to
get into an infinite loop
by triggering a layout
pass with every
calculation. Does it work?

Turning the phone sideways triggers another recalculation that results in a similar (though not nec-

essarily the same) font size:
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* This is a paragraph of text displayed
with a FontSize value of 30 that is

empirically calculated in a loop within
the SizeChanged handler of the Label's
container. This technique can be tricky:
You don't want to get into an infinite
loop by triggering a layout pass with

“ every calculation. Does it work?

¥ % D' B 100
This is a paragraph of text displayed
with a FontSize value of 35 that is
empirically calculated in a loop within
the SizeChanged handler of the Label's o
container. This technique can be tricky:
You don't want to get into an i

_loop by triggering a layout pass

every calculation. Does it work?

his is a paragraph of text displayed with
a FontSize value of 37 that is empirically
calculated in a loop within the
SizeChanged handler of the Label's
container. This technique can be tricky:

‘ou don't want to get into an infinite loop
by triggering a layout pass with every
calculation. Does it work?

It might seem that the algorithm could be improved beyond simply averaging the Fontsize prop-
erties from the lower and upper FontCalc values. But the relationship between the font size and ren-

dered text height is rather complex, and sometimes the easiest approach is just as good.
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Button clicks

The components of a graphical user interface can be divided roughly into views that are used for
presentation, which display information to the user, and interaction, which obtain input from the user.
While the Label is the most basic presentation view, the Button is probably the archetypal interactive
view. The Button signals a command. It's the user’s way of telling the program to initiate some ac-
tion—to do something.

A Xamarin.Forms button displays text, with or without an accompanying image. (Only text buttons
are described in this chapter; adding an image to a button is covered in Chapter 13, "Bitmaps.”) When
the user’s finger presses on a button, the button changes its appearance somewhat to provide feed-
back to the user. When the finger is released, the button fires a c1icked event. The two arguments of
the clicked handler are typical of Xamarin.Forms event handlers:

e The first argument is the object firing the event. For the C1icked handler, this is the particular
Button object that's been tapped.

e The second argument sometimes provides more information about the event. For the c1icked
event, the second argument is simply an EventArgs object that provides no additional infor-
mation.

Once an application begins implementing user interaction, some special needs arise: The applica-
tion should make an effort to save the results of that interaction if the program happens to be termi-
nated before the user has finished working with it. For that reason, this chapter also discusses how an
application can save transient data, particularly in the context of application lifecycle events. These are
described in the section “Saving transient data.”

Processing the click

Here's a program named ButtonLogger with a Button that shares a StackLayout with a Scroll-
View containing another StackLayout. Every time the Button is clicked, the program adds
a new Label to the scrollable stackLayout, in effect logging all the button clicks:

public class ButtonLoggerPage : ContentPage

{

StackLayout loggerLayout = new StacklLayout(Q);

public ButtonLoggerPage()

{
// Create the Button and attach Clicked handler.
Button button = new Button
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Text = "Log the Click Time"
};
button.Clicked += OnButtonClicked;

this.Padding = new Thickness(5, Device.OnPlatform(20, 0, 0), 5, 0);

// Assemble the page.
this.Content = new StacklLayout

{
Children =
{
button,
new ScrollView
{
VerticalOptions = LayoutOptions.Fill1AndExpand,
Content = loggerLayout
}
}
b
}
void OnButtonClicked(object sender, EventArgs args)
{
// Add Label to scrollable StackLayout.
loggerLayout.Children.Add(new Label
{
Text = "Button clicked at " + DateTime.Now.ToString("T")
b
}

In the programs in this book, event handlers are given names beginning with the word on, followed
by some kind of identification of the view firing the event (sometimes just the view type), followed by
the event name. The resultant name in this case is OnButtonClicked.

The constructor attaches the c1icked handler to the Button right after the Button is created. The
page is then assembled with a stackLayout containing the Button and a Scrol1lview with another
StackLayout, hamed loggerLayout. Notice that the Scrollview has its VerticalOptions set to
FillAndExpand so that it can share the stackLayout with the Button and still be visible and scrolla-
ble.

Here's the display after several Button clicks:
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Button clicked at 3:

Button clicked at 3:

Button clicked at 3:

Button clicked at 3;

Button clicked at 3:23:39 PM
Button clicked at 3:

Button clicked at 3:

Button clicked at 3:23:

LOG THE CLICK TIME

LA

0324

Log the Click Time

Button clicked at 3:24:46 PM
Button clicked at 3:24:47 PM
Button clicked at 3:24:49 PM
Button clicked at 3:24:51 PM
Button clicked at 3:24:52 PM
Button clicked at 3:24:53 PM
Button clicked at 3:24:55 PM
Button clicked at 3:25:01 PM
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Button clicked at 3:23:41 PM
Button clicked at 3:23:42 PM

Button clicked at 3:23:44 PM

As you can see, the Button looks a little different on the three screens. That's because the button is
rendered natively on the individual platforms: on the iPhone it's a UIButton, on Android it's an
Android Button, and on Windows 10 Mobile it's a Windows Runtime Button. By default the button
always fills the area available for it and centers the text inside.

Button defines several properties that let you customize its appearance:
e FontFamily of type string

e FontSize of type double

e FontAttributes of type FontAttributes

e TextColor of type Color (defaultis Color.Default)

e BorderColor of type Color (defaultis Color.Default)

e BorderWidth of type double (default is 0)

e BorderRadius of type double (default is 5)

e Image (to be discussed in Chapter 13)

Button also inherits the BackgroundColor property (and a bunch of other properties) from
VisualElement and inherits HorizontalOptions and VerticalOptions from vView.

Some Button properties might work a little differently on the various platforms. As you can see,
none of the buttons in the screenshots has a border. (However, the Windows Phone 8.1 button has a
visible white border by default.) If you set the BorderWidth property to a nonzero value, the border
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becomes visible only on the iPhone, and it's black. If you set the BorderColor property to something
other than Color.Default, the border is visible only on the Windows 10 Mobile device. If you want a
visible border on both iOS and Windows 10 mobile devices, set both Borderwidth and BorderColor.
But the border still won't show up on Android devices unless you also set the BackgroundColor
property. Customizing a button border is a good opportunity for using Device.onPlatform (as you'll
see in Chapter 10, "“XAML markup extensions”).

The BorderRadius property is intended to round off the sharp corners of the border, and it works
on iOS and Android if the border is displayed, but it doesn’t work on Windows 10 and Windows 10
Mobile. The BorderRadius works on Windows 8.1 and Windows Phone 8.1, but if you use it with
BackgroundColor, the background is not enclosed within the border.

Suppose you wrote a program similar to ButtonLogger but did not save the 1oggerLayout object
as a field. Could you get access to that stackLayout object in the Clicked event handler?

Yes! It's possible to obtain parent and child visual elements by a technique called walking the visual
tree. The sender argument to the OnButtonClicked handler is the object firing the event, in this case
the Button, so you can begin the c1icked handler by casting that argument:

Button button = (Button)sender;

You know that the Button is a child of a StackLayout, so that object is accessible from the Parent
property. Again, some casting is required:

StackLayout outerLayout = (StacklLayout)button.Parent;

The second child of this stackLayout is the Scrol1view, so the Children property can be indexed
to obtain that:

ScrollView scrollView = (ScrollView)outerLayout.Children[1];

The content property of this Scrollview is exactly the StackLayout you were looking for:

StackLayout loggerLayout = (StacklLayout)scrollView.Content;

Of course, the danger in doing something like this is that you might change the layout someday
and forget to change your tree-walking code similarly. But the technique comes in handy if the code
that assembles your page is separate from the code handling events from views on that page.

Sharing button clicks

If a program contains multiple Button views, each Button can have its own Clicked handler. But in
some cases it might be more convenient for multiple Button views to share a common Clicked
handler.

Consider a calculator program. Each of the buttons labeled 0 through 9 basically does the same
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thing, and having 10 separate Clicked handlers for these 10 buttons—even if they share some com-
mon code—simply wouldn’t make much sense.

You've seen how the first argument to the c1icked handler can be cast to an object of type
Button. But how do you know which Button it is?

One approach is to store all the Button objects as fields and then compare the Button object fir-
ing the event with these fields.

The TwoButtons program demonstrates this technique. This program is similar to the previous pro-
gram but with two buttons—one to add Label objects to the stackLayout, and the other to remove
them. The two Button objects are stored as fields so that the c1icked handler can determine which
one fired the event:

public class TwoButtonsPage : ContentPage
{
Button addButton, removeButton;
StackLayout loggerLayout = new StacklLayout(Q);

public TwoButtonsPage()
{
// Create the Button views and attach Clicked handlers.
addButton = new Button
{
Text = "Add",
HorizontalOptions = LayoutOptions.CenterAndExpand
};
addButton.Clicked += OnButtonClicked;

removeButton = new Button

{
Text = "Remove",
HorizontalOptions = LayoutOptions.CenterAndExpand,
IskEnabled = false

b

removeButton.Clicked += OnButtonClicked;
this.Padding = new Thickness(5, Device.OnPlatform(20, 0, 0), 5, 0);

// Assemble the page.
this.Content = new StacklLayout

{
Children =
{
new StacklLayout
{
Orientation = StackOrientation.Horizontal,
Children =
{
addButton,
removeButton
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1,
new ScrollView
{
VerticalOptions = LayoutOptions.FillAndExpand,
Content = loggerLayout
}
}
1
}
void OnButtonClicked(object sender, EventArgs args)
{
Button button = (Button)sender;
if (button == addButton)
{
// Add Label to scrollable StackLayout.
loggerLayout.Children.Add(new Label
{
Text = "Button clicked at " + DateTime.Now.ToString("T")
b
}
else
{
// Remove topmost Label from StackLayout.
ToggerLayout.Children.RemoveAt(0);
}
// Enable "Remove" button only if children are present.
removeButton.IsEnabled = loggerLayout.Children.Count > 0;
}

}

Both buttons are given a HorizontalOptions value of CenterAndExpand so that they can be dis-
played side by side at the top of the screen by using a horizontal StackLayout:
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i Wa

REMOVE

Button clicked at 8:55:06 AM
Button clicked at 8:55:09 AM
Button clicked at 8:55:11 AM
Button dlicked at 8:55:13 AM
Button clicked at 8:55:17 AM
Button clicked at 8:55:19 AM
Button clicked at 8:55:21 AM

Button clicked at 8:54:23 AM
Button clicked at 8:54:24 AM
Button clicked at 5 AM
Button clicked at 8:54:27 AM
Button clicked at 8:54:28 AM
Button clicked at 8:54:28 AM
Button clicked at 8:54:31 AM

Notice that when the clicked handler detects removeButton, it simply calls the Removeat
method on the Children property:

loggerLayout.Children.RemoveAt(0);
But what happens if there are no children? Won't RemoveAt raise an exception?

It can’t happen! When the TwoButtons program begins, the IsEnabled property of the remove-
Button is initialized to false. When a button is disabled in this way, a dim appearance signals to the
user that it's nonfunctional. It does not provide feedback to the user and it does not fire C1icked
events. Toward the end of the c1icked handler, the TsEnabled property on removeButton is set to
true only if the loggerLayout has at least one child.

This illustrates a good general rule: if your code needs to determine whether a button clicked
event is valid, it's probably better to prevent invalid button clicks by disabling the button.

Anonymous event handlers

As with any event handler, you can define a c1icked handler as an anonymous lambda function.
Here's a program named ButtonLambdas that has a Label displaying a number and two buttons.
One button doubles the number, and the other halves the number. Normally, the number and Label
variables would be saved as fields. But because the anonymous event handlers are defined right in the
constructor after these variables are defined, the event handlers have access to these local variables:

public class ButtonLambdasPage : ContentPage
{
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public ButtonLambdasPage()

{

// Number to manipulate.
double number = 1;

// Create the Label for display.
Label 1abel = new Label

{
Text = number.ToStringQ),
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.CenterAndExpand
b

// Create the first Button and attach Clicked handler.
Button timesButton = new Button

{
Text = "Double",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Button)),
HorizontalOptions = LayoutOptions.CenterAndExpand
};
timesButton.Clicked += (sender, args) =>
{
number *= 2;
Tlabel.Text = number.ToString(Q);
b

// Create the second Button and attach Clicked handler.
Button divideButton = new Button

{
Text = "Half",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Button)),
HorizontalOptions = LayoutOptions.CenterAndExpand
b
divideButton.Clicked += (sender, args) =>
{
number /= 2;
Tlabel.Text = number.ToString();
b

// Assemble the page.
this.Content = new StacklLayout

{
Children =
{
Tlabel,
new StacklLayout
{

Orientation = StackOrientation.Horizontal,
VerticalOptions = LayoutOptions.CenterAndExpand,
Children =
{

timesButton,

divideButton
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}

Notice the use of Device.GetNamedSize to get large text for both the Label and the Button. When
used with Labe1l, the second argument of GetNamedsSize should indicate a Labe1, and when used
with the Button it should indicate a Button. The sizes for the two elements might be different.

Like the previous program, the two buttons share a horizontal StackLayout:

LA i ERt]

00078125 e 0.015625

DOUBLE
Double Double Half

The disadvantage of defining event handlers as anonymous lambda functions is that they can't be
shared among multiple views. (Actually they can, but some messy reflection code is involved.)

Distinguishing views with IDs

In the TwoButtons program, you saw a technique for sharing an event handler that distinguishes
views by comparing objects. This works fine when there aren’t very many views to distinguish, but it
would be a terrible approach for a calculator program.

The Element class defines a stylelId property of type string specifically for the purpose of iden-
tifying views. It's not used for anything internal to Xamarin.Forms, so you can set it to whatever is con-
venient for the application. You can test the values by using if and else statements or in a switch
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and case block, or you can use a pParse method to convert the strings into numbers or enumeration
members.

The following program isn't a calculator, but it is a numeric keypad, which is certainly part of a cal-
culator. The program is called SimplestKeypad and uses a StackLayout for organizing the rows and
columns of keys. (One of the intents of this program is to demonstrate that stackLayout is not quite
the right tool for this job!)

The program creates a total of five stackLayout instances. The mainStack is vertically oriented,
and four horizontal stackLayout objects arrange the 10 digit buttons. To keep things simple, the key-
pad is arranged with telephone ordering rather than calculator ordering:

public class SimplestKeypadPage : ContentPage
{

Label displayLabel;

Button backspaceButton;

public SimplestKeypadPage()
{
// Create a vertical stack for the entire keypad.
StacklLayout mainStack = new StacklLayout
{
VerticalOptions = LayoutOptions.Center,
HorizontalOptions = LayoutOptions.Center

1

// First row is the Label.
displayLabel = new Label

{
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
VerticalOptions = LayoutOptions.Center,
HorizontalTextAlignment = TextAlignment.End

};

mainStack.Children.Add(dispTlayLabel);

// Second row is the backspace Button.
backspaceButton = new Button

{
Text = "\u2lE6",
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Button)),
IsEnabled = false

};

backspaceButton.Clicked += OnBackspaceButtonClicked;
mainStack.Children.Add(backspaceButton);

// Now do the 10 number keys.
StackLayout rowStack = null;

for (int num = 1; num <= 10; num++)
{

if ((hum - 1) % 3 == 0)

{
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rowStack = new StacklLayout

{
Orientation = StackOrientation.Horizontal
};
mainStack.Children.Add(rowStack);
}
Button digitButton = new Button
{
Text = (num % 10) .ToString(),
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Button)),
StyleId = (num % 10).ToString(Q
}

digitButton.Clicked += OnDigitButtonClicked;

// For the zero button, expand to fill horizontally.
if (num == 10)

{
digitButton.HorizontalOptions = LayoutOptions.FiTlAndExpand;
}
rowStack.Children.Add(digitButton);
}
this.Content = mainStack;
}
void OnDigitButtonClicked(object sender, EventArgs args)
{
Button button = (Button)sender;
displayLabel.Text += (string)button.Styleld;
backspaceButton.IsEnabled = true;
}
void OnBackspaceButtonClicked(object sender, EventArgs args)
{
string text = displaylLabel.Text;
displayLabel.Text = text.Substring(0, text.Length - 1);
backspaceButton.IsEnabled = displaylLabel.Text.Length > 0;
}

The 10 number keys share a single clicked handler. The style1d property indicates the number
associated with the key, so the program can simply append that number to the string displayed by the
Label. The styleId happens to be identical to the Text property of the Button, and the Text prop-
erty could be used instead, but in the general case, things aren’t always quite that convenient.

The backspace Button is sufficiently different in function to warrant its own C1icked handler, al-
though it would surely be possible to combine the two methods into one to take advantage of any
code they might have in common.

To give the keypad a slightly larger size, all the text is given a FontSize using NamedSize.Large.
Here are the three renderings of the SimplestKeypad program:
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Of course, you'll want to press the keys repeatedly until you see how the program responds to a
really large string of digits, and you'll discover that it doesn't adequately anticipate such a thing. When
the Label gets too wide, it begins to govern the overall width of the vertical stackLayout, and the
buttons start shifting as well.

Moreover, if the buttons contain letters or symbols rather than numbers, the buttons will be
misaligned because each button width is based on its content.

Can you fix this problem with the Expands flag on the HorizontalOptions property? No. The
Expands flag causes extra space to be distributed equally among the views in the StackLayout. Each
view will increase additively by the same amount, but the buttons start out with different widths, and
they will always have different widths. For example, take a look at the two buttons in the TwoButtons
or ButtonLambdas program. Those buttons have their HorizontalOptions properties set to Fill-
AndExpand, but they are different widths because the width of the button content is different.

A better solution for these programs is the layout known as the Grid, coming up in Chapter 17.

Saving transient data

Suppose you're entering an important number in the SimplestKeypad program and you're inter-
rupted—perhaps with a phone call. Later on, you shut off the phone, effectively terminating the

program.

What should happen the next time you run SimplestKeypad? Should the long string of numbers
you entered earlier be discarded? Or should it seem as though the program resumed from the state
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you last left it? Of course, it doesn't matter for a simple demo program like SimplestKeypad, but in
the general case, users expect mobile applications to remember exactly what they were doing the last
time they interacted with the program.

For this reason, the application class supports two facilities that help the program save and re-
store data:

e The Properties property of Application is a dictionary with string keys and object
items. The contents of this dictionary are automatically saved prior to the application being ter-
minated, and the saved contents become available the next time the application runs.

e The Application class defines three protected virtual methods, named onstart, OnSleep,
and OnResume, and the App class generated by the Xamarin.Forms template overrides these
methods. These methods help an application deal with what are known as application lifecycle
events.

To use these facilities, you need to identify what information your application needs to save so that
it can restore its state after being terminated and restarted. In general, this is a combination of applica-
tion settings—such as colors and font sizes that the user might be given an opportunity to set—and
transient data, such as half-entered entry fields. Application settings usually apply to the entire applica-
tion, while transient data is unique to each page in the application. If each item of this data is an entry
in the Properties dictionary, each item needs a dictionary key. However, if a program needs to save
a large file such as a word-processing document, it shouldn’t use the Properties dictionary, but in-
stead should access the platform’s file system directly. (That's a job for Chapter 20, “Async and file
1/0.")

Also, you should restrict the data types used with Properties to the basic data types supported by
.NET and C#, such as string, int, and double.

The SimplestKeypad program needs to save only a single item of transient data, and the dictionary
key “displayLabelText" seems reasonable.

Sometimes a program can use the Properties dictionary to save and retrieve data without getting
involved with application lifecycle events. For example, the SimplestKeypad program knows exactly
when the Text property of displayLabel changes. It happens only in the two C1icked event han-
dlers for the number keys and the delete key. Those two event handlers could simply store the new
value in the Properties dictionary.

But wait: Properties is a property of the Application class. Do we need to save the instance of
the aApp class so that code in the simplestKeypadPage can get access to the dictionary? No, it's not
necessary. Application defines a static property named Current that returns the current applica-
tion’s instance of the Application class.

To store the Text property of the Label in the dictionary, simply add the following line at the bot-
tom of the two Cclicked event handlers in SimplestKeypad:
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Application.Current.Properties["displaylLabelText"] = displayLabel.Text;

Don't worry if the displayLabelText key does not yet exist in the dictionary: The Properties dic-
tionary implements the generic IDictionary interface, which explicitly defines the indexer to replace
the previous item if the key already exists or to add a new item to the dictionary if the key does not
exist. That behavior is exactly what you want here.

The simplestKeypadPage constructor can then conclude by initializing the Text property of the
Label with the following code, which retrieves the item from the dictionary:

IDictionary<string, object> properties = Application.Current.Properties;

if (properties.ContainsKey("displayLabelText"))

{
displayLabel.Text = properties["displaylLabelText"] as string;
backspaceButton.IsEnabled = displaylLabel.Text.Length > 0;

This is all your application needs to do: just save information in the Properties dictionary and re-
trieve it. Xamarin.Forms itself is responsible for the job of saving and loading the contents of the dic-
tionary in platform-specific application storage.

In general, however, it's better for an application to interact with the Properties dictionary in a
more structured manner, and here’s where the application lifecycle events come into play. These are
the three methods that appear in the App class generated by the Xamarin.Forms template:

public class App : Application

{
public AppQ
{
}
protected override void OnStart()
{
// Handle when your app starts
}
protected override void OnSleep()
{
// Handle when your app sleeps
}
protected override void OnResume()
{
// Handle when your app resumes
}
}

The most important is the onsleep call. In general, an application goes into sleep mode when it no
longer commands the screen and has become inactive (apart from some background jobs it might
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have initiated). From this sleep mode, an application can be resumed (signaled by an onResume call) or
terminated. But this is important: After the onsieep call, there is no further notification that an appli-
cation is being terminated. The ons1eep call is as close as you get to a termination notification, and it
always precedes a termination. For example, if your application is running and the user turns off the
phone, the application gets an onSleep call as the phone is shutting down.

Actually, there are some exceptions to the rule that a call to onsleep always precedes program ter-
mination: a program that crashes does not get an onsleep call first, but you probably expect that. But
here’s a case that you might not anticipate: When you are debugging a Xamarin.Forms application,
and use Visual Studio or Xamarin Studio to stop debugging, the program is terminated without a pre-
ceding OnSleep call. This means that when you are debugging code that uses these application life-
cycle events, you should get into the habit of using the phone itself to put your program to sleep, to
resume the program, and to terminate it.

When your Xamarin.Forms application is running, the easiest way to trigger an onsleep call on a
phone or simulator is by pressing the phone’s Home button. You can then bring the program back to
the foreground and trigger an onResume call by selecting the application from the home menu (on
iOS devices or Android devices) or by pressing the Back button (on Android and Windows Phone
devices).

If your Xamarin.Forms program is running and you invoke the phone’s application switcher—by
pressing the Home button twice on iOS devices, by pressing the Multitask button on Android devices
(or by holding down the Home button on older Android devices), or by holding down the Back button
on a Windows Phone—the application gets an onsleep call. If you then select that program, the appli-
cation gets an OnResume call as it resumes execution. If you instead terminate the application—by
swiping the application’s image upward on iOS devices or by tapping the X on the upper-right corner
of the application’s image on Android and Windows Phone devices—the program stops executing with
no further notification.

So here's the basic rule: Whenever your application gets a call to onsleep, you should ensure that
the Properties dictionary contains all the information about the application you want to save.

If you're using lifecycle events solely for saving and restoring program data, you don't need to han-
dle the onResume method. When your program gets an onResume call, the operating system has al-
ready automatically restored the program contents and state. If you want to, you can use OnResume as
an opportunity to clear out the Properties dictionary because you are assured of getting another
onSleep call before your program terminates. However, if your program has established a connection
with a web service—or is in the process of establishing such a connection—you might want to use on-
Resume to restore that connection. Perhaps the connection has timed out in the interval that the pro-
gram was inactive. Or perhaps some fresh data is available.

You have some flexibility when you restore the data from the Properties dictionary to your appli-
cation as your program starts running. When a Xamarin.Forms program starts up, the first opportunity
you have to execute some code in the Portable Class Library is the constructor of the App class. At that
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time, the Properties dictionary has already been filled with the saved data from platform-specific
storage. The next code that executes is generally the constructor of the first page in your application
instantiated from the App constructor. The onstart call in Application (and App) follows that, and
then an overridable method called onaAppearing is called in the page class. You can retrieve the data
at any time during this startup process.

The data that an application needs to save is usually in a page class, but the Onsleep override is in
the App class. So somehow the page class and the App class must communicate. One approach is to
define an ons1eep method in the page class that saves the data to the Properties dictionary and
then call the page’s onsleep method from the onsieep method in app. This approach works fine for
a single-page application—indeed, the application class has a static property named MainPage that
is set in the App constructor and which the ons1eep method can use to get access to that page—but it
doesn’t work nearly as well for multipage applications.

Here's a somewhat different approach: You first define all the data you need to save as public prop-
erties in the App class, for example:

public class App : Application

{

pubTic AppQ

{

}

public string DisplayLabelText { set; get; }
}

The page class (or classes) can then set and retrieve those properties when convenient. The App class
can restore any such properties from the Properties dictionary in its constructor prior to instantiat-
ing the page and can store the properties in the Properties dictionary in its Onsleep override.

That's the approach taken by the PersistentKeypad project. This program is identical to Simplest-
Keypad except that it includes code to save and restore the contents of the keypad. Here's the app
class that maintains a public DisplayLabelText property that is saved in the onsleep override and
loaded in the App constructor:

namespace PersistentKeypad
{
public class App : Application

{
const string displayLabelText = "displaylLabelText";

pubTlic AppQO
{
if (Properties.ContainsKey(displaylLabelText))
{
DisplaylLabelText = (string)Properties[displaylLabelText];
}
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MainPage = new PersistentKeypadPage();

public string DisplaylLabelText { set; get; }

protected override void OnStart()

{
// Handle when your app starts
}
protected override void OnSleep()
{
// Handle when your app sleeps
Properties[displayLabelText] = DisplaylLabelText;
}
protected override void OnResume()
{
// Handle when your app resumes
}

}

To avoid spelling errors, the App class defines the string dictionary key as a constant. It's the same as
the property name except that it begins with a lowercase letter. Notice that the DisplayLabelText
property is set prior to instantiating PersistentKeypadPage so that it's available in the
PersistentKeypadPage constructor.

An application with many more items might want to consolidate them in a class named Appset-
tings (for example), serialize that class to an XML or a JSON string, and then save the string in the
dictionary.

The PersistentKeypadPage class accesses that DisplayLabelText property in its constructor
and sets the property in its two event handlers:

public class PersistentKeypadPage : ContentPage
{

Label displaylLabel;

Button backspaceButton;

public PersistentKeypadPage()
{

// New code for loading previous keypad text.

App app = Application.Current as App;

displayLabel.Text = app.DisplaylLabelText;

backspaceButton.IsEnabled = displaylLabel.Text != null &&
displayLabel.Text.Length > 0;
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void OnDigitButtonClicked(object sender, EventArgs args)

{

Button button = (Button)sender;
displayLabel.Text += (string)button.StyleId;
backspaceButton.IsEnabled = true;

// Save keypad text.
App app = Application.Current as App;
app.DisplaylLabelText = displaylLabel.Text;

void OnBackspaceButtonClicked(object sender, EventArgs args)

{

string text = displaylLabel.Text;
displayLabel.Text = text.Substring(0, text.Length - 1);
backspaceButton.IsEnabled = displaylLabel.Text.Length > 0;

// Save keypad text.
App app = Application.Current as App;
app.DisplaylLabelText = displaylLabel.Text;

130

When testing programs that use the Properties dictionary and application lifecycle events, you'll
want to occasionally uninstall the program from the phone or simulator. Uninstalling a program from a

device also deletes any stored data, so the next time the program is deployed from Visual Studio or

Xamarin Studio, the program encounters an empty dictionary, as though it were being run for the very

first time.



Chapter 7

XAML vs. code

C# is undoubtedly one of the greatest programming languages the world has ever seen. You can write
entire Xamarin.Forms applications in C#, and it's conceivable that you've found C# to be so ideally
suited for Xamarin.Forms that you haven't even considered using anything else.

But keep an open mind. Xamarin.Forms provides an alternative to C# that has some distinct ad-
vantages for certain aspects of program development. This alternative is XAML (pronounced "zam-
mel"), which stands for the Extensible Application Markup Language. Like C#, XAML was developed at
Microsoft Corporation, and it is only a few years younger than C#.

As its name suggests, XAML adheres to the syntax of XML, the Extensible Markup Language. This
book assumes that you have familiarity with the basic concepts and syntax of XML.

In the most general sense, XAML is a declarative markup language used for instantiating and initial-
izing objects. That definition might seem excessively general, and XAML is indeed quite flexible. But
most real-world XAML has been used for defining tree-structured visual user interfaces characteristic of
graphical programming environments. The history of XAML-based user interfaces begins with the
Windows Presentation Foundation (WPF) and continues with Silverlight, Windows Phone 7 and 8, and
Windows 8 and 10. Each of these XAML implementations supports a somewhat different set of visual
elements defined by the particular platform. Likewise, the XAML implementation in Xamarin.Forms
supports the visual elements defined by Xamarin.Forms, such as Label, BoxView, Frame, Button,
StackLayout, and ContentPage.

As you've seen, a Xamarin.Forms application written entirely in code generally defines the initial ap-
pearance of its user interface in the constructor of a class that derives from Contentpage. If you
choose to use XAML, the markup generally replaces this constructor code. You will find that XAML pro-
vides a more succinct and elegant definition of the user interface and has a visual structure that better
mimics the tree organization of the visual elements on the page.

XAML is also generally easier to maintain and modify than equivalent code. Because XAML is XML, it
is also potentially toolable: XAML can more easily be parsed and edited by software tools than the
equivalent C# code. Indeed, an early impetus behind XAML was to facilitate a collaboration between
programmers and designers: Designers can use design tools that generate XAML, while programmers
focus on the code that interacts with the markup. While this vision has perhaps only rarely been ful-
filled to perfection, it certainly suggests how applications can be structured to accommodate XAML.
You use XAML for the visuals and code for the underlying logic.

Yet, XAML goes beyond that simple division of labor. As you'll see in a future chapter, it's possible to
define bindings right in the XAML that link user-interface objects with underlying data.
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When creating XAML for Microsoft platforms, some developers use interactive design tools such as
Microsoft Blend, but many others prefer to handwrite XAML. No design tools are available for Xama-
rin.Forms, so handwriting is the only option. Obviously, all the XAML examples in this book are hand-
written. But even when design tools are available, the ability to handwrite XAML is an important skill.

The prospect of handwriting XAML might cause some consternation among developers for another
reason: XML is notoriously verbose. Yet, you'll see almost immediately that XAML is often more concise
than the equivalent C# code. The real power of XAML becomes evident only incrementally, however,
and won't be fully apparent until Chapter 19, “Collection views,” when you use XAML for constructing
templates for multiple items displayed in a Listview.

It is natural for programmers who prefer strongly typed languages such as C# to be skeptical of a
markup language where everything is a text string. But you'll see shortly how XAML is a very strict ana-
log of programming code. Much of what's allowed in your XAML files is defined by the classes and
properties that make up the Xamarin.Forms application programming interface. For this reason, you
might even begin to think of XAML as a "strongly typed" markup language. The XAML parser does its
job in a very mechanical manner based on the underlying API infrastructure. One of the objectives of
this chapter and the next is to demystify XAML and illuminate what happens when the XAML is parsed.

Yet, code and markup are very different: Code defines a process while markup defines a state. XAML
has several deficiencies that are intrinsic to markup languages: XAML has no loops, no flow control, no
algebraic calculation syntax, and no event handlers. However, XAML defines several features that help
compensate for some of these deficiencies. You'll see many of these features in future chapters.

If you do not want to use XAML, you don't need to. Anything that can be done in XAML can be
done in C#. But watch out: Sometimes developers get a little taste of XAML and get carried away and
try to do everything in XAML! As usual, the best rule is “moderation in all things.” Many of the best
techniques involve combining code and XAML in interactive ways.

Let's begin this exploration with a few snippets of code and the equivalent XAML, and then see how
XAML and code fit together in a Xamarin.Forms application.

Properties and attributes

Here is a Xamarin.Forms Label instantiated and initialized in code, much as it might appear in the
constructor of a page class:

new Label

{
Text = "Hello from Code!",
IsVisible = true,
Opacity = 0.75,
HorizontalTextAlignment = TextAlignment.Center,
VerticalOptions = LayoutOptions.CenterAndExpand,
TextColor = Color.Blue,



Chapter 7 XAML vs. code 133

BackgroundColor = Color.FromRgb(255, 128, 128),
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold | FontAttributes.Italic

};

Here is a very similar Label instantiated and initialized in XAML, which you can see immediately is

more concise than the equivalent code:

<Label Text="Hello from XAML!"
IsVisible="True"
Opacity="0.75"
HorizontalTextAlignment="Center"
VerticalOptions="CenterAndExpand"
TextColor="Blue"
BackgroundColor="#FF8080"
FontSize="Large"
FontAttributes="Bold,Italic" />

Xamarin.Forms classes such as Label become XML elements in XAML. Properties such as Text,
IsVisible, and the rest become XML attributes in XAML.

To be instantiated in XAML, a class such as Label must have a public parameterless constructor. (In
the next chapter, you'll see that there is a technique to pass arguments to a constructor in XAML, but
it's generally used for special purposes.) The properties set in XAML must have public set accessors. By
convention, spaces surround an equal sign in code but not in XML (or XAML), but you can use as much
white space as you want.

The concision of the XAML results mostly from the brevity of the attribute values—for example, the
use of the word "Large" rather than a call to the Device.GetNamedSize method. These abbreviations
are not built into the XAML parser. The XAML parser is instead assisted by various converter classes de-
fined specifically for this purpose.

When the XAML parser encounters the Label element, it can use reflection to determine whether
Xamarin.Forms has a class named Label, and if so, it can instantiate that class. Now it is ready to ini-
tialize that object. The Text property is of type string, and the attribute value is simply assigned to
that property.

Because XAML is XML, you can include Unicode characters in the text by using the standard XML
syntax. Precede the decimal Unicode value with s# (or the hexadecimal Unicode value with s#x) and
follow it with a semicolon:

Text="Cost &#x2014; &#x20AC;123.45"

Those are the Unicode values for the em dash and euro symbol. To force a line break, use the line-feed
character s#x0002, or (because leading zeros aren't required) s#xa, or, in decimal, s#10.

Angle brackets, ampersands, and quotation marks have a special meaning in XML, so to include
those characters in a text string, use one of the standard predefined entities:

e glt; for<
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e sgt; for>

e gamp; for &
e gapos; for'
e squot; for"

The HTML predefined entities such as snbsp; are not supported. For a nonbreaking space use s#x20;
instead.

In addition, in Chapter 10, “XAML markup extensions,” you'll discover that curly braces ({ and }) have
a special meaning in XAML. If you need to begin an attribute value with a left curly brace, begin it with
a pair of curly braces ({}) and then the left curly brace.

Back to the example: The Isvisible and Opacity properties of Label are of type bool and dou-
ble, respectively, and these are as simple as you might expect. The XAML parser uses the Bool-
ean.Parse and Double.Parse methods to convert the attribute values. The Boolean.Parse
method is case insensitive, but generally Boolean values are capitalized as “True” and “False” in XAML.
The Double.Parse method is passed a CultureInfo.InvariantCulture argument, so the conver-
sion doesn't depend on the local culture of the programmer or user.

The HorizontalTextAlignment property of Label is of type TextAlignment, which is an enu-
meration. For any property that is an enumeration type, the XAML parser uses the Enum. Parse
method to convert from the string to the value.

The verticalOptions property is of type LayoutOptions, a structure. When the XAML parser
references the LayoutOptions structure using reflection, it discovers that the structure has a C# at-
tribute defined:

[TypeConverter (typeof(LayoutOptionsConverter))]
public struct LayoutOptions
{

}

(Watch out! This discussion involves two types of attributes: XML attributes such as HorizontalText-
Alignment and C# attributes such as this TypeConverter.)

The TypeConverter attribute is supported by a class named TypeConverteraAttribute. This par-
ticular TypeConverter attribute on LayoutOptions references a class named LayoutOptionsCon-
verter, which derives from a public abstract class named TypeConverter that defines methods
named CanConvertFrom and ConvertFrom. When the XAML parser encounters this TypeConverter
attribute, it instantiates the LayoutOptionsConverter. The VerticalOptions attribute in the XAML
is assigned the string "Center”, so the XAML parser passes that “Center” string to the ConvertFrom
method of LayoutOptionsConverter, and out pops a LayoutOptions value. This is assigned to the
VerticalOptions property of the Label object.
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Similarly, when the XAML parser encounters the TextColor and BackgroundColor properties, it
uses reflection to determine that those properties are of type Color. The Color structure is also
adorned with a TypeConverter attribute:

[TypeConverter (typeof(ColorTypeConverter))]

public struct Color

{
3

You can create an instance of ColorTypeConverter and experiment with it in code if you'd like. It
accepts color definitions in several formats: It can convert a string like “Blue” to the Color.Blue value,
and the “Default” and “Accent” strings to the Color.Default and Color.Accent values. Color-
TypeConverter can also parse strings that encode red-green-blue values, such as “#FF8080", which is
a red value of OxFF, a green value of 0x80, and a blue value also of 0x80.

All numeric RGB values begin with a number-sign prefix, but that prefix can be followed with eight,
six, four, or three hexadecimal digits for specifying color values with or without an alpha channel.
Here's the most extensive syntax:

BackgroundColor="#aarrggbb"
Each of the letters represents a hexadecimal digit, in the order alpha (opacity), red, green, and blue. For

the alpha channel, keep in mind that OxFF is fully opaque and 0x00 is fully transparent. Here's the syn-
tax without an alpha channel:

BackgroundColor="#rrggbb"
In this case the alpha value is set to OxFF for full opacity.

Two other formats allow you to specify only a single hexadecimal digit for each channel:

BackgroundColor="#argb"
BackgroundColor="#rgb"

In these cases, the digit is repeated to form the value. For example, #CF3 is the RGB color OxCC-0xFF-
0x33. These short formats are rarely used.

The FontSize property of Label is of type double. This is a little different from properties of type
LayoutOptions and Color. The LayoutOptions and Color structures are part of Xamarin.Forms, so
they can be flagged with the C# TypeConverter attribute, but it's not possible to flag the .NET
Double structure with a TypeConverter attribute just for font sizes!

Instead, the Fontsize property within the Labe1l class has the TypeConverter attribute:

public class Label : View, IFontElement

{

[TypeConverter (typeof (FontSizeConverter))]
public double FontSize

{
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3

The FontSizeConverter class determines whether the string passed to it is one of the members of
the NamedsSize enumeration. If not, FontSizeConverter assumes the value is a double.

The last attribute set in the example is FontAttributes. The FontAttributes property is an enu-
meration named FontAttributes, and you already know that the XAML parser handles enumeration
types automatically. However, the FontAttributes enumeration has a C# Flags attribute set like so:
[Flags]

public enum FontAttributes

{
None = 0,
Bold = 1,
Italic = 2
}

The XAML parser therefore allows multiple members separated by commas:

FontAttributes="Bold,Italic"

This demonstration of the mechanical nature of the XAML parser should be very good news. It
means that you can include custom classes in XAML, and these classes can have properties of custom
types, or the properties can be of standard types but allow additional values. All you need is to flag
these types or properties with a C# TypeConverter attribute and provide a class that derives from

TypeConverter.

Property-element syntax

Here is some C# that is similar to the FramedText code in Chapter 4. In one statement it instantiates a
Frame and a Label and sets the Label to the Content property of the Frame:

new Frame

{
OutTineColor = Color.Accent,
HorizontalOptions = LayoutOptions.Center,
VerticalOptions = LayoutOptions.Center,
Content = new Label

{

Text = "Greetings, Xamarin.Forms!"
}
};

But when you start to duplicate this in XAML, you might become a little stymied at the point where
you set the Content attribute:

<Frame OutlineColor="Accent"



Chapter 7 XAML vs. code 137

HorizontalOptions="Center"
VerticalOptions="Center"
Content=" what goes here? " />

How can that Content attribute be set to an entire Label object?

The solution to this problem is the most fundamental feature of XAML syntax. The first step is to
separate the Frame tag into start and end tags:
<Frame OutlineColor="Accent"

HorizontalOptions="Center"
VerticalOptions="Center">

</Frame>

Within those tags, add two more tags that consist of the element (Frame) and the property you want
to set (Content) connected with a period:
<Frame OutlineColor="Accent"

HorizontalOptions="Center"

VerticalOptions="Center">
<Frame.Content>

</Frame.Content>
</Frame>

Now put the Label within those tags:

<Frame OutlineColor="Accent"
HorizontalOptions="Center"
VerticalOptions="Center">
<Frame.Content>
<Label Text="Greetings, Xamarin.Forms!" />
</Frame.Content>
</Frame>

That syntax is how you set a Label to the Content property of the Frame.

You might wonder if this XAML feature violates XML syntax rules. It does not. The period has no
special meaning in XML, so Frame.Content is a perfectly valid XML tag. However, XAML imposes its
own rules about these tags: The Frame.Content tags must appear within Frame tags, and no attrib-
utes can be set in the Frame.Content tag. The object set to the Content property appears as the
XML content of those tags.

Once this syntax is introduced, some terminology becomes necessary. In the final XAML snippet
shown above:

e Frame and Label are C# objects expressed as XML elements. They are called object elements.

[ OutlineColor,HorizontalOptions,VerticalOptions,andTextareC#[NOpeﬂbseX—
pressed as XML attributes. They are called property attributes.
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e Frame.Content is a C# property expressed as an XML element, and it is therefore called a
property element.

Property elements are very common in real-life XAML. You'll see numerous examples in this chapter
and future chapters, and you'll soon find property elements becoming second nature to your use of
XAML. But watch out: Sometimes developers must remember so much that we forget the basics. Even
after you've been using XAML for a while, you'll probably encounter a situation where it doesn’t seem
possible to set a particular object to a particular property. The solution is very often a property
element.

You can also use property-element syntax for simpler properties, for example:

<Frame HorizontalOptions="Center">
<Frame.VerticalOptions>
Center
</Frame.VerticalOptions>
<Frame.OutTineColor>
Accent
</Frame.OutTlineColor>
<Frame.Content>
<Label>
<Label.Text>
Greetings, Xamarin.Forms!
</Label.Text>
</Label>
</Frame.Content>
</Frame>

Now the VerticalOptions and OutlineColor properties of Frame and the Text property of Label
have all become property elements. The value of these attributes is always the content of the property
element without quotation marks.

Of course, it doesn’t make much sense to define these properties as property elements. It's unneces-
sarily verbose. But it works as it should.

Let's go a little further: Instead of setting HorizontalOptions to “Center” (corresponding to the
static property LayoutOptions.Center), you can express HorizontalOptions as a property ele-
ment and set it to a LayoutOptions value with its individual properties set:

<Frame>
<Frame.HorizontalOptions>
<LayoutOptions Alignment="Center"
Expands="False" />
</Frame.HorizontalOptions>
<Frame.VerticalOptions>
Center
</Frame.VerticalOptions>
<Frame.OutTlineColor>
Accent
</Frame.OutTlineColor>
<Frame.Content>
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<Label>
<Label.Text>
Greetings, Xamarin.Forms!
</Label.Text>
</Label>
</Frame.Content>
</Frame>

And you can also express these properties of LayoutOptions as property elements:

<Frame>
<Frame.HorizontalOptions>
<LayoutOptions>
<LayoutOptions.Alignment>
Center
</LayoutOptions.Alignment>
<LayoutOptions.Expands>
False
</LayoutOptions.Expands>
</LayoutOptions>

</Frame.HorizontalOptions>
</Frame>

You can't set the same property as a property attribute and a property element. That's setting the
property twice, and it's not allowed. And remember that nothing else can appear in the property-
element tags. The value being set to the property is always the XML content of those tags.

Now you should know how to use a stackLayout in XAML. First express the Children property as
the property element stackLayout.Children, and then include the children of the stackLayout as
XML content of the property-element tags. Here’s an example where each child of the first StackLay-
out is another StackLayout with a horizontal orientation:

<StackLayout>
<StackLayout.Children>
<StackLayout Orientation="Horizontal">
<StackLayout.Children>
<BoxView Color="Red" />
<Label Text="Red"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>

<StackLayout Orientation="Horizontal">
<StackLayout.Children>
<BoxView Color="Green" />
<Label Text="Green"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>

<StackLayout Orientation="Horizontal">
<StackLayout.Children>
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<BoxView Color="Blue" />
<Label Text="Blue"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>
</StackLayout.Children>
</StackLayout>

Each horizontal stackLayout has a BoxView with a color and a Label with that color name.

Of course, the repetitive markup here looks rather scary! What if you wanted to display 16 colors?
Or 140? You might succeed at first with a lot of copying and pasting, but if you then needed to refine
the visuals a bit, you'd be in bad shape. In code you'd do this in a loop, but XAML has no such feature.

When markup threatens to be overly repetitious, you can always use code. Defining some of a user
interface in XAML and the rest in code is perfectly reasonable. But there are other solutions, as you'll
see in later chapters.

Adding a XAML page to your project

Now that you've seen some snippets of XAML, let’s look at a whole XAML page in the context of a
complete program. First, create a Xamarin.Forms solution named CodePlusXaml using the Portable
Class Library solution template.

Now add a XAML ContentPage to the PCL. Here's how: In Visual Studio, right-click the
CodePlusXaml project in the Solution Explorer. Select Add > New Item from the menu. In the Add
New Item dialog, select Visual C# and Cross-Platform at the left, and Forms Xaml Page from the
central list. Name it CodePlusXamlPage.cs.

In Xamarin Studio, invoke the drop-down menu on the CodePlusXaml project in the Solution list,
and select Add > New File. In the New File dialog, select Forms at the left and Forms ContentPage
Xaml in the central list. (Watch out: There's also a Forms ContentView Xaml in the list. You want a
content page.) Name it CodePlusXamlIPage.

In either case, two files are created:
e  CodePlusXamlPage.xaml, the XAML file; and
e  CodePlusXamlPage.xaml.cs, a C# file (despite the odd double extension on the filename).

In the file list, the second file is indented underneath the first, indicating their close relationship. The C#
file is often referred to as the code-behind of the XAML file. It contains code that supports the markup.
These two files both contribute to a class named CodePlusXamlPage that derives from ContentPage.

Let's examine the code file first. Excluding the using directives, it looks like this:
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namespace CodePlusXaml

{
public partial class CodePlusXamlPage : ContentPage
{
public CodePlusXamlPage()
{
InitializeComponent();
}
}
}

It is indeed a class named CodePlusxamlPage that derives from ContentPage, just as anticipated.
However, the class definition includes a partial keyword, which usually indicates that this is only part
of the CodePlusXamlPage class definition. Somewhere else there should be another partial class defi-
nition for CodePlusxamlPage. So if it exists, where is it? It's a mystery! (For now.)

Another mystery is the InitializeComponent method that the constructor calls. Judging solely
from the syntax, it seems as though this method should be defined or inherited by ContentPpage. Yet
you won't find InitializeComponent in the APl documentation.

Let's set those two mysteries aside temporarily and look at the XAML file. The Visual Studio and
Xamarin Studio templates generate two somewhat different XAML files. If you're using Visual Studio,
delete the markup for the Label and replace it with ContentPage.Content property-element tags
so that it looks like the version in Xamarin Studio:
<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"

xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="CodePlusXaml.CodePlusXamlPage">
<ContentPage.Content>

</ContentPage.Content>
</ContentPage>

The root element is ContentPage, which is the class that CodePlusxamlPage derives from. That tag
begins with two XML namespace declarations, both of which are URIs. But don't bother checking the
web addresses! There's nothing there. These URIs simply indicate who owns the namespace and what
function it serves.

The default namespace belongs to Xamarin. This is the XML namespace for elements in the file with
no prefix, such as the ContentPage tag. The URI includes the year that this namespace came into be-
ing and the word forms as an abbreviation for Xamarin.Forms.

The second namespace is associated with a prefix of x by convention, and it belongs to Microsoft.
This namespace refers to elements and attributes that are intrinsic to XAML and are found in every
XAML implementation. The word winfx refers to a name once used for the .NET Framework 3.0, which
introduced WPF and XAML. The year 2009 refers to a particular XAML specification, which also implies
a particular collection of elements and attributes that build upon the original XAML specification,
which is dated 2006. However, Xamarin.Forms implements only a subset of the elements and attributes
in the 2009 specification.
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The next line is one of the attributes that is intrinsic to XAML, called Class. Because the x prefix is
almost universally used for this namespace, this attribute is commonly referred to as x:Class and pro-
nounced "x class.”

The x:Class attribute can appear only on the root element of a XAML file. It specifies the .NET
namespace and name of a derived class. The base class of this derived class is the root element. In
other words, this x: Class specification indicates that the CodePlusxamlPpage class in the
CodePlusXaml namespace derives from ContentPage. That's exactly the same information as the
CodePlusXamlPage class definition in the CodePlusXamlPage.xaml.cs file.

Let's add some content to this ContentPage in the XAML file. This requires setting something to
the content property, which in the XAML file means putting something between ContentPage.Con-
tent property-element tags. Begin the content with a stackLayout, and then add a Label to the
Children property:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="CodePlusXaml.CodePlusXamlPage">
<ContentPage.Content>
<StackLayout>
<StackLayout.Children>
<Label Text="Hello from XAML!"
IsVisible="True"
Opacity="0.75"
HorizontalTextAlignment="Center"
VerticalOptions="CenterAndExpand"
TextCoTlor="BTlue"
BackgroundColor="#FF8080"
FontSize="Large"
FontAttributes="Bold,Italic" />
</StackLayout.Children>
</StackLayout>
</ContentPage.Content>
</ContentPage>

That's the XAML Label you saw at the beginning of this chapter.

You'll now need to change the rpp class to instantiate this page just like you do with a code-only
derivative of ContentPage:

namespace CodePlusXaml

{

public class App : Application

{
public AppQ
{

MainPage = new CodePlusXamlPage();

}

}
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You can now build and deploy this program. After you do so, it's possible to clear up a couple of
mysteries encountered earlier in this section:

In Visual Studio, in the Solution Explorer, select the CodePlusXaml project, find the icon at the top
with the tooltip Show All Files, and toggle that on.

In Xamarin Studio, in the Solution file list, invoke the drop-down menu for the whole solution, and
select Display Options > Show All Files.

In the CodePlusXaml Portable Class Library project, find the obj folder and within that, the Debug
folder. You'll see a file named CodePlusXamlPage.xaml.g.cs. Notice the g in the filename. That stands
for generated. Here it is, complete with the comment that tells you that this file is generated by a tool:

e
// <auto-generated>

// This code was generated by a tool.

// Runtime Version:4.0.30319.42000

//

// Changes to this file may cause incorrect behavior and will be lost if

// the code is regenerated.

// </auto-generated>

e

namespace CodePlusXaml {
using System;
using Xamarin.Forms;
using Xamarin.Forms.XamT;

public partial class CodePlusXamlPage : global::Xamarin.Forms.ContentPage {

[System.CodeDom.Compiler.GeneratedCodeAttribute("Xamarin.Forms.Build.Tasks.Xam1G",
"0.0.0.0")]
private void InitializeComponent() {
this.LoadFromXaml (typeof (CodePlusXamlPage));
}

During the build process, the XAML file is parsed, and this code file is generated. Notice that it's a
partial class definition of CodeP1usxamlPage, which derives from ContentPage, and the class con-
tains a method named InitializeComponent.

In other words, it's a perfect fit for the CodePlusXamlPage.xaml.cs code-behind file. After the
CodePlusXamlPage.xaml.g.cs file is generated, the two files can be compiled together as if they were
just normal C# partial class definitions.

At run time, the aApp class instantiates the CodeP1lusXamlPage class. The CodePlusXamlPage con-
structor (defined in the code-behind file) calls TnitializeComponent (defined in the generated file),
and InitializeComponent calls LoadFromXaml. This is an extension method for view defined in the
Extensions class in the Xamarin.Forms.Xaml assembly. What LoadFromxaml does depends on
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whether you've chosen to compile the XAML or not (as discussed in the next section). But when the
InitializeComponent method returns, the whole page is in place, just as though everything had
been instantiated and initialized in code in the CodePlusxXamlPage constructor.

It's possible to continue adding content to the page in the constructor of the code-behind file, but
only after the InitializeComponent call returns. Let's take this opportunity to create another Label
by using some code from earlier in this chapter:

namespace CodePlusXaml

{
public partial class CodePlusXamlPage : ContentPage
{
public CodePlusXamlPage()
{
InitializeComponent();
Label Tabel = new Label
{
Text = "Hello from Code!",
IsVisible = true,
Opacity = 0.75,
HorizontalTextAlignment = TextAlignment.Center,
VerticalOptions = LayoutOptions.CenterAndExpand,
TextColor = Color.Blue,
BackgroundColor = Color.FromRgb(255, 128, 128),
FontSize = Device.GetNamedSize(NamedSize.Large, typeof(Label)),
FontAttributes = FontAttributes.Bold | FontAttributes.Italic
1
(Content as StacklLayout).Children.Insert(0, label);
}
}
}

The constructor concludes by accessing the stackLayout that we know is set to the Content
property of the page and inserting the Label at the top. (In the next chapter, you'll see a much better
way to reference objects in the XAML file by using the x:Name attribute.) You can create the Label
prior to the TnitializeComponent call, but you can't add it to the StackLayout at that time be-
cause InitializeComponent is what causes the stackLayout (and all the other XAML elements) to
be instantiated. Here's the result:
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Hello from Code!

Hello from XAML!

Hello from XAML!

Aside from the text, the two buttons are identical.

You don't have to spend much time examining the generated code file that the XAML parser cre-
ates, but it's helpful to understand how the XAML file plays a role both in the build process and during
run time. Also, sometimes an error in the XAML file raises a run-time exception at the LoadFromXaml
call, so you will probably see the generated code file pop up frequently, and you should know what
it is.

The XAML compiler

You have an option whether to compile the XAML during the build process. Compiling the XAML per-
forms validity checks during the build process, reduces the size of the executable, and improves load-
ing time, but it's somewhat newer than the noncompilation approach, so there might be issues
sometimes.

To indicate that you want to compile all the XAML files in your application, you can insert the fol-
lowing assembly attribute somewhere in a code file. The most convenient place is the Assembly.cs file
in the Properties folder of the PCL project:

[assembly: XamlCompilation(XamlCompilationOptions.Compile)]

You can put it in another C# file, but because it's an assembly attribute, it needs to be outside any
namespace block. You'll also need a using directive for xamarin.Forms.Xaml.

You can alternatively specify that the XAML file for a particular class is compiled:
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namespace CodePlusXaml

{
[Xam1Compilation(XamlCompilationOptions.Compile)]
public partial class CodePlusXamlPage : ContentPage
{
public CodePlusXamlPage()
{
InitializeComponent();
}
}
}

The XamlCompilationOptions enumeration has two members, Compile and Skip, which means
that you can use xam1lCompilation as an assembly attribute to enable XAML compilation for all clas-
ses in the project, but skip XAML compilation for individual classes by using the skip member.

When you do not choose to compile the XAML, the entire XAML file is bound into the executable as
an embedded resource, just like the Edgar Allan Poe story in the BlackCat program in Chapter 4. In-
deed, you can get access to the XAML file at run time by using the GetManifestResourceStream
method. That's similar to what the LoadFromxaml call in InitializeComponent does. It loads the
XAML file and parses it for a second time, instantiating and initializing all the elements in the XAML file
except for the root element, which already exists.

When you choose to compile the XAML, this process is streamlined somewhat, but the LoadFrom-
xaml method still needs to instantiate all the elements and build a visual tree.

Platform specificity in the XAML file

Here is the XAML file for a program named ScaryColorList that's similar to a snippet of XAML that you
saw earlier. But now the repetition is even scarier because each color item is surrounded by a Frame:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ScaryColorList.ScaryColorListPage">
<ContentPage.Content>
<StackLayout>
<StackLayout.Children>
<Frame OutlineColor="Accent">
<Frame.Content>
<StackLayout Orientation="Horizontal">
<StackLayout.Children>
<BoxView Color="Red" />
<Label Text="Red"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>
</Frame.Content>
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</Frame>

<Frame OutlineColor="Accent">
<Frame.Content>
<StackLayout Orientation="Horizontal">
<StackLayout.Children>
<BoxView Color="Green" />
<Label Text="Green"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>
</Frame.Content>
</Frame>

<Frame OutlineColor="Accent">
<Frame.Content>
<StackLayout Orientation="Horizontal">
<StackLayout.Children>
<BoxView Color="Blue" />
<Label Text="Blue"
VerticalOptions="Center" />
</StackLayout.Children>
</StackLayout>
</Frame.Content>
</Frame>
</StackLayout.Children>
</StackLayout>
</ContentPage.Content>
</ContentPage>

The code-behind file contains only the standard call to ITnitializeComponent.

Aside from the repetitious markup, this program has a more practical problem: When it runs on iOS,
the top item overlaps the status bar. This problem can be fixed with a call to bevice.0OnPlatformin
the page’s constructor (just as you saw in Chapter 2). Because Device.OnPlatform sets the Padding
property on the page and doesn't require anything in the XAML file, it could go either before or after
the InitializeComponent call. Here's one way to do it:

public partial class ScaryColorListPage : ContentPage

{
public ScaryColorListPage()
{
Padding = Device.OnPlatform(new Thickness(0, 20, 0, 0),
new Thickness(0),
new Thickness(0));
InitializeComponent();
}
}

Or, you could set a uniform padding value for all three platforms right in the root element of the
XAML file:
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<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ScaryColorList.ScaryColorListPage"
Padding="0, 20, 0, 0">
<ContentPage.Content>

</ContentPage.Content>
</ContentPage>

That sets the Padding property for the page. The ThicknessTypeConverter class requires the values
to be separated by commas, but you have the same flexibility as with the Thickness constructor. You
can specify four values in the order left, top, right, and bottom; two values (the first for left and right,
and the second for top and bottom); or one value.

However, you can also specify platform-specific values right in the XAML file by using the onPlat-
form class, whose name suggests that it is similar in function to the Device.oOnPlatform static
method.

OonPlatform is a very interesting class, and it's worthwhile to gain a sense of how it works. The class
is generic, and it has three properties of type T, as well as an implicit conversion of itself to T that
makes use of the Device.0s value:

public class OnPlatform<T>

{
public T i0S { get; set; }

public T Android { get; set; }
public T WinPhone { get; set; }
public static implicit operator T(OnPlatform<T> onPlatform)

{

// returns one of the three properties based on Device.0S

}

In theory, you might use the onPlatform<T> class in code, perhaps like this in the constructor of a
ContentPage derivative:

Padding = new OnPlatform<Thickness>

{
i0S = new Thickness(0, 20, 0, 0),
Android = new Thickness(0),
WinPhone = new Thickness(0)

};

You can set an instance of this onplatform class directly to the Padding property because the on-
Platform class defines an implicit conversion of itself to the generic argument (in this case

Thickness).
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However, you shouldn't use OnPlatform in code. Use Device.OnPlatform instead. OnPlatform
is designed for XAML, and the only really tricky part is figuring out how to specify the generic type
argument.

Fortunately, the XAML 2009 specification includes an attribute designed specifically for generic clas-
ses, called TypeArguments. Because it's part of XAML itself, it's used with an x prefix, so it appears as
x:TypeArguments. Here's how OnPlatform is used in XAML to select among three Thickness
values:
<OnPlatform x:TypeArguments="Thickness"

i0s="0, 20, 0, 0"

Android="0"
WinPhone="0" />

In this example (and in the previous code example), the Android and WinPhone settings aren't re-
quired because they are the defaults. Notice that the Thickness strings can be set directly to the
properties because those properties are of type Thickness, and hence the XAML parser will use the
ThicknessTypeConverter for converting those strings.

Now that we have the onPlatform markup, how do we set it to the Padding property of the
Page? By expressing Padding using property-element syntax, of course!

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ScaryColorList.ScaryColorListPage">

<ContentPage.Padding>
<OnPlatform x:TypeArguments="Thickness
i0s="0, 20, 0, 0" />
</ContentPage.Padding>

<ContentPage.Content>

</ContentPage.Content>
</ContentPage>

This is how the ScaryColorList program appears in the collection of samples from this book and here’s
how it looks:
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Similar to onDevice, OnIdiom distinguishes between Phone and Tablet. For reasons that will be-
come apparent in the next chapter, you should try to restrict the use of OnDevice and onIdiom to

small chunks of markup rather than large blocks. Their use shouldn’t become a structural element in
your XAML files.

The content property attribute

The XAML file in the ScaryColorList program is actually somewhat longer than it needs to be. You can
delete the ContentPage.Content tags, all the stackLayout.Children tags, and all the
Frame.Content tags, and the program will work the same:

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ScaryColorList.ScaryColorListPage">

<ContentPage.Padding>
<OnPlatform x:TypeArguments="Thickness"
i0S="0, 20, 0, 0" />
</ContentPage.Padding>

<StackLayout>
<Frame OutlineColor="Accent">
<StackLayout Orientation="Horizontal">
<BoxView Color="Red" />
<Label Text="Red"
VerticalOptions="Center" />
</StackLayout>
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</Frame>

<Frame OutlineColor="Accent">
<StackLayout Orientation="Horizontal">
<BoxView Color="Green" />
<Label Text="Green"
VerticalOptions="Center" />
</StackLayout>
</Frame>

<Frame OutlineColor="Accent">
<StackLayout Orientation="Horizontal">
<BoxView Color="Blue" />
<Label Text="Blue"
VerticalOptions="Center" />
</StackLayout>
</Frame>
</StackLayout>
</ContentPage>

It looks a lot cleaner now. The only property element left is for the Padding property of ContentPpage.

As with almost everything about XAML syntax, this elimination of some property elements is sup-
ported by the underlying classes. Every class used in XAML is allowed to define one property as a con-
tent property (sometimes also called the class’s default property). For this content property, the prop-
erty-element tags are not required, and any XML content within the start and end tags is automatically
assigned to this property. Very conveniently, the content property of ContentPage is Content, the
content property of StackLayout is Children, and the content property of Frame is Content.

These content properties are documented, but you need to know where to look. A class specifies its
content property by using the ContentPropertyaAttribute. If this attribute is attached to a class, it
appears in the online Xamarin.Forms APl documentation along with the class declaration. Here’s how it
appears in the documentation for Contentpage:

[Xamarin.Forms.ContentProperty("Content")]
public class ContentPage : TemplatedPage

If you say it aloud, it sounds a bit redundant: The Content property is the content property of
ContentPage.

The declaration for the Frame class is similar:

[Xamarin.Forms.ContentProperty("Content")]
public class Frame : ContentView

StackLayout doesn't have a ContentProperty attribute applied, but stackLayout derives from
Layout<View>, and Layout<T> has a ContentProperty attribute:
[Xamarin.Forms.ContentProperty("Children")]

public abstract class Layout<T> : Layout, IViewContainer<T>
where T : View


http://iosapi.xamarin.com/monodoc.ashx?link=T%3aXamarin.Forms.Layout
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The ContentProperty attribute is inherited by the classes that derive from Layout<T>, so Children
is the content property of stackLayout.

Certainly, there's no problem if you include the property elements when they're not required, but in
most cases they will no longer appear in the sample programs in this book.

Formatted text

Text displayed by a XAML file might involve just a word or two, but sometimes an entire paragraph is
required, perhaps with some embedded character formatting. Specifying character formatting is not
always as obvious, or as easy, in XAML as might be suggested by our familiarity with HTML.

The TextVariations solution has a XAML file that contains seven Label views in a scrollable
StackLayout:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="TextVariations.TextVariationsPage">

<ContentPage.Padding>
<OnPlatform x:TypeArguments="Thickness"
i0S="0, 20, 0, 0" />
</ContentPage.Padding>

<Scrol1View>
<StackLayout>

</StackLayout>
</Scrol1View>
</ContentPage>

Each of the seven Label views shows a somewhat different way of defining the displayed text. For ref-
erence purposes, here's the program running on all three platforms:
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The simplest approach involves just setting a few words to the Text attribute of the Label element:

<Label VerticalOptions="CenterAndExpand"
Text="Single Tines of text are easy." />

You can also set the Text property by breaking it out as a property element:

<Label VerticalOptions="CenterAndExpand">
<Label.Text>
Text can also be content of the Text property.
</Label.Text>
</Label>

Text is the content property of Label, so you don't need the Label.Text tags:

<Label VerticalOptions="CenterAndExpand">
Text is the content property of Label.
</Label>

When you set text as the content of the Label (whether you use the Label . Text tags or not), the text
is trimmed: all white space, including carriage returns, is removed from the beginning and end of the
text. However, all embedded white space is retained, including end-of-line characters.

When you set the Text property as a property attribute, all white space within the quotation marks
is retained, but if the text occupies more than one line in the XAML file, each end-of-line character (or
character sequence) is converted to a single space.

As a result, displaying a whole paragraph of uniformly formatted text is somewhat problematic. The
most foolproof approach is setting Text as a property attribute. You can put the whole paragraph as a
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single line in the XAML file, but if you prefer to use multiple lines, you should left justify the whole par-
agraph in the XAML file surrounded by quotation marks, like so:

<Label VerticalOptions="CenterAndExpand"
Text=
"Perhaps the best way to define a paragraph of
uniformly formatted text is by setting the Text
property as an attribute and left justifying
the block of text in the XAML file. End-of-Tine
characters are converted to a space character." />

The end-of-line characters are converted to space characters so the individual lines are properly con-
catenated. But watch out: Don't leave any stray characters at the end or beginning of the individual
lines. Those will show up as extraneous characters within the paragraph.

When multiple lines of text are specified as content of the Labe1, only white space at the beginning
and end of the text is timmed. All embedded white space is retained, including end-of-line characters:

<Label VerticalOptions="CenterAndExpand">
Text as content has the curse
Of breaks at each 1ine's close.
That's a format great for verse
But not the best for prose.
</Label>

This text is rendered as four separate lines. If you're displaying lists or poetry in your Xamarin.Forms
application, that's exactly what you want. Otherwise, probably not.

If your line or paragraph of text requires some nonuniform paragraph formatting, you'll want to use
the FormattedText property of Label. As you might recall, you set this to a FormattedString ob-
ject and then set multiple Span objects to the Spans collection of the Formattedstring. In XAML,
you need property-element tags for Label.FormattedString, but Spans is the content property of
FormattedString:

<Label VerticalOptions="CenterAndExpand">
<Label.FormattedText>
<FormattedString>
<Span Text="A single line with " />
<Span Text="bold" FontAttributes="Bold" />
<Span Text=" and " />
<Span Text="italic" FontAttributes="Italic" />
<Span Text=" and " />
<Span Text="1large" FontSize="Large" />
<Span Text=" text." />
</FormattedString>
</Label.FormattedText>
</Label>

Notice that the Text properties of the nonformatted items have spaces at the end or beginning of the
text string, or both, so that the items don’t run into each other.
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In the general case, however, you might be working with an entire paragraph. You can set the Text
attribute of span to a long line, or you can wrap it on multiple lines. As with Label, keep the entire

block left justified in the XAML file:

<Label VerticalOptions="CenterAndExpand">
<Label.FormattedText>
<FormattedString>
<Span Text=
"A paragraph of formatted text requires left justifying
it within the XAML file. But the text can include multiple
kinds of character formatting, including " />
<Span Text="bold" FontAttributes="Bold" />
<Span Text=" and " />
<Span Text="italic" FontAttributes="Italic"
<Span Text=" and " />
<Span Text="Targe" FontSize="Large" />
<Span Text=
and whatever combinations you might desire to adorn
your glorious prose." />
</FormattedString>
</Label.FormattedText>
</Label>

/>

You'll notice in the screenshot that the text with the large font size is aligned with the regular text on
the baseline, which is the typographically proper approach, and the line spacing is adjusted to accom-

modate the larger text.

In most Xamarin.Forms programs, neither XAML nor code exist in isolation but work together. Ele-
ments in XAML can trigger events handled in code, and code can modify elements in XAML. In the

next chapter you'll see how this works.
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Code and XAML in harmony

A code file and a XAML file always exist as a pair. The two files complement each other. Despite being
referred to as the “code-behind” file to the XAML, very often the code is prominent in taking on the
more active and interactive parts of the application. This implies that the code-behind file must be able
to refer to elements defined in XAML with as much ease as objects instantiated in code. Likewise, ele-
ments in XAML must be able to fire events that are handled in code-based event handlers. That's what
this chapter is all about.

But first, let’s explore a couple of unusual techniques for instantiating objects in a XAML file.

Passing arguments

When you run an application containing a XAML file, each element in the XAML file is instantiated with
a call to the parameterless constructor of the corresponding class or structure. The load process contin-
ues with initialization of the resultant object by setting properties from attribute values. This seems rea-
sonable. However, developers using XAML sometimes have a need to instantiate objects with construc-
tors that require arguments or by calling a static creation method. These needs usually don't involve
the APl itself, but instead involve external data classes referenced by the XAML file that interact with
the API.

The 2009 XAML specification introduced an x:Arguments element and an x:FactoryMethod at-
tribute for these cases, and Xamarin.Forms supports them. These techniques are not often used in ordi-
nary circumstances, but you should see how they work in case the need arises.

Constructors with arguments

To pass arguments to a constructor of an element in XAML, the element must be separated into start
and end tags. Follow the start tag of the element with x: Arguments start and end tags. Within those
x:Arguments tags, include one or more constructor arguments.

But how do you specify multiple arguments of common types, such as double or int? Do you sep-
arate the arguments with commas?

No. Each argument must be delimited with start and end tags. Fortunately, the XAML 2009 specifi-
cation defines XML elements for common basic types. You can use these tags to clarify the types of el-
ements, to specify generic types in onPlatform, or to delimit constructor arguments. Here's the com-
plete set supported by Xamarin.Forms. Notice that they duplicate the .NET type names rather than the
C# type names:
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. X
. X
. X
. X
. X
. X
. X
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. X
. X
. X
. X
. X

o X

You'll be

The ParameteredConstructorDemo sample demonstrates the use of x: Arguments with argu-

:Object
:Boolean
:Byte
:Intlé6
:Int32
:Int64
:Single
:Double
:Decimal
:Char
:String
:TimeSpan

:Array

:DateTime (supported by Xamarin.Forms but not the XAML 2009 specification)
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hard-pressed to find a use for all of these, but you'll certainly discover uses for some of them.

ments delimited by x: Double tags using three different constructors of the Color structure. The con-
structor with three parameters requires red, green, and blue values ranging from 0 to 1. The construc-
tor with four parameters adds an alpha channel as the fourth parameter (which is set here to 0.5), and

the constructor with a single parameter indicates a gray shade from 0 (black) to 1 (white):

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ParameteredConstructorDemo.ParameteredConstructorDemoPage">

<StackLayout>

<BoxView WidthRequest="100"

HeightRequest="100"

HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">

<BoxView.Color>
<Color>
<x:Arguments>

<x:Double>1</x:Double>

<x:Double>0</x:Double>

<x:DoubTe>0</x:DoubTle>
</Xx:Arguments>

</Color>
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</BoxView.Color>
</BoxView>

<BoxView WidthRequest="100"
HeightRequest="100"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">
<BoxView.Color>
<Color>
<x:Arguments>
<x:DoubTe>0</x:DoubTle>
<x:Double>0</x:Double>
<x:Double>1</x:Double>
<x:DoubTe>0.5</x:Double>
</x:Arguments>
</Color>
</BoxView.Color>
</BoxView>

<BoxView WidthRequest="100"
HeightRequest="100"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">
<BoxView.Color>
<Color>
<x:Arguments>
<x:DoubTe>0.5</x:Double>
</x:Arguments>
</Color>
</BoxView.Color>
</BoxView>
</StackLayout>
</ContentPage>

The number of elements within the x : Arguments tags, and the types of these elements, must match
one of the constructors of the class or structure. Here's the result:
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The blue Boxview is light against the light background and dark against the dark background because
it's 50 percent transparent and lets the background show through.

Can | call methods from XAML?

At one time, the answer to this question was "Don't be ridiculous,” but now it's a qualified “Yes.” Don't
get too excited, though. The only methods you can call in XAML are those that return objects (or val-
ues) of the same type as the class (or structure) that defines the method. These methods must be pub-
lic and static. They are sometimes called creation methods or factory methods. You can instantiate an
element in XAML through a call to one of these methods by specifying the method’s name using the
x:FactoryMethod attribute and its arguments using the x: Arguments element.

The color structure defines seven static methods that return Color values, so these qualify. This
XAML file makes use of three of them:

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="FactoryMethodDemo.FactoryMethodDemoPage">

<StackLayout>
<BoxView WidthRequest="100"
HeightRequest="100"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">
<BoxView.Color>
<Color x:FactoryMethod="FromRgbh">
<x:Arguments>
<x:Int32>255</x:Int32>
<x:Int32>0</x:Int32>
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<x:Int32>0</x:Int32>
</x:Arguments>
</Color>
</BoxView.Color>
</BoxView>

<BoxView WidthRequest="100"
HeightRequest="100"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">
<BoxView.Color>
<Color x:FactoryMethod="FromRgb">
<x:Arguments>
<x:DoubTe>0</x:DoubTle>
<x:DoubTe>1.0</x:Double>
<x:DoubTe>0</x:DoubTle>
</x:Arguments>
</Color>
</BoxView.Color>
</BoxView>

<BoxView WidthRequest="100"
HeightRequest="100"
HorizontalOptions="Center"
VerticalOptions="CenterAndExpand">
<BoxView.Color>
<Color x:FactoryMethod="FromHsla">
<x:Arguments>
<x:DoubTe>0.67</x:Double>
<x:DoubTe>1.0</x:Double>
<x:DoubTe>0.5</x:Double>
<x:Double>1.0</x:Double>
</Xx:Arguments>
</Color>
</BoxView.Color>
</BoxView>
</StackLayout>
</ContentPage>

The first two static methods invoked here are both named Color.FromRrgb, but the types of ele-
ments within the x: Arguments tags distinguish between int arguments that range from 0 to 255 and
double arguments that range from 0 to 1. The third one is the Color.FromHsla method, which cre-
ates a Color value from hue, saturation, luminosity, and alpha components. Interestingly, this is the
only way to define a Color value from HSL values in a XAML file by using the Xamarin.Forms API.
Here's the result:
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The x:Name attribute

In most real applications, the code-behind file needs to reference elements defined in the XAML file.
You saw one way to do this in the CodePlusXaml program in the previous chapter: If the code-behind
file has knowledge of the layout of the visual tree defined in the XAML file, it can start from the root
element (the page itself) and locate specific elements within the tree. This process is called "walking the
tree” and can be useful for locating particular elements on a page.

Generally, a better approach is to give elements in the XAML file a name similar to a variable name.
To do this you use an attribute that is intrinsic to XAML, called Name. Because the prefix x is almost uni-
versally used for attributes intrinsic to XAML, this Name attribute is commonly referred to as x: Name.

The XamlClock project demonstrates the use of x : Name. Here is the XamlIClockPage.xaml file con-
taining two Label controls, named timeLabel and dateLabel:

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="Xam1Clock.Xam1ClockPage">
<StackLayout>
<Label x:Name="timeLabel"

FontSize="Large"
HorizontalOptions="Center"
VerticalOptions="EndAndExpand" />

<Label x:Name="datelLabel"
HorizontalOptions="Center"
VerticalOptions="StartAndExpand" />
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</StackLayout>
</ContentPage>

The rules for x: Name are the same as for C# variable names. (You'll see why shortly.) The name must
begin with a letter or an underscore and can contain only letters, underscores, and numbers.

Like the clock program in Chapter 5, XamlClock uses Device.StartTimer to fire a periodic event
for updating the time and date. Here’s the xam1ClockPage code-behind file:

namespace Xaml1Clock

{
public partial class XamlClockPage
{
public Xam1ClockPage()
{
InitializeComponent();
Device.StartTimer(TimeSpan.FromSeconds(1), OnTimerTick);
}
bool OnTimerTick()
{
DateTime dt = DateTime.Now;
timelLabel.Text = dt.ToString("T");
datelabel.Text = dt.ToString("D");
return true;
}
}
}

This timer callback method is called once per second. The method must return true to continue the
timer. If it returns false, the timer stops and must be restarted with another call to Device.Start-

Timer.

The callback method references timeLabel and dateLabel as though they were normal variables
and sets the Text properties of each:
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12:48 PM

12:51:42 PM

12:48:01 PM

Friday, January 22, 2016

Friday, January 22, 2016

This is not a visually impressive clock, but it's definitely functional.

How is it that the code-behind file can reference the elements identified with x:Name? Is it magic?
Of course not. The mechanism is very evident when you examine the XamlIClockPage.xaml.g.cs file that
the XAML parser generates from the XAML file as the project is being built:

ettt
// <auto-generated>

// This code was generated by a tool.

// Runtime Version:4.0.30319.42000

//

// Changes to this file may cause incorrect behavior and will be lost if

// the code 1is regenerated.

// </auto-generated>
ettt

namespace Xam1Clock {
using System;
using Xamarin.Forms;
using Xamarin.Forms.XamT;

public partial class XamlClockPage : global::Xamarin.Forms.ContentPage {

[System.CodeDom.Compiler.GeneratedCodeAttribute("Xamarin.Forms.Build.Tasks.Xam1G",
"0.0.0.0")]
private global::Xamarin.Forms.Label timelLabel;

[System.CodeDom.Compiler.GeneratedCodeAttribute("Xamarin.Forms.Build.Tasks.Xam1G",
"0.0.0.0")]
private global::Xamarin.Forms.Label datelLabel;
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[System.CodeDom.Compiler.GeneratedCodeAttribute("Xamarin.Forms.Build.Tasks.Xam1G",
"0.0.0.0")]
private void InitializeComponent() {
this.LoadFromXaml (typeof (Xam1ClockPage));
timelLabel = this.FindByName<global::Xamarin.Forms.Label>("timeLabel™);
datelLabel this.FindByName<global::Xamarin.Forms.Label>("dateLabel");

}

It might be a little hard to see because of the attributes and fully qualified types, but as the build-time
XAML parser chews through the XAML file, every x: Name attribute becomes a private field in this gen-
erated code file. This allows code in the code-behind file to reference these names as though they were
normal fields—which they definitely are. However, the fields are initially nul1. Only when Initial-
izeComponent is called at run time are the two fields set via the FindByName method, which is de-
fined in the NameScopeExtensions class. If the constructor of your code-behind file tries to reference
these two fields prior to the InitializeComponent call, they will have null values.

This generated code file also implies another rule for x: Name values that is now very obvious but
rarely stated explicitly: the names cannot duplicate names of fields or properties defined in the code-
behind file.

Because these are private fields, they can be accessed only from the code-behind file and not from
other classes. If a ContentPage derivative needs to expose public fields or properties to other classes,
you must define those yourself.

Obviously, x:Name values must be unique within a XAML page. This can sometimes be a problem if
you're using onPlatform for platform-specific elements in the XAML file. For example, here's a XAML
file that expresses the 10S, Android, and WinPhone properties of OnPlatform as property elements
to select one of three Label views:

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatformSpecificLabels.PlatformSpecificLabelsPage">

<OnPTatform x:TypeArguments="View">
<OnPlatform.i0S>
<Label Text="This is an i0S device"
HorizontalOptions="Center"
VerticalOptions="Center" />
</0nPlatform.i0S>

<OnPlatform.Android>
<Label Text="This is an Android device"
HorizontalOptions="Center"
VerticalOptions="Center" />
</0nPlatform.Android>

<0OnPlatform.WinPhone>
<Label Text="This is an Windows device"
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HorizontalOptions="Center"
VerticalOptions="Center" />
</0OnPlatform.WinPhone>
</0OnPlatform>
</ContentPage>

The x:TypeArguments attribute of onPlatform must match the type of the target property exactly.
This onPlatform element is implicitly being set to the Content property of ContentPage, and this
Content property is of type View, so the x: TypeArguments attribute of OnPlatform must specify
View. However, the properties of onPlatform can be set to any class that derives from that type. The
objects set to the 10S, Android, and WinPhone properties can in fact be different types just as long as
they all derive from view.

Although that XAML file works, it's not exactly optimum. All three Label views are instantiated and
initialized, but only one is set to the Content property of the ContentPage. The problem with this
approach arises if you need to refer to the Label from the code-behind file and you give each of them
the same name, like so:

The following XAML file does not work!

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatformSpecificLabels.PlatformSpecificLabelsPage">

<OnPTatform x:TypeArguments="View">
<OnPlatform.i0S>
<Label x:Name="devicelLabel"
Text="This is an i0S device"
HorizontalOptions="Center"
VerticalOptions="Center" />
</0nPlatform.i0S>

<OnPTatform.Android>
<Label x:Name="devicelLabel"
Text="This is an Android device"
HorizontalOptions="Center"
VerticalOptions="Center" />
</0OnPlatform.Android>

<OnPTatform.WinPhone>
<Label x:Name="devicelLabel"

Text="This is a Windows device"
HorizontalOptions="Center"
VerticalOptions="Center" />

</0nPlatform.WinPhone>

</0OnPlatform>
</ContentPage>

This will not work because multiple elements cannot have the same name.

You could give them different names and handle the three names in the code-behind file by using
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Device.OnPlatform, but a better solution is to keep the platform-specific markup as small as possi-
ble. In this example, all the Label properties are the same except for Text, so only the Text property
needs to be platform specific. Here's the version of the PlatformSpecificLabels program that is in-
cluded with the sample code for this chapter. It has a single Labe1, and everything is platform inde-
pendent except for the Text property:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatformSpecificLabels.PlatformSpecificLabelsPage">

<Label x:Name="devicelLabel"
HorizontalOptions="Center"
VerticalOptions="Center">
<Label.Text>

<OnPlatform x:TypeArguments="x:String"
i0S="This is an i0S device"
Android="This 1is an Android device
WinPhone="This is a Windows device" />

</Label.Text>
</Label>
</ContentPage>

Here's what it looks like:

This is an i0S device This is a Windows device

The Text property is the content property for Labe1l, so you don't need the Label.Text tags in
the previous example. This works as well:
<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"

xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatformSpecificLabels.PlatformSpecificLabelsPage">
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<Label x:Name="devicelLabel"
HorizontalOptions="Center"
VerticalOptions="Center">
<OnPlatform x:TypeArguments="x:String"
i0S="This 1is an i0S device"
Android="This is an Android device"
WinPhone="This is a Windows device" />
</Label>
</ContentPage>

Custom XAML-based views

The ScaryColorList program in the previous chapter listed a few colors in a StackLayout using
Frame, BoxView, and Label. Even with just three colors, the repetitive markup was starting to look
very ominous. Unfortunately there is no XAML markup that duplicates the C# for and while loops, so
your choice is to use code for generating multiple similar items, or to find a better way to do it in
markup.

In this book, you'll see several ways to list colors in XAML, and eventually, a very clean and elegant
way to do this job will become clear. But that requires a few more steps into learning Xamarin.Forms.
Until then, we'll be looking at some other approaches that you might find useful in similar circum-
stances.

One strategy is to create a custom view that has the sole purpose of displaying a color with a name
and a colored box. And while we're at it, let's display the hexadecimal RGB values of the colors as well.
You can then use that custom view in a XAML page file for the individual colors.

What might a reference to such a custom view look like in XAML?
Or the better question is: How would you like it to look?

If the markup looked something like this, the repetition is not bad at all, and not so much worse
than explicitly defining an array of color values in code:
<StackLayout>
<MyColorView Color="Red" />

<MyColorView Color="Green" />
<MyColorView Color="Blue" />

</StackLayout>

Well, actually, it won't look exactly like that. MyColorview is obviously a custom class and not part of
the Xamarin.Forms API. Therefore, it cannot appear in the XAML file without a namespace prefix that is
defined in an XML namespace declaration.

With this XML prefix applied, there won't be any confusion about this custom view being part of the
Xamarin.Forms API, so let's give it a more dignified name of Colorview rather than MyColorview.
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This hypothetical Colorview class is an example of a fairly easy custom view because it consists
solely of existing views—specifically Label, Frame, and BoxView—arranged in a particular way using
StackLayout. Xamarin.Forms defines a view designed specifically for the purpose of parenting such
an arrangement of views, and it's called Contentview. Like ContentPage, ContentView has a Con-
tent property that you can set to a visual tree of other views. You can define the contents of the Con-
tentView in code, but it's more fun to do it in XAML.

Let's put together a solution named ColorViewList. This solution will have two sets of XAML and
code-behind files, the first for a class named ColorviewListPage, which derives from ContentPage
(as usual), and the second for a class named Colorview, which derives from Contentview.

To create the Colorview class in Visual Studio, use the same procedure as when adding a new
XAML page to the ColorViewList project: Right-click the project name in the Solution Explorer, and
select Add > New Item from the context menu. In the Add New Item dialog, select Visual C# >
Cross-Platform at the left and then Forms Xaml Page. Enter the name ColorView.cs. But right away,
before you forget, go into the ColorView.xaml file and change the ContentPage start and end tags to
ContentView. In the ColorView.xaml.cs file, change the base class to Contentview.

The process is a little easier in Xamarin Studio. From the tool menu for the ColorViewlList project,
select Add > New File. In the New File dialog, select Forms at the left and Forms ContentView Xaml
(not Forms ContentPage Xaml). Give it a name of ColorView.

You'll also need to create a XAML file and code-behind file for the ColorviewListPage class, as
usual.

The ColorView.xaml file describes the layout of the individual color items but without any actual
color values. Instead, the Boxview and two Label views are given names:

<ContentView xmIns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="ColorViewList.ColorView">

<Frame OutlineColor="Accent">
<StackLayout Orientation="Horizontal">
<BoxView x:Name="boxView"
WidthRequest="70"
HeightRequest="70" />

<StackLayout>
<Label x:Name="colorNamelLabel"
FontSize="Large"
VerticalOptions="CenterAndExpand" />

<Label x:Name="colorValuelLabel"
VerticalOptions="CenterAndExpand" />
</StackLayout>
</StackLayout>
</Frame>
</ContentView>
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In a real-life program, you'll have plenty of time later to fine-tune the visuals. Initially, you'll just want
to get all the named views in there.

Besides the visuals, this Colorview class will need a new property to set the color. This property
must be defined in the code-behind file. At first, it seems reasonable to give Colorview a property
named Color of type Color (as the earlier XAML snippet with MyColorview seems to suggest). But
the Colorview class needs to display the color name, and it can't get the color name from a Color
value.

Instead, it makes more sense to define a property named ColorName of type string. The code-
behind file can then use reflection to obtain the static field of the Color class corresponding to that
name.

But wait: Xamarin.Forms includes a public ColorTypeConverter class that the XAML parser uses to
convert a text color name like "Red” or "Blue” into a Color value. Why not take advantage of that?

Here's the code-behind file for Colorview. It defines a ColorName property with a set accessor
that sets the Text property of the colorNameLabel to the color name, and then uses ColorType-
Converter to convert the name to a Color value. This Color value is then used to set the color
property of boxView and the Text property of the colorvalueLabel to the RGB values:

public partial class ColorView : ContentView

{
string colorName;
ColorTypeConverter colorTypeConv = new ColorTypeConverter();

public ColorView(Q)

{
InitializeComponent();
}
public string ColorName
{
set
{
// Set the name.
colorName = value;
colorNameLabel.Text = value;
// Get the actual Color and set the other views.
Color color = (Color)colorTypeConv.ConvertFrom(colorName);
boxView.Color = color;
colorValuelLabel.Text = String.Format("{0:X2}-{1:X2}-{2:X2}",
(int) (255 * color.R),
(int) (255 * color.G),
(int) (255 * color.B));
get
{

return colorName;
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The Colorview class is finished. Now let's look at ColorviewListPage. The ColorViewList-
Page.xaml file must list multiple colorview instances, so it needs a new XML namespace declaration
with a new namespace prefix to reference the Colorview element.

The Colorview class is part of the same project as ColorviewListPage. Generally, programmers
use an XML namespace prefix of 1ocal for such cases. The new namespace declaration appears in the
root element of the XAML file (like the other two) with the following format:

xmlns:local="clr-namespace:ColorViewList;assembly=ColorViewList"

In the general case, a custom XML namespace declaration for XAML must specify a common language
runtime (CLR) namespace—also known as the .NET namespace—and an assembly. The keywords to
specify these are clr-namespace and assembly. Often the CLR namespace is the same as the assem-
bly, as they are in this case, but they don't need to be. The two parts are connected by a semicolon.

Notice that a colon follows c1r-namespace, but an equal sign follows assembly. This apparent
inconsistency is deliberate: the format of the namespace declaration is intended to mimic a URI found
in conventional namespace declarations, in which a colon follows the URI scheme name.

You use the same syntax for referencing objects in external portable class libraries. The only differ-
ence in those cases is that the project also needs a reference to that external PCL. (You'll see an exam-
ple in Chapter 10, “XAML markup extensions.”).

The local prefix is common for code in the same assembly, and in that case the assembly part is
not required:

xmIns:local="clr-namespace:ColorViewList"

For a XAML file in a PCL, you can include the assembly part to reference something in the same as-
sembly if you want but it's not necessary. For a XAML file in an SAP, however, you must not include the
assembly part to reference a local class because there is no assembly associated with an SAP. The
code in the SAP is actually part of the individual platform assemblies, and those all have different
names.

Here's the XAML for the ColorviewListPage class. The code-behind file contains nothing beyond
the InitializeComponent call:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
xmlns:local="clr-namespace:ColorViewList"
x:Class="ColorViewList.ColorViewListPage">

<ContentPage.Padding>
<OnPlatform x:TypeArguments="Thickness"
i0s="0, 20, 0, 0" />
</ContentPage.Padding>
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<Scrol1View>

<StackLayout Padding="6, 0">

<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local
<local

:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView
:ColorView

</StackLayout>

</Scrol1View>
</ContentPage>

ColorName="Aqua" />
ColorName="BTlack" />
ColorName="BTlue" />
ColorName="Fuchsia" />
ColorName="Gray" />
ColorName="Green" />
ColorName="Lime" />
ColorName="Maroon" />
ColorName="Navy" />
ColorName="0Tive" />
ColorName="Purple" />
ColorName="Pink" />
ColorName="Red" />
ColorName="Silver" />
ColorName="Teal" />
ColorName="White" />
ColorName="Yellow" />
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This is not quite as odious as the earlier example seemed to suggest, and it demonstrates how you can

encapsulate visuals in their own XAML-based classes. Notice that the stackLayout is the child of a

ScrollView, so the list can be scrolled:

10610 AM

Agua

DO-FF-FF

Fuchsia

FF-00-FF

4% @02

Lime

00-FF-00

Maroon

Pink

FF-66-FF

Red

FF-00-00

Silver
Co-co-co

Teal

00-80-80

However, there is one aspect of the ColorViewList project that does not qualify as a “best practice.” It
is the definition of the ColorName property in Colorview. This should really be implemented as a
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BindableProperty object. Delving into bindable objects and bindable properties is a high priority
and will be explored in Chapter 11, “The bindable infrastructure.”

Events and handlers

When you tap a Xamarin.Forms Button, it fires a C1icked event. You can instantiate a Button in
XAML, but the c1icked event handler itself must reside in the code-behind file. The Button is only
one of a bunch of views that exist primarily to generate events, so the process of handling events is
crucial to coordinating XAML and code files.

Attaching an event handler to an event in XAML is as simple as setting a property; it is, in fact, visu-
ally indistinguishable from a property setting. The XamlKeypad project is a XAML version of the Per-
sistentKeypad project from Chapter 6. It illustrates setting event handlers in XAML and handling these
events in the code-behind file. It also includes logic to save keypad entries when the program is termi-
nated.

If you take a look back at the constructor code of the SimplestKeypadPage Or PersistentKey-
padPage classes, you'll see a couple of loops to create the buttons that make up the numeric part of
the keypad. Of course, this is precisely the type of thing you can’t do in XAML, but look at how much
cleaner the markup in Xam1KeypadPage is when compared with that code:

<ContentPage xmIns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="XamlKeypad.Xam1KeypadPage">

<StackLayout VerticalOptions="Center"
HorizontalOptions="Center">

<Label x:Name="displayLabel"
Font="Large"
VerticalOptions="Center"
HorizontalTextAlignment="End" />

<Button x:Name="backspaceButton"
Text="&#x21E6;"
Font="Large"
IsEnabled="False"
Clicked="0OnBackspaceButtonClicked" />

<StackLayout Orientation="Horizontal">
<Button Text="7" StyleId="7" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="8" StyleId="8" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="9" StyleId="9" Font="Large"
Clicked="0OnDigitButtonClicked" />
</StackLayout>



Chapter 8 Code and XAML in harmony

<StackLayout Orientation="Horizontal">
<Button Text="4" StyleId="4" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="5" StyleId="5" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="6" StyleIld="6" Font="Large"
Clicked="0OnDigitButtonClicked" />
</StackLayout>

<StackLayout Orientation="Horizontal">
<Button Text="1" StyleId="1" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="2" StyleId="2" Font="Large"
Clicked="0OnDigitButtonClicked" />
<Button Text="3" StyleId="3" Font="Large"
Clicked="0OnDigitButtonClicked" />
</StackLayout>

<Button Text="0" StyleId="0" Font="Large"
Clicked="0OnDigitButtonClicked" />

</StackLayout>
</ContentPage>

The file is a lot shorter than it would have been had the three properties on each numeric Button
been formatted into three lines, but packing these all together makes the uniformity of the markup
very obvious and provides clarity rather than obscurity.
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The big question is this: Which would you rather maintain and modify? The code in the Simplest-
KeypadPage Of PersistentKeypadPage constructors or the markup in the Xaml1KeypadpPage XAML

file?

Here's the screenshot. You'll see that these keys are now arranged in calculator order rather than

telephone order:
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The backspace button has its C1icked event set to the OnBackspaceButtonClicked handler,
while the digit buttons share the onDigitButtonClicked handler. As you'll recall, the style1d prop-
erty is often used to distinguish views sharing the same event handler, which means that the two event
handlers can be implemented in the code-behind file exactly the same as in the code-only program:

public partial class XamlKeypadPage

{
App app = Application.Current as App;

public XamTKeypadPage()

{
InitializeComponent();
displayLabel.Text = app.DisplaylLabelText;
backspaceButton.IsEnabled = displaylLabel.Text != null &&
displayLabel.Text.Length > 0;
}
void OnDigitButtonClicked(object sender, EventArgs args)
{
Button button = (Button)sender;
displayLabel.Text += (string)button.Styleld;
backspaceButton.IsEnabled = true;
app.DisplayLabelText = displayLabel.Text;
}

void OnBackspaceButtonClicked(object sender, EventArgs args)
{

string text = displaylLabel.Text;

displayLabel.Text = text.Substring(0, text.Length - 1);
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backspaceButton.IsEnabled = displayLabel.Text.Length > 0;
app.DisplaylLabelText = displaylLabel.Text;
}

Part of the job of the LoadFromxaml method called by InitializeComponent involves attaching
these event handlers to the objects instantiated from the XAML file.

The XamlKeypad project also includes the code that was added to the page and 2App classes in Per-
sistentKeypad to save the keypad text when the program is terminated. The app class in XamlKeypad
is basically the same as the one in PersistentKeypad.

Tap gestures

The Xamarin.Forms But ton responds to finger taps, but you can actually get finger taps from any class
that derives from View, including Label, BoxView, and Frame. These tap events are not built into the
View class, but the view class defines a property named GestureRecognizers. Taps are enabled by
adding an object to this GestureRecognizers collection. An instance of any class that derives from
GestureRecognizer can be added to this collection, but undoubtedly the most useful is TapGes-

tureRecognizer.

Here's how to add a TapGestureRecognizer to a BoxView in code:

BoxView boxView = new BoxView

{

Color = Color.Blue
};
TapGestureRecognizer tapGesture = new TapGestureRecognizer();
tapGesture.Tapped += OnBoxViewTapped;
boxView.GestureRecognizers.Add(tapGesture);

TapGestureRecognizer also defines a NumberOfTapsRequired property with a default value of 1.
Set it to 2 to implement double taps.

To generate Tapped events, the View object must have its IsEnabled property set to true, its Is-
Visible property set to true (or it won't be visible at all), and its InputTransparent property set to
false. These are all default conditions.

The Tapped handler looks just like a C1icked handler for the Button:

void OnBoxViewTapped(object sender, EventArgs args)

{
}

As you know, the sender argument of an event handler is normally the object that fires the event,



Chapter 8 Code and XAML in harmony 176

which in this case would be the TapGestureRecognizer object. That would not be of much use. In-
stead, the sender argument to the Tapped handler is the view being tapped, in this case the BoxView.
That's much more useful!

Like Button, TapGestureRecognizer also defines Command and CommandParameter properties;
these are used when implementing the MVVM design pattern, and they are discussed in a later chap-
ter.

TapGestureRecognizer also defines properties named TappedCallback and TappedCallback-
pParameter and a constructor that includes a TappedCallback argument. These are all deprecated
and should not be used.

In XAML, you can attach a TapGestureRecognizer to a view by expressing the GestureRecog-
nizers collection as a property element:
<BoxView Color="Blue">
<BoxView.GestureRecognizers>
<TapGestureRecognizer Tapped="OnBoxViewTapped" />

</BoxView.GestureRecognizers>
</BoxView>

As usual, the XAML is a little shorter than the equivalent code.
Let's make a program that's inspired by one of the first standalone computer games.

The Xamarin.Forms version of this game is called MonkeyTap because it's an imitation game. It
contains four BoxVview elements, colored red, blue, yellow, and green. When the game begins, one of
the Boxview elements flashes, and you must then tap that Boxview. That BoxVview flashes again fol-
lowed by another one, and now you must tap both in sequence. Then those two flashes are followed
by a third and so forth. (The original had sound as well, but MonkeyTap does not.) It's a rather cruel
game because there is no way to win. The game just keeps on getting harder and harder until you lose.

The MonkeyTapPage.xaml file instantiates the four Boxview elements and a Button in the center
labeled "Begin”.

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmlns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="MonkeyTap.MonkeyTapPage">

<ContentPage.Padding>
<OnPlatform x:TypeArguments="Thickness"
i0s="0, 20, 0, 0" />
</ContentPage.Padding>

<StackLayout>
<BoxView x:Name="boxview0"
VerticalOptions="FilTAndExpand">
<BoxView.GestureRecognizers>
<TapGestureRecognizer Tapped="OnBoxViewTapped" />
</BoxView.GestureRecognizers>
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</BoxView>

<BoxView x:Name="boxviewl"
VerticalOptions="FillAndExpand">
<BoxView.GestureRecognizers>
<TapGestureRecognizer Tapped="OnBoxViewTapped" />
</BoxView.GestureRecognizers>
</BoxView>

<Button x:Name="startGameButton"
Text="Begin"
Font="Large"
HorizontalOptions="Center"
Clicked="OnStartGameButtonClicked" />

<BoxView x:Name="boxview2"
VerticalOptions="FillAndExpand">
<BoxView.GestureRecognizers>
<TapGestureRecognizer Tapped="OnBoxViewTapped" />
</BoxView.GestureRecognizers>
</BoxView>

<BoxView x:Name="boxview3"
VerticalOptions="FilTAndExpand">
<BoxView.GestureRecognizers>
<TapGestureRecognizer Tapped="OnBoxViewTapped" />
</BoxView.GestureRecognizers>
</BoxView>
</StackLayout>
</ContentPage>

All four Boxview elements here have a TapGestureRecognizer attached, but they aren't yet as-
signed colors. That's handled in the code-behind file because the colors won't stay constant. The colors
need to be changed for the flashing effect.

The code-behind file begins with some constants and variable fields. (You'll notice that one of them
is flagged as protected; in the next chapter, a class will derive from this one and require access to this
field. Some methods are defined as protected as well.)

public partial class MonkeyTapPage

{
const int sequenceTime = 750; // in msec
protected const int flashDuration = 250;

const double offLuminosity = 0.4; // somewhat dimmer
const double onLuminosity = 0.75; // much brighter

BoxView[] boxViews;

Color[] colors = { Color.Red, Color.Blue, Color.Yellow, Color.Green };
List<int> sequence = new List<int>(Q);

int sequencelndex;

bool awaitingTaps;

bool gameEnded;
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Random random = new Random();

pubTlic MonkeyTapPage()

{
InitializeComponent();
boxViews = new BoxView[] { boxviewO, boxviewl, boxview2, boxview3 };
InitializeBoxViewColors();
}
void InitializeBoxViewColors()
{
for (int index = 0; index < 4; index++)
boxViews[index].Color = colors[index].WithLuminosity(offLuminosity);
}

}

The constructor puts all four Boxview elements in an array; this allows them to be referenced by a sim-
ple index that has values of 0, 1, 2, and 3. The InitializeBoxViewColors method sets all the Box-
View elements to their slightly dimmed nonflashed state.

The program is now waiting for the user to press the Begin button to start the first game. The same
Button handles replays, so it includes a redundant initialization of the Boxview colors. The Button
handler also prepares for building the sequence of flashed Boxview elements by clearing the se-
quence list and calling startSequence

public partial class MonkeyTapPage

{
protected void OnStartGameButtonClicked(object sender, EventArgs args)
{
gameEnded = false;
startGameButton.IsVisible = false;
InitializeBoxViewColors(Q);
sequence.Clear();
StartSequence();
}
void StartSequence()
{
sequence.Add(random.Next(4));
sequenceIndex = 0;
Device.StartTimer(TimeSpan.FromMilliseconds(sequenceTime), OnTimerTick);
}
}

StartSequence adds a new random integer to the sequence list, initializes sequenceIndex to 0,
and starts the timer.

In the normal case, the timer tick handler is called for each index in the sequence list and causes
the corresponding Boxview to flash with a call to F1ashBoxVview. The timer handler returns false
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when the sequence is at an end, also indicating by setting awaitingTaps that it's time for the user to
imitate the sequence:

public partial class MonkeyTapPage

{
bool OnTimerTick()
{
if (gameEnded)
return false;
FlashBoxView(sequence[sequenceIndex]);
sequenceIndex++;
awaitingTaps = sequenceIndex == sequence.Count;
sequenceIndex = awaitingTaps ? 0 : sequencelndex;
return !awaitingTaps;
}
protected virtual void FlashBoxView(int index)
{
boxViews[index].Color = colors[index].WithLuminosity(onLuminosity);
Device.StartTimer(TimeSpan.FromMilliseconds(flashDuration), () =>
{
if (gameEnded)
return false;
boxViews[index].Color = colors[index].WithLuminosity(offLuminosity);
return false;
s
}
}

The flash is just a quarter second in duration. The FlashBoxView method first sets the luminosity for
a bright color and creates a “one-shot” timer, so called because the timer callback method (here
expressed as a lambda function) returns false and shuts off the timer after restoring the color’s
luminosity.

The Tapped handler for the Boxview elements ignores the tap if the game is already over (which
only happens with a mistake by the user), and ends the game if the user taps prematurely without
waiting for the program to go through the sequence. Otherwise, it just compares the tapped BoxView
with the next one in the sequence, flashes that Boxview if correct, or ends the game if not:

public partial class MonkeyTapPage

{

protected void OnBoxViewTapped(object sender, EventArgs args)

{
if (gameEnded)
return;

if (lawaitingTaps)
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EndGame();
return;

BoxView tappedBoxView = (BoxView)sender;
int index = Array.IndexOf(boxViews, tappedBoxView);

if (index != sequence[sequenceIndex])
{

EndGame();

return;
}

FlashBoxView(index);

sequenceIndex++;
awaitingTaps = sequencelndex < sequence.Count;

if (lawaitingTaps)

StartSequence();
}
protected virtual void EndGame()
{
gameEnded = true;
for (int index = 0; index < 4; index++)
boxViews[index].Color = Color.Gray;
startGameButton.Text = "Try again?";
startGameButton.IsVisible = true;
}

}

If the user manages to “ape” the sequence all the way through, another call to startSequence adds a
new index to the sequence list and starts playing that new one. Eventually, though, there will be a call
to EndGame, which colors all the boxes gray to emphasize the end, and reenables the Button for a
chance to try it again.

Here's the program after the Button has been clicked and hidden:
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I know, | know. The game is a real drag without sound.

Let's take the opportunity in the next chapter to fix that.



Chapter 9
Platform-specific API calls

An emergency has arisen. Anyone playing with the MonkeyTap game from the previous chapter will
quickly come to the conclusion that it desperately needs a very basic enhancement, and it simply can-
not be allowed to exist without it.

MonkeyTap needs sound.

It doesn’t need very sophisticated sound—just little beeps to accompany the flashes of the four
BoxView elements. But the Xamarin.Forms API doesn’t support sound, so sound is not something we
can add to MonkeyTap with just a couple of API calls. Supporting sound requires going somewhat be-
yond Xamarin.Forms to make use of platform-specific sound-generation facilities. Figuring out how to
make sounds in iOS, Android, and Windows Phone is hard enough. But how does a Xamarin.Forms
program then make calls into the individual platforms?

Before tackling the complexities of sound, let's examine the different approaches to making plat-
form-specific API calls with a much simpler example. The first three short programs shown in this chap-
ter are all functionally identical: They all display two tiny items of information supplied by the underly-
ing platform’s operating system that reveal the model of the device running the program and the op-
erating system version.

Preprocessing in the Shared Asset Project

As you learned in Chapter 2, “Anatomy of an app,” you can use either a Shared Asset Project (SAP) or a
Portable Class Library (PCL) for the code that is common to all three platforms. An SAP contains code
files that are shared among the platform projects, while a PCL encloses the common code in a library
that is accessible only through public types.

Accessing platform APIs from a Shared Asset Project is a little more straightforward than from a
Portable Class Library because it involves more traditional programming tools, so let’s try that ap-
proach first. You can create a Xamarin.Forms solution with an SAP using the process described in
Chapter 2. You can then add a XAML-based ContentPage class to the SAP the same way you add one
to a PCL.

Here's the XAML file for a project that displays platform information, named PlatinfoSap1:

<ContentPage xmlns="http://xamarin.com/schemas/2014/forms"
xmIns:x="http://schemas.microsoft.com/winfx/2009/xam1"
x:Class="PlatInfoSapl.PlatInfoSaplPage">

<StackLayout Padding="20">
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<StackLayout VerticalOptions="CenterAndExpand">
<Label Text="Device Model:" />

<ContentView Padding="50, 0, 0, 0">
<Label x:Name="modelLabel"
FontSize="Large"
FontAttributes="Bold" />
</ContentView>
</StackLayout>

<StackLayout VerticalOptions="CenterAndExpand">
<Label Text="Operating System Version:" />

<ContentView Padding="50, 0, 0, 0">
<Label x:Name="versionLabel"
FontSize="Large"
FontAttributes="Bold" />
</ContentView>
</StackLayout>

</StackLayout>
</ContentPage>

The code-behind file must set the Text properties for modelLabel and versionLabel.

Code files in a Shared Asset Project are extensions of the code in the individual platforms. This
means that code in the SAP can make use of the C# preprocessor directives #if, #elif, #else, and
#endif with conditional-compilation symbols defined for the three platforms, as demonstrated in
Chapters 2 and 4. These symbols are:

e 105 foriOS

e  ANDROID for Android

e wINDoWsS_ UwP for the Universal Windows Platform
e wINDOWS APP for Windows 8.1

e WINDOWS PHONE APP for Windows Phone 8.1

The APIs involved in obtaining the model and version information are, of course, different for the
three platforms:

e ForiOS, use the uUIDevice class in the UTKit namespace.
e  For Android, use various properties of the Bui1d class in the Android.0S namespace.

e  For the Windows platforms, use the EasClientDeviceInformation class in the win-
dows.Security.ExchangeActiveSyncProvisioning hamespace.

Here's the PlatinfoSapl.xaml.cs code-behind file showing how modellLabel and versionLabel are
set based on the conditional-compilation symbols:

using System;
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using Xamarin.Forms;

#if _TI0S__
using UIKit;

#e1if _ANDROID__
using Android.0S;

#e1if WINDOWS_APP || WINDOWS_PHONE_APP || WINDOWS_UWP
using Windows.Security.ExchangeActiveSyncProvisioning;

#endif

namespace PlatInfoSapl

{
public partial class PlatInfoSaplPage : ContentPage
{
public PlatInfoSaplPage ()
{
InitializeComponent ();
#if __I0S__

UIDevice device = new UIDevice();

modellLabel.Text = device.Model.ToString(Q);

versionLabel.Text = String.Format("{0} {1}", device.SystemName,
device.SystemVersion);

#elif _ANDROID__
modellLabel.Text = String.Format("{0} {1}", Build.Manufacturer,
Build.Model);
versionLabel.Text = Build.VERSION.Release.ToString(Q);
#e1if WINDOWS_APP || WINDOWS_PHONE_APP || WINDOWS_UWP
EasClientDeviceInformation devInfo = new EasClientDeviceInformation();
modellLabel.Text = String.Format("{0} {1}", devInfo.SystemManufacturer,
devInfo.SystemProductName) ;

versionLabel.Text = devInfo.OperatingSystem;

#endif

}

Notice that these preprocessor directives are used to select different using directives as well as to
make calls to platform-specific APIs. In a program as simple as this, you could simply include the
namespaces with the class names, but for longer blocks of code, you'll probably want those using

directives.

And of course it works:

184
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Device Model:

NOKIA
RM-893 nam_t
mous_201

Device Model
iPhone

LGE Nexus 5

Operating System Version:
iPhone 0S 9.2

Operating System Version:

WindowsPhone

The advantage of this approach is that you have all the code for the three platforms in one place.
But the preprocessor directives in the code listing are—let’s face it—rather ugly, and they harken back
to a much earlier era in programming. Using preprocessor directives might not seem so bad for short
and less frequent calls such as this example, but in a larger program you'll need to juggle blocks of
platform-specific code and shared code, and the multitude of preprocessor directives can easily be-
come confusing. Preprocessor directives should be used for little fixes and generally not as structural
elements in the application.

Let's try another approach.

Parallel classes and the Shared Asset Project

Although the Shared Asset Project is an extension of the platform projects, the relationship goes both
ways: just as a platform project can make calls into code in a Shared Asset Project, the SAP can make
calls into the individual platform projects.

This means that we can restrict the platform-specific API calls to classes in the individual platform
projects. If the names and namespaces of these classes in the platform projects are the same, then code
in the SAP can access these classes in a transparent, platform-independent manner.

In the PlatinfoSap2 solution, each of the five platform projects has a class named pPlatformInfo
that contains two methods that return string objects, named GetModel and GetVersion. Here's the
version of this class in the iOS project:

using System;
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using UIKit;

namespace PlatInfoSap2
{

public class PlatformInfo

{

UIDevice device = new UIDevice();

public string GetModel()
{

return device.Model.ToString(Q);

public string GetVersion()
{

return String.Format("{0} {1}", device.SystemName,
device.SystemVersion);

}

Notice the namespace name. Although the other classes in this iOS project use the PlatInfo-
Sap2.10S namespace, the namespace for this class is just PlatInfoSap2. This allows the SAP to ac-
cess this class directly without any platform specifics.

Here's the parallel class in the Android project. Same namespace, same class name, and same
method names, but different implementations of these methods using Android API calls:

using System;
using Android.0S;

namespace PlatInfoSap2

{
public class PlatformInfo
{
public string GetModel()
{
return String.Format("{0} {1}", Build.Manufacturer,
Build.Model);
}
public string GetVersion()
{
return Build.VERSION.Release.ToString(Q);
}
}
}

And here’s the class that exists in three identical copies in the three Windows and Windows Phone
projects:

using System;
using Windows.Security.ExchangeActiveSyncProvisioning;
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namespace PlatInfoSap2

{

public class PlatformInfo

{

EasClientDeviceInformation devInfo = new EasClientDeviceInformation();

public string GetModel()
{
return String.Format("{0} {1}", devInfo.SystemManufacturer,
devInfo.SystemProductName);

}

public string GetVersion()
{

return devInfo.OperatingSystem;
}

The XAML file in the PlatinfoSap2 project is basically the same as the one in PlatinfoSap1 project.
The code-behind file is considerably simpler:

using System;
using Xamarin.Forms;

namespace PlatInfoSap2

{
public partial class PlatInfoSap2Page : ContentPage
{
public PlatInfoSap2Page ()
{
InitializeComponent ();
PlatformInfo platformInfo = new PlatformInfo();
modellLabel.Text = platformInfo.GetModel();
versionLabel.Text = platformInfo.GetVersion(Q);
}
}
}

The particular version of PlatformInfo that is referenced by the class is the one in the compiled pro-
ject. It's almost as if we've defined a little extension to Xamarin.Forms that resides in the individual
platform projects.

DependencyService and the Portable Class Library

Can the technique illustrated in the PlatinfoSap2 program be implemented in a solution with a Porta-
ble Class Library? At first, it doesn't seem possible. Although application projects make calls to libraries
all the time, libraries generally cant make calls to applications except in the context of events or
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callback functions. The PCL is bundled with a device-independent version of .NET and closed up
tight—capable only of executing code within itself or other PCLs it might reference.

But wait: When a Xamarin.Forms application is running, it can use .NET reflection to get access to its
own assembly and any other assemblies in the program. This means that code in the PCL can use re-
flection to access classes that exist in the platform assembly from which the PCL is referenced. Those
classes must be defined as public, of course, but that's just about the only requirement.

Before you start writing code that exploits this technique, you should know that this solution al-
ready exists in the form of a Xamarin.Forms class named DependencyService. This class uses .NET
reflection to search through all the other assembilies in the application—including the particular plat-
form assembly itself—and provide access to platform-specific code.

The use of DependencyService is illustrated in the DisplayPlatformInfo solution, which uses a
Portable Class Library for the shared code. You begin the process of using DependencyService by
defining an interface type in the PCL project that declares the signatures of the methods you want to
implement in the platform projects. Here's IPlatformInfo:

namespace DisplayPlatformInfo

{
public interface IPlatformInfo
{
string GetModel();
string GetVersion();
}
}

You've seen those two methods before. They're the same two methods implemented in the Plat-
formInfo classes in the platform projects in PlatinfoSap2.

In a manner very similar to PlatinfoSap2, all three platform projects in DisplayPlatforminfo must
now have a class that implements the TPlatformInfo interface. Here's the class in the iOS project,
named PlatformInfo:

using System;
using UIKit;
using Xamarin.Forms;

[assembly: Dependency(typeof(DisplayPlatformInfo.i0S.PlatformInfo))]

namespace DisplayPlatformInfo.i0S

{
public class PlatformInfo : IPlatformInfo

{

UIDevice device = new UIDevice();

public string GetModel()
{

return device.Model.ToString(Q);
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}
public string GetVersion()
{
return String.Format("{0} {1}", device.SystemName,
device.SystemVersion);
}

}

This class is not referenced directly from the PCL, so the namespace name can be anything you want.
Here it's set to the same namespace as the other code in the iOS project. The class name can also be
anything you want. Whatever you name it, however, the class must explicitly implement the 1P1at-
formInfo interface defined in the PCL:

public class PlatformInfo : IPlatformInfo

Furthermore, this class must be referenced in a special attribute outside the namespace block. You'll
see it near the top of the file following the using directives:
[assembly: Dependency(typeof(DisplayPlatformInfo.i0S.PlatformInfo))]
The DependencyAttribute class that defines this Dependency attribute is part of Xamarin.Forms and
used specifically in connection with Dependencyservice. The argument is a Type object of a class in
the platform project that is available for access by the PCL. In this case, it's this Plat formInfo class.

This attribute is attached to the platform assembly itself, so code executing in the PCL doesn’t have to
search all over the library to find it.

Here's the Android version of PlatformInfo:

using System;
using Android.0S;
using Xamarin.Forms;

[assembly: Dependency(typeof(DisplayPlatformInfo.Droid.PlatformInfo))]

namespace DisplayPlatformInfo.Droid

{
public class PlatformInfo : IPlatformInfo
{
public string GetModel()
{
return String.Format("{0} {1}", Build.Manufacturer,
Build.Model);
}
public string GetVersion()
{
return Build.VERSION.Release.ToString(Q);
}
}
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And here’s the one for the UWP project:

using System;
using Windows.Security.ExchangeActiveSyncProvisioning;
using Xamarin.Forms;

[assembly: Dependency(typeof(DisplayPlatformInfo.UWP.PlatformInfo))]

namespace DisplayPlatformInfo.UWP

{
public class PlatformInfo : IPlatformInfo

{

EasClientDeviceInformation devInfo = new EasClientDeviceInformation();

public string GetModel()
{
return String.Format("{0} {1}", devInfo.SystemManufacturer,
devInfo.SystemProductName);

public string GetVersion()
{
return devInfo.OperatingSystem;

}
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The Windows 8.1 and Windows Phone 8.1 projects have similar files that differ only by the namespace.

Code in the PCL can then get access to the particular platform’s implementation of TPlatform-

Info by using the DependencyService class. This is a static class with three public methods, the most

important of which is named Get. Get is a generic method whose argument is the interface you've de-

fined, in this case IPlatformInfo.

IPTatformInfo platformInfo = DependencyService.Get<IPlatformInfo>();

The Get method returns an instance of the platform-specific class that implements the TPlatform-
Info interface. You can then use this object to make platform-specific calls. This is demonstrated in the

code-behind file for the DisplayPlatformInfo project:

namespace DisplayPlatformInfo

{

public partial class DisplayPlatformInfoPage : ContentPage

{
public DisplayPlatformInfoPage()

{
InitializeComponent();
IPTatformInfo platformInfo = DependencyService.Get<IPlatformInfo>(Q);
modelLabel.Text = platformInfo.GetModel();
versionLabel.Text = platformInfo.GetVersion(Q);
}
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DependencyService caches the instances of the objects that it obtains through the Get method.
This speeds up subsequent uses of Get and also allows the platform implementations of the interface
to maintain state: any fields and properties in the platform implementations will be preserved across
multiple Get calls. These classes can also include events or implement callback methods.

DependencyService requires just a little more overhead than the approach shown in the Platin-
foSap2 project and is somewhat more structured because the individual platform classes implement an
interface defined in shared code.

DependencyService is not the only way to implement platform-specific calls in a PCL. Adven-
turous developers might want to use dependency-injection techniques to configure the PCL to make
calls into the platform projects. But DependencyService is very easy to use, and it eliminates most
reasons to use a Shared Asset Project in a Xamarin.Forms application.

Platform-specific sound generation

Now for the real objective of this chapter: to give sound to MonkeyTap. All three platforms support
APIs that allow a program to dynamically generate and play audio waveforms. This is the approach
taken by the MonkeyTapWithSound program.

Commercial music files are often compressed in formats such as MP3. But when a program is algo-
rithmically generating waveforms, an uncompressed format is much more convenient. The most basic
technique—which is supported by all three platforms—is called pulse code modulation or PCM. De-
spite the fancy name, it's quite simple, and it's the technique used for storing sound on music CDs.

A PCM waveform is described by a series of samples at a constant rate, known as the sampling rate.
Music CDs use a standard rate of 44,100 samples per second. Audio files generated by computer pro-
grams often use a sampling rate of half that (22,050) or one-quarter (11,025) if high audio quality is
not required. The highest frequency that can be recorded and reproduced is one-half the sampling
rate.

Each sample is a fixed size that defines the amplitude of the waveform at that point in time. The
samples on a music CD are signed 16-bit values. Samples of 8 bits are common when sound quality
doesn’t matter as much. Some environments support floating-point values. Multiple samples can
accommodate stereo or any number of channels. For simple sound effects on mobile devices, monau-
ral sound is often fine.

The sound generation algorithm in MonkeyTapWithSound is hard-coded for 16-bit monaural
samples, but the sampling rate is specified by a constant and can easily be changed.

Now that you know how DependencyService works, let's examine the code added to Monkey-
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Tap to turn it into MonkeyTapWithSound, and let's look at it from the top down. To avoid reproduc-
ing a lot of code, the new project contains links to the MonkeyTap.xaml and MonkeyTap.xaml.cs files in
the MonkeyTap project.

In Visual Studio, you can add items to projects as links to existing files by selecting Add > Existing
Item from the project menu. Then use the Add Existing Item dialog to navigate to the file. Choose
Add as Link from the drop-down on the Add button.

In Xamarin Studio, select Add > Add Files from the project’s tool menu. After opening the file or
files, an Add File to Folder alert box pops up. Choose Add a link to the file.

However, after taking these steps in Visual Studio, it was also necessary to manually edit the Mon-
keyTapWithSound.csproj file to change the MonkeyTapPage.xaml file to an EmbeddedResource and
the Generator to MSBuild:UpdateDesignTimeXaml. Also, a DependentUpon tag was added to the
MonkeyTapPage.xaml.cs file to reference the MonkeyTapPage.xaml file. This causes the code-behind
file to be indented under the XAML file in the file list.

The MonkeyTapWithSoundPage class then derives from the MonkeyTapPage class. Although the
MonkeyTapPage class is defined by a XAML file and a code-behind file, MonkeyTapWithSoundPage is
code only. When a class is derived in this way, event handlers in the original code-behind file for events
in the XAML file must be defined as protected, and this is the case.

The MonkeyTap class also defined a flashDuration constant as protected, and two methods
were defined as protected and virtual. The MonkeyTapWithSoundPage overrides these two meth-
ods to call a static method named SoundPlayer.PlaySound:

namespace MonkeyTapWithSound

{
class MonkeyTapWithSoundPage : MonkeyTap.MonkeyTapPage

{

const int errorDuration = 500;

// Diminished 7th in 1st inversion: C, Eb, F#, A
doubTle[] frequencies = { 523.25, 622.25, 739.99, 880 };

protected override void BlinkBoxView(int index)

{
SoundPlayer.PlaySound(frequencies[index], flashDuration);
base.BlinkBoxView(index);

}

protected override void EndGame()

{
SoundPlayer.PlaySound(65.4, errorDuration);
base.EndGame();
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The soundPlayer.PlaySound method accepts a frequency and a duration in milliseconds. Every-
thing else—the volume, the harmonic makeup of the sound, and how the sound is generated—is the
responsibility of the P1aySound method. However, this code makes an implicit assumption that
SoundPlayer.PlaySound returns immediately and does not wait for the sound to complete playing.
Fortunately, all three platforms support sound-generation APIs that behave in this way.

The soundPlayer class with the PlaySound static method is part of the MonkeyTapWithSound
PCL project. The responsibility of this method is to define an array of the PCM data for the sound. The
size of this array is based on the sampling rate and the duration. The for loop calculates samples that
define a triangle wave of the requested frequency:

namespace MonkeyTapWithSound
{
class SoundPlayer

{
const int samplingRate = 22050;

// Hard-coded for monaural, 16-bit-per-sample PCM
public static void PlaySound(double frequency = 440, int duration = 250)
{
short[] shortBuffer = new short[samplingRate * duration / 1000];
double angleIncrement = frequency / samplingRate;
double angle = 0; // normalized 0 to 1

for (int i = 0; i < shortBuffer.Length; i++)
{

// Define triangle wave

double sample;

// 0 to 1
if (angle < 0.25)
sample = 4 * angle;

// 1 to -1
else if (angle < 0.75)
sample = 4 * (0.5 - angle);

// -1 to 0
else
sample = 4 * (angle - 1);

shortBuffer[i] = (short) (32767 * sample);
angle += anglelIncrement;

while (angle > 1)
angle -= 1;
}

byte[] byteBuffer = new byte[2 * shortBuffer.Length];
Buffer.BlockCopy(shortBuffer, 0, byteBuffer, 0, byteBuffer.Length);

DependencyService.Get<IPlatformSoundPlayer>().PlaySound(samplingRate, byteBuffer);
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}

Although the samples are 16-bit integers, two of the platforms want the data in the form of an array of
bytes, so a conversion occurs near the end with Buf fer.BlockCopy. The last line of the method uses
DependencyService to pass this byte array with the sampling rate to the individual platforms.

The DependencyService.Get method references the IPlat formSoundPlayer interface that de-
fines the signature of the P1aySound method:

namespace MonkeyTapWithSound

{
public interface IPlatformSoundPlayer
{
void PTaySound(int samplingRate, byte[] pcmData);
}
}

Now comes the hard part: writing this P1aySound method for the three platforms!

The iOS version uses AvAudioPlayer, which requires data that includes the header used in Wave-
form Audio File Format (.wav) files. The code here assembles that data in a MemoryBuffer and then
converts that to an NSDhata object:

using System;

using System.IO;
using System.Text;
using Xamarin.Forms;
using AVFoundation;
using Foundation;

[assembly: Dependency(typeof(MonkeyTapWithSound.i0S.PlatformSoundPlayer))]

namespace MonkeyTapWithSound.i0S
{
public class PlatformSoundPlayer : IPTatformSoundPlayer
{
const int numChannels = 1;
const int bitsPerSample = 16;

public void PlaySound(int samplingRate, byte[] pcmData)

{
int numSamples = pcmData.Length / (bitsPerSample / 8);

MemoryStream memoryStream = new MemoryStream();
BinaryWriter writer = new BinaryWriter(memoryStream, Encoding.ASCII);

// Construct WAVE header.

writer.Write(new char[] { 'R', 'I', '"F', "F' });

writer.Write(36 + sizeof(short) * numSamples);

writer.Write(new char[] { 'W', 'A', 'V', "E' });

writer.Write(new char[] { 'f', 'm"', 't', " ' }); // format chunk
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writer.Write(16); // PCM chunk size
writer.Write((short)1l); // PCM format flag
writer.Write((short)numChannels);

writer.Write(samplingRate);

writer.Write(samplingRate * numChannels * bitsPerSample / 8); // byte rate
writer.Write((short) (numChannels * bitsPerSample / 8)); // block align
writer.Write((short)bitsPerSample);

writer.Write(new char[] { 'd', 'a', 't', 'a' }); // data chunk

writer.Write(numSamples numChannels * bitsPerSample / 8);

// Write data as well.
writer.Write(pcmData, 0, pcmData.lLength);

memoryStream.Seek (0, SeekOrigin.Begin);

NSData data = NSData.FromStream(memoryStream);
AVAudioPlayer audioPlayer = AVAudioPlayer.FromData(data);
audioPlayer.Play();

Notice the two essentials: PlatformSoundPlayer implements the IPlatformSoundPlayer inter-
face, and the class is flagged with the Dependency attribute.

The Android version uses the audioTrack class, and that turns out to be a little easier. However,
AudioTrack objects can't overlap, so it's necessary to save the previous object and stop it playing be-
fore starting the next one:

using System;
using Android.Media;
using Xamarin.Forms;

[assembly: Dependency(typeof(MonkeyTapWithSound.Droid.PlatformSoundPlayer))]

namespace MonkeyTapWithSound.Droid

{
public class PlatformSoundPlayer : IPlatformSoundPlayer
{

AudioTrack previousAudioTrack;

public void PlaySound(int samplingRate, byte[] pcmData)
{
if (previousAudioTrack != null)
{
previousAudioTrack.Stop(Q);
previousAudioTrack.Release();

AudioTrack audioTrack = new AudioTrack(Stream.Music,
sampTlingRate,
ChannelOut.Mono,
Android.Media.Encoding.Pcml6bit,
pcmData.lLength * sizeof(short),
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AudioTrackMode.Static);

audioTrack.Write(pcmData, 0, pcmData.Length);
audioTrack.Play(Q);

previousAudioTrack = audioTrack;
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The three Windows and Windows Phone platforms can use MediaStreamSource. To avoid a lot of
repetitive code, the MonkeyTapWithSound solution contains an additional SAP project named
WinRuntimeShared consisting solely of a class that all three platforms can use:

using System;

using System.Runtime.InteropServices.WindowsRuntime;
using Windows.Media.Core;

using Windows.Media.MediaProperties;

using Windows.Storage.Streams;

using Windows.UI.Xaml.Controls;

namespace MonkeyTapWithSound.WinRuntimeShared

{

public class SharedSoundPlayer

{

MediaElement mediaElement = new MediaElement();
TimeSpan duration;

public void PlaySound(int samplingRate, byte[] pcmData)

{

AudioEncodingProperties audioProps =

AudioEncodingProperties.CreatePcm((uint)samplingRate, 1, 16);

AudioStreamDescriptor audioDesc = new AudioStreamDescriptor(audioProps);
MediaStreamSource mss = new MediaStreamSource(audioDesc);

bool samplePlayed = false;
mss.SampleRequested += (sender, args) =>

{

};

if (samplePlayed)
return;

IBuffer ibuffer = pcmData.AsBuffer(Q);
MediaStreamSample sample =

MediaStreamSample.CreateFromBuffer(ibuffer, TimeSpan.Zero);
sample.Duration = TimeSpan.FromSeconds(pcmData.Length / 2.0 / samplingRate);
args.Request.Sample = sample;
samplePlayed = true;

mediaETement.SetMediaStreamSource(mss);
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This SAP project is referenced by the three Windows and Windows Phone projects, each of which
contains an identical (except for the namespace) Plat formSoundPlayer class:

using System;
using Xamarin.Forms;

[assembly: Dependency(typeof(MonkeyTapWithSound.UWP.PlatformSoundPlayer))]

namespace MonkeyTapWithSound.UWP

{
public class PlatformSoundPlayer : IPlatformSoundPlayer
{
WinRuntimeShared.SharedSoundPlayer sharedSoundPlayer;
public void PlaySound(int samplingRate, byte[] pcmData)
{
if (sharedSoundPlayer == null)
{
sharedSoundPlayer = new WinRuntimeShared.SharedSoundPlayer();
}
sharedSoundPlayer.PlaySound(samplingRate, pcmData);
}
}
}

The use of DependencyService to perform platform-specific chores is very powerful, but this ap-
proach falls short when it comes to user-interface elements. If you need to expand the arsenal of views
that adorn the pages of your Xamarin.Forms applications, that job involves creating platform-specific
renderers, a process discussed in the final chapter of this book.
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In code, you can set a property in a variety of different ways from a variety of different sources:

triangle.Anglel = 45;

triangle.Anglel = 180 * radians / Math.PI;
triangle.Anglel = angles[i];

triangle.Anglel animator.GetCurrentAngle();

If this Anglel property is a double, all that's required is that the source be a double or otherwise pro-
vide a numeric value that is convertible to a double.

In markup, however, a property of type double usually can be set only from a string that qualifies
as a valid argument to Double.Parse. The only exception you've seen so far is when the target prop-
erty is flagged with a TypeConverter attribute, such as the Fontsize property.

It might be desirable if XAML were more flexible—if you could set a property from sources other
than explicit text strings. For example, suppose you want to define another way to set a property of
type Color, perhaps using the Hue, Saturation, and Luminosity values but without the hassle of
the x:FactoryMethod element. Just offhand, it doesn’t seem possible. The XAML parser expects that
any value set to an attribute of type Color is a string acceptable to the ColorTypeConverter class.

The purpose of XAML markup extensions is to get around this apparent restriction. Rest assured that
XAML markup extensions are not extensions to XML. XAML is always legal XML. XAML markup exten-
sions are extensions only in the sense that they extend the possibilities of attribute settings in markup.
A markup extension essentially provides a value of a particular type without necessarily being a text
representation of a value.

The code infrastructure

Strictly speaking, a XAML markup extension is a class that implements IMarkupExtension, which is a
public interface defined in the regular Xamarin.Forms.Core assembly but with the namespace xama-

rin.Forms.Xaml:

public interface IMarkupExtension

{

object ProvideValue(IServiceProvider serviceProvider);

}

As the name suggests, Providevalue is the method that provides a value to a XAML attribute.
IserviceProvider is part of the base class libraries of NET and defined in the system namespace:
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public interface IServiceProvider

{

3

object GetService(Type type);

Obviously, this information doesn’t provide much of a hint on writing custom markup extensions, and
in truth, they can be tricky. (You'll see an example shortly and other examples later in this book.) Fortu-
nately, Xamarin.Forms provides several valuable markup extensions for you. These fall into three
categories:

Markup extensions that are part of the XAML 2009 specification. These appear in XAML files
with the customary x prefix and are:

. x:Static

. x:Reference
. x:Type

. x:Null

. X:Array

These are implemented in classes that consist of the name of the markup extension with the
word Extension appended—for example, the StaticExtension and ReferenceExtension
classes. These classes are defined in the Xamarin.Forms.Xaml assembly.

The following markup extensions originated in the Windows Presentation Foundation (WPF)
and, with the exception of DynamicResource, are supported by Microsoft's other implemen-
tations of XAML, including Silverlight, Windows Phone 7 and 8, and Windows 8 and 10:

J StaticResource
o DynamicResource
o Binding

These are implemented in the public StaticResourceExtension, DynamicResourceExten—
sion, and BindingExtension classes.

There is only one markup extension that is unique to Xamarin.Forms: the ConstraintExpres-
sion class used in connection with RelativeLayout.

Although it's possible to play around with public markup-extension classes in code, they really only

make sense in XAML.
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Accessing static members

One of the simplest and most useful implementations of IMarkupExtension is encapsulated in the
StaticExtension class. This is part of the original XAML specification, so it customarily appears in
XAML with an x prefix. sStaticExtension defines a single property named Member of type string
that you set to a class and member name of a public constant, static property, static field, or enumera-
tion member.

Let's see how this works. Here's a Label with six properties set as they would normally appear in
XAML.

<Label Text="Just some text"
BackgroundColor="Accent"
TextColor="Black"
FontAttributes="Italic"
VerticalOptions="Center"
HorizontalTextAlignment="Center" />

Five of these attributes are set to text strings that eventually reference various static properties, fields,
and enumeration members, but the conversion of those text strings occurs through type converters
and the standard XAML parsing of enumeration types.

If you want to be more explicit in setting these attributes to those various static properties, fields,
and enumeration members, you can use x:StaticExtension within property element tags:

<Label Text="Just some text">
<LabeT.BackgroundColor>
<x:StaticExtension Member="C